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Documentation Updates
This manual’s title page contains the following identifying information:

• Version number, which indicates the software version.

• Document release date, which changes each time the document is 
updated.

• Software release date, which indicates the release date of this 
version of the software.

To check for recent updates or to verify that you are using the most 
recent edition, visit the following URL:

http://ovweb.external.hp.com/lpe/doc_serv/

You will also receive updated or new editions if you subscribe to the 
appropriate product support service. Contact your HP sales 
representative for details. 
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Support
Please visit the HP OpenView support web site at:

http://www.hp.com/managementsoftware/support

This web site provides contact information and details about the 
products, services, and support that HP OpenView offers. 

HP OpenView online software support provides customer self-solve 
capabilities. It provides a fast and efficient way to access interactive 
technical support tools needed to manage your business. As a valuable 
support customer, you can benefit by using the support site to:

• Search for knowledge documents of interest
• Submit enhancement requests online
• Download software patches
• Submit and track progress on support cases
• Manage a support contract
• Look up HP support contacts
• Review information about available services
• Enter discussions with other software customers 
• Research and register for software training

Most of the support areas require that you register as an HP Passport 
user and log in. Many also require a support contract.

To find more information about access levels, go to:

http://www.hp.com/managementsoftware/access_level

To register for an HP Passport ID, go to: 

http://www.managementsoftware.hp.com/passport-registration.h
tml
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1 Introduction

This chapter provides an introduction to the tasks and functionality 
available to the Service Desk administrator.
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Service Desk Administrator Task Overview
You can perform the following tasks and functions as a Service Desk 
administrator:

• Creating and maintaining user accounts and access to Service Desk.

• Using Service Pages to access Service Desk.

• Using the Web Console to access Service Desk.

• Accessing Service Desk objects from the command-line.

• Customizing the layout and appearance of the HP OpenView console.

• Creating actions to perform automated tasks.

• Creating rules to trigger actions.

• Creating scheduled tasks.

• Working with Service Desk data.

• Creating and maintaining templates.

• Integrating E-mail with Service Desk.

• Reporting.

• OVPI Reports Administration.

• OVPI Service Desk Reporting.

• Archiving.

• Impacted services.

• Using additional Tools: Configuring server settings and using the 
object server monitor.

• Using multiple management servers for load balancing.

• Troubleshooting Service desk: Using logging, tracing, and the Service 
Desk Support Tool.

• Defining System Settings for workspaces.
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Users and Security

In the Users & Security workspace you can create and maintain user 
accounts, and configure user access to Service Desk. For more 
information, refer to Information for Administrators→Users & Security 
in the HP OpenView online help. You can also reconfigure Service Desk 
to authenticate console users using an Active Directory, an LDAP server, 
or some other external authentication mechanism. For more information, 
refer to Information for Administrators→Users & Security→User 
Authentication in the OpenView online help.

Service Pages

Service Pages is a web-based application that provides limited access to 
Service Desk for licensed and unlicensed users. Use Service Pages to 
allow users to remotely create, view and edit Service Desk objects. For 
more information, refer to Chapter 2 “Service Pages”.

The Web Console

Use the web console to give users a personalized and remote view of the 
managed environment through a browser interface. The Web Console 
provides much of the functionality available in the Java version of the 
HP OpenView Console with minimal configuration and administration. 
For more information, refer to Chapter 3 “The HP OpenView Web 
Console”.

Command-Line Utility

The HP OpenView console provides a utility that allows you to interact 
with the console from the command line. This is useful for integrating 
other programs or tools with the console. For more information, refer to 
Chapter 5 “Command Line Utility”. For a reference of ovoconsolecmd 
commands refer to Chapter 5 “Command Line Utility”.

Presentation

The Presentation workspace provides tools that you can use to customize 
the layout and appearance of the HP OpenView console. For more 
information, refer to Information for Administrators→Presentation in 
the HP OpenView online help.
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Actions

Actions are shortcuts to simple or complex tasks. An action is associated 
with a specific object type. You can create actions that you can reuse 
when you need and actions that are created only when you create rules. 
For more information, refer to Information for Administrators→Actions 
in the HP OpenView online help.

Rules

You can use business logic in Service Desk to automate your business 
processes, by creating database rules and user-interface (UI) rules to 
automate repetitive tasks. For more information, refer to Information for 
Administrators→Rules in the HP OpenView online help.

Scheduled Tasks

Scheduled Tasks are associated with Conditions for Rules. These tasks 
are triggered according to a defined schedule rather than immediately 
after the creation or modification of an object. You can use Scheduled 
Tasks to reschedule tasks that are registered in the database but did not 
run to completion at the specified time. For more information, refer to 
Information for Administrators-→Scheduled Tasks in the HP OpenView 
online help.

Data

The Data workspace allows you to work with the data aspects of Service 
Desk. For example, you can create named filters for data views and data 
retrieval, create or modify field codes for objects, create custom fields for 
objects, or perform data exchange and configuration exchange. For more 
information, refer to Information for Administrators→Data in the HP 
OpenView online help. 

Templates

Templates allow you to set default values for attributes when console 
users create new objects. The Templates workspace in the HP OpenView 
Configuration workspace group contains tools you can use to create and 
configure templates. For more information, refer to Information for 
Administrators→Templates in the HP OpenView online help.
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Configuration Exchange

The configuration exchange feature enables you to transfer configuration 
settings between compatible databases. Configuration settings include 
the changes, modifications, and customizations that system 
administrators make to the HP OpenView environment (for example, to 
make use of alternative user-authentication procedures). Exchanging 
configuration data between systems helps to ensure that all systems look 
and work as similarly as possible. For more information, refer to 
Information for Administrators→Data→Configuration Exchange in the 
OpenView online help.

E-mail

You can configure Service Desk to perform specified functions in 
response to incoming e-mail, and send outgoing e-mail in response to 
specified events. For more information, refer to Chapter 4 “E-mail”.

Reporting

You can create reports for console, database, analyzed data and OVPI 
Report Packs using the Service Desk reporting capabilities. You can also 
create database views and a data dictionary for use with your own 
third-party reporting tool. In this way you can create a variety of reports 
based on the data in your Service Desk database. For more information, 
refer to Chapter 6 “Reporting”.

OVPI Reports Administration

OVPI reports administration includes the administrative tasks 
associated with using OVPI Helpdesk and Change Manager report packs 
with Service Desk. If you have module licenses for the Helpdesk and 
Change Manager modules, you can purchase OVPI report packs to 
produce reports relating to the data contained in each of these modules. 
For more information, refer to Chapter 7 “OVPI Reports 
Administration”. 

For a complete description of OVPI reporting, refer to the OVPI 
documentation set.
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OVPI Service Desk Reporting

OVPI Service Desk Reporting allows you to report on how your Service 
Desk is performing. It enables you to analyze calls in various ways 
including by category, classification and closure code, and identify trends 
in the number of calls that are closed before deadline. For more 
information, refer to Chapter 8 “OVPI Service Desk Reporting”.

Archiving

You can archive information by defining views for each object type. Work 
orders, changes, projects, problems, service calls, and incidents can all be 
archived. Any combination of conditions that can be set up in a Service 
Desk data view can be used to determine what information is archived. 
For more information, refer to Chapter 9 “Archiving”.

Impacted Services

You can define the parameters used to find impacted services for 
incidents and service calls. For more information, refer to Chapter 10 
“Impacted Services”.

Object Server Monitor

The Object Server Monitor allows you to assess quickly and easily the 
status of the management server. For example, you can use the Object 
Server Monitor to assess database performance, see how many clients 
are connected to the management server, or examine the size and state of 
queues. You can also monitor the connections to the database and the 
status of message and event services. For more information, refer to 
Information for Administrators→Server Monitor in the HP OpenView 
Service Desk online help.

Server Settings

The Server Configuration editor allows you to view and modify the 
configuration of the management server. Use this editor to set up the 
management server to handle requests from clients (such as consoles and 
applications) efficiently. For more information, refer to Information for 
Administrators→Server Settings in the HP OpenView Service Desk 
online help.
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Multiple Management Servers

You can set up an environment with multiple management servers or 
multiple instances of the Object Server on one system (or both 
simultaneously) to provide load balancing for high volume client requests 
when your environment expands or when demands increase on existing 
resources. For more information, refer to Information for 
Administrators→Multiple Management Servers in the HP OpenView 
online help.

Troubleshooting Service Desk

You can use the following methods to troubleshoot Service Desk:

• Logging

• Tracing

• Service Desk Support Tool

Using Log Files

You can use Service Desk log file information to resolve problems. Refer 
to Chapter 12 “Logging” for information on how to use log files generated 
by Service Desk to resolve problems.

Tracing

You can investigate the cause of problems in Service Desk using HP 
OpenView Tracing. Use tracing as a troubleshooting procedure to 
provide trace log files so that you can pinpoint when and where a 
problem has occurred. For more information, refer to the HP OpenView 
Tracing: Concepts Guide.

Support Tool

Use the Service Desk 5.0 Support Tool when problems arise with Service 
Desk resulting in a call to the Service Desk support line. This tool 
collects information about the operating system and Service Desk and 
generates a Support Log file. For more information, refer to Chapter 13 
“Support Tool”.
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System Settings

Use the System Settings workspace to define general settings for all 
workspaces in the HP OpenView console. You can define the following: 

• Attachment Settings

• Configuration Exchange Settings 

• Email Settings 

• General Settings 

• Password Settings 

• Regional Settings 

• Incident System Action Setting

For more information, refer to Information for Administrators→System 
Settings in the HP OpenView online help.
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2 Service Pages

This chapter describes how to configure Service Pages and Service Pages 
accounts. Service Pages is a web-based application that provides limited 
access to Service Desk for licensed and unlicensed users.
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Service Pages provides a simplified web interface to Service Desk. Its 
main function is to allow users to remotely create, view and edit Service 
Desk objects. The objects that can be created depend on the type of user 
that logs on to Service Pages. There are two types of Service Pages user:

• Specialist User

Specialists are normal licensed Service Desk users (for example, 
support engineers). Their Service Desk account automatically gives 
them access to Service Pages, so they do not need a Service Pages 
account. Specialist users can use Service Pages to work remotely on 
service calls, incidents, problems, changes, and work orders.

• Service Pages (SP) User

SP users are not licensed Service Desk users. SP users do not have 
Service Desk accounts, so they need a Service Pages account to 
access the Service Pages application. Access is restricted to creating, 
viewing and editing service calls.

Table 2-1 shows a summary of object access in Service Pages: 

Additional functionality, such as access to FAQs, is available to all users.

Table 2-1 Object access in Service Pages

Account Type Object Type Allowed Access

SP User Service Call Create, view, edit

Specialist Service Call Create, view, edit

Incident Create, view, edit

Change View, edit

Problem View, edit

Work Order View, edit
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Service Pages is a Tomcat-based web application. It is accessed via the 
Apache web server. Tomcat and Apache must both be installed and 
running on the machine on which you want to Service Pages to run. You 
can use any standards-compatible web browser to access Service Pages.

NOTE For information about installing Service Pages, see the HP OpenView 
Service Desk 5.0 Installation Guide.

The general steps required to configure Service Pages are:

• Specify the views to be used in Service Pages.

See “Service Pages Views” on page 38.

• Specify the templates to be used to create objects in Service Pages.

See “Service Pages Templates” on page 42.

• Create Service Pages accounts. Alternatively, registered Persons can 
create their own accounts.

See “Service Pages Accounts” on page 45.

• Optional: Set password restrictions for Service Pages accounts.

See “Set Password Restrictions” on page 50.

• Optional: Customize the interface.

See “Customize the Interface” on page 56.

You define these settings in the Service Pages workspace. 
Chapter 2 37



Service Pages
Service Pages Views
Service Pages Views
Service Pages views are standard Service Desk views that you assign to 
Service Pages. You must assign views to Service Pages in order for the 
application to be usable. The views determine how Service Desk objects 
are listed, filtered and ordered in Service Pages, and they enable users to 
view and edit those objects. You can use existing views, or you can create 
new ones.

You assign two views for each object type that users can access: one to 
provide a restricted list of objects, and one to provide a full list of objects. 
You can assign a maximum of twelve views, as shown in Table 2-2.

It is the responsibility of the person who configures Service Pages (the 
Service Desk administrator) to decide what views should be used as the 
basis for the ‘restricted’ and ‘full’ lists. Typically, you assign a view with 
more filtering criteria to provide the restricted list, and a view with less 
restrictive filtering for the full list.

Table 2-2 Allowable Service Pages views

User Type Object Type Number of SP Views

SP User Service Call 1 Restricted list, 1 Full list

Specialist Service Call 1 Restricted list, 1 Full list

Incident 1 Restricted list, 1 Full list

Change 1 Restricted list, 1 Full list

Problem 1 Restricted list, 1 Full list

Work Order 1 Restricted list, 1 Full list
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Create a View for Service Pages

If you need to create new views for Service Pages, you can do so in the 
Service Pages workspace, or in the HP OpenView 
Configuration→Presentation workspace. 

To create a view in the Service Pages workspace:

1. In the Service Pages workspace, expand the Presentation→Service 
Pages View node, and then select an object type (for example, service 
call).

2. Right-click in the right-hand pane, and choose New View from the 
pop-up menu.

The View Properties Summary dialog box opens.

3. In the Name field, enter a name for the new view.

4. Select a View Type from the drop-down list.

NOTE The Service Desk view type (for example, Chart or Explorer) is 
ignored when a view is rendered in Service Pages. Service Pages 
shows all views as simple tables of data.

5. Click OK. The View Properties Summary for <view name> dialog 
box opens. 

The fields available in this dialog box depend on the type of view you 
are creating. For specific information about how to configure each of 
the different view types, see the online help.

6. When you have configured the view, click OK to close the View 
Properties Summary for <view name> dialog box.
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7. Click OK to close the View Properties Summary dialog box. The new 
view is displayed in the list of available views.
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Assign a View to Service Pages

You assign views to provide restricted and full lists in Service 
Pages→Presentation→View Settings.

To assign a view to Service Pages:

1. In the HP OpenView Configuration workspace group, select the 
Service Pages workspace.

2. Select Presentation→View Settings and double-click the icon for an 
object type (for example, service call) in the right hand pane.

The Service Pages View Settings - Service Calls dialog box opens.

3. Use the Quick Find buttons next to the Restricted list and Full list 
fields to assign the views that will be used to display data to SP users 
and specialists.
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Service Pages Templates
When users create a service call or incident in Service Pages, a 
predefined template is used as the basis for the new object. The template 
provides default values for some of the object’s attributes.

Service Pages templates are normal Service Desk templates. You can use 
existing Service Desk templates for Service Pages, or you can create new 
ones.

For information about creating templates in Service Desk, see the online 
help.
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Assign a Template to Service Pages

You can assign three templates to Service Pages:

• Service call template for SP users

• Service call template for support engineers

• Incidents template for support engineers

To assign a template to Service Pages:

1. In the HP OpenView Configuration workspace group, select the 
Service Pages workspace.

2. Expand the Service Pages→Data branch and select Template 
Settings. 

3. In the right-hand pane, double-click the Service Call icon. 

The Service Pages Template Settings - Service Call dialog box 
opens.
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4. Use the Quick Find icon next to the Template for insert fields in both 
the Support Engineer and SP End User areas, to choose the 
templates that will be used when creating service calls.

5. Click OK.
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A Service Pages (SP) account can be created by you (the Service Desk 
administrator), or by people who meet the following criteria:

• They are registered as valid Persons in Service Desk (for example, 
external customers).

• The value in the E-mail field of their Person record is an e-mail 
address from a valid Service Pages e-mail host. When a new Service 
Pages account is created, the password for the account is sent to this 
e-mail address.

NOTE For information about specifying valid e-mail hosts for Service Pages, 
see “Specify E-mail Hosts” on page 52.
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Create a Service Pages Account

Service Pages accounts can be created in two ways:

• In the Service Pages workspace 

Only an administrator can create an account in the Service Pages 
workspace. The user for whom the account is being created does not 
need to be registered as a Person in Service Desk. The administrator 
creates the account and specifies a password. Users can change their 
own passwords in the Service Pages application.

• In the Service Pages log-on dialog box

Anyone registered as a valid Person in Service Desk can create an 
account using the log-on dialog box. An administrator can also create 
accounts for valid Persons. 

The person creating the account enters a valid e-mail address, and 
either a telephone number, employee id, or surname. The details 
entered are used to search for a valid Person in Service Desk. If a 
record is found, an SP user account is created. The new account is 
automatically linked to the Person record, and the account details 
(including a password) are sent to the specified e-mail address.

To create an account in the Service Pages workspace:

1. In the HP OpenView Configuration workspace group, select the 
Service Pages workspace.

2. In the right-hand pane, expand the Service Page→Access branch 
and select Service Pages Account. The Service Pages Accounts 
view appears in the right-hand pane.

3. Right-click in the view, and choose New SP Account from the pop-up 
menu.

The New - SP Account dialog box opens.
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4. In the Display Name field, enter a name to use for this account. This 
is the name that is normally displayed (for example, in the Active 
Service Desk Sessions tab page).

5. In the Account Name field, enter the log-on name that the user will 
enter when logging on to Service Pages. This can be the same as the 
user’s NT logon, or it can be a different name.

6. Enter a Password, and confirm the entry.

7. Leave the Host field blank.

8. Enter the user’s Default language by selecting a language from the 
drop-down list. The list displays all the languages that are installed 
in Service Desk for localization.

9. Select the user’s Default time zone from the drop-down list. 

All records are stored on the database using Greenwich Mean Time. 
Data is adjusted to the user’s time zone setting when data is created, 
viewed, or modified.
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10. Select the Blocked check box if you want to disable the account. 

To change a Service Pages account password:

Do one of the following:

• Edit the account in the SP Account dialog box in Service Desk.

• Log on to Service Pages and select the Change Password menu item.
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Link a Service Pages Account to a Person

A Service Pages account can optionally be linked to a Person record in 
Service Desk. When you or someone else creates a Service Pages account 
using the Service Pages log-on screen, the account is automatically 
linked to the Person whose e-mail address is entered. 

When you (as administrator) create an account in the Service Pages 
workspace, it is not automatically linked to a person (because a Person 
record may not exist). However if your organization’s processes require 
you to link a Service Pages account to a Service Desk Person, you can do 
so using the following procedure.

To link a Service Pages account to a Person:

1. In the Organization workspace group, select the Person workspace. 
The SD All Persons view appears in the right-hand pane.

2. Double-click the required Person record, or right-click the record and 
choose Edit from the pop-up menu. The SD Person dialog box opens.

3. Click the Quick Find icon next to the Account field. The Quick Find 
dialog box opens.

4. In the Object Type field, select SP Account from the drop-down list, 
and click Find Next to display all Service Pages accounts.

5. Select the appropriate Service Pages account and click Choose. The 
Service Pages account name is displayed in the Account field of the 
Person record.

6. Click Save.
Chapter 2 49



Service Pages
Service Pages Accounts
Set Password Restrictions

You can set restrictions for user-defined passwords. These password 
restrictions apply to all Service Pages accounts.

To set password restrictions:

1. In the HP OpenView Configuration workspace group, select the 
Service Pages workspace.

2. In the right-hand pane, select Service Pages→System Panel. 
Double-click the Password Settings icon.

3. In the Service Pages Password Settings dialog box, select the 
options you require.

4. Click OK.
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Re-sending Account Details

Users sometimes forget their account log-on details (for example, their 
password). In this case, users can try to create a new Service Pages 
account in the log-on dialog box using the same e-mail address that the 
original account was created with. Service Pages detects the existence of 
the original account and re-sends the account details, including the 
account name and password, to the specified e-mail address.
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Specify E-mail Hosts

To enable people to create their own Service Pages accounts using the 
Service Pages log-on dialog box, you need to specify the hosts from which 
e-mail addresses can be accepted. For example, if a person wants to 
create a Service Pages account using the e-mail address 
Jane.Doe@company.com, the host company.com must be specified as a 
valid host name in the Service Pages settings.

You can also specify hosts from which e-mail addresses are not accepted, 
by specifying a host name and then blocking it.

To specify a valid e-mail host:

1. In the HP OpenView Configuration workspace group, select the 
Service Pages workspace.

2. Expand the Access branch below the Service Pages node, and select 
E-mail Hostname. The Hostname view appears in the right-hand 
pane.
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3. Right-click in the Hostname view, and select New E-mail Hostname 
from the pop-up menu. The New - E-mail hostname dialog box opens.

4. Enter the host name in the Hostname field.

5. If you want to prevent e-mail addresses with this host name from 
being used to create accounts, select the Blocked check box. 

Blocking allows you to exclude a host name without removing it from 
the system. This ensures the integrity of any database records that 
use this host name.

6. Click OK. 
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Enable E-mail Approval Requests
Service Desk provides the facility for approval to be requested via e-mail 
before specified actions can be performed. To enable this functionality, 
you must specify the fully-qualified host name for the Service Pages 
server in the General Settings dialog box.

To specify the Service Pages server name:

1. In the HP OpenView Configuration workspace group, select the 
System Settings workspace.

2. Double-click the General Settings icon to open the General Settings 
dialog box, and then click the Application tab. 
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3. Enter the server name in the Service Pages Server Host Name field. 

4. Click OK.

5. Follow the instructions in “Receive Outbound E-mail Messages” on 
page 115 to enable requests for approval by e-mail.
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Customize the Interface
You can customize the links, fonts and the logo in the Service Pages 
header. To do this, edit the HTML files. These can be found in the folder 
\\Service Desk 5.0\ServicePages.

To customize the logo:

1. Open the logo1.html file with an HTML editor such as Microsoft® 
FrontPage Editor.

2. Insert the graphic of your choice in the HTML line <IMG 
src=”xxxx.gif”>, where xxxx is the Hewlett Packard logo.

3. Save the file. Make sure that your editor has the character set 
defined as Multilingual (Unicode UTF-8) language.

To customize the links:

1. Open the links.html file with an HTML editor such as Microsoft® 
FrontPage Editor.

2. Replace the default links with the links of your choice.

3. Save the file. Make sure that your editor has the character set 
defined as Multilingual (Unicode UTF-8) language.

To customize the font:

1. Open the file sd-sp.css.

2. Change the default fonts to the fonts of your choice.

3. Save the file.
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3 The HP OpenView Web Console

This chapter provides information about the HP OpenView web console.
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Introduction to the HP OpenView Web 
Console
The HP OpenView web console provides an alternate method of 
accessing and working with a limited set of object types and predefined 
views. Your team must create the views using the Java version of the HP 
OpenView console, before they are visible in the HP OpenView web 
console.

This section includes the following information:

• “Architecture of the Web Console” on page 58

• “Distribution of the Web Console” on page 60

• “Features and Benefits of the Web Console” on page 60

• “Limitations of the Web Console” on page 61

Architecture of the Web Console

The web console architecture includes three main elements, as shown in 
Figure 3-1: web console client, management server, and database server. 
The web console requires that three services/daemons are running: 

• Apache HTTP Server (ovapacheA)

• Apache Tomcat Servlet Engine (ovtomcatA)

• Object Server (ovobs)
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Figure 3-1 Web Console Architecture

The web console uses the Apache Tomcat Servlet Engine as the 
application server. By starting and stopping the Apache Tomcat Servlet 
Engine, you also start and stop the web console (and the online help for 
both the web console and HP OpenView console). 

The web console requires that three servlets are running within the 
Apache Tomcat Servlet Engine:

• Portal (ovportal) to communicate with the Object Server for 
authentication during login (using HP OpenView console accounts 
and passwords) and for accessing data.

• Oracle Help for the Web (ohw) to display the web console online help 
files.

• Online Help Assembler (ohs) to combine (at runtime) all online help 
files provided by HP and provided by you. This feature is used by 
both the HP OpenView console and the HP OpenView web console.

• Additional servlets may be running.
Chapter 3 59



The HP OpenView Web Console
Introduction to the HP OpenView Web Console
Distribution of the Web Console

The web console supports a three-tiered distribution model (as shown in 
Figure 3-2): 

• Web console client

• Management server (where the HP OpenView console is installed)

• Database server

The model supports placement of a firewall between the web console 
client and management server, with HTTP as the protocol between them.

Figure 3-2 Three-Tiered Distribution Model

Features and Benefits of the Web Console

The web console enables you to give users a personalized and remote 
view of the managed environment through the following benefits and 
features:

• Remote access to data:

— Requires Internet Explorer 6.x, Mozilla 1.4.x, or Firefox 1.0.x or 
greater.

— No client installation is necessary.

• Provides much of the functionality available in the Java version of 
HP OpenView console:
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— Table, explorer, tree, and chart views
— Views and forms for all object types
— Overview and Smart actions

• Gives your users a personalized view:

— A variety of portal skins based on cascading style sheets
— Data filtering and access to actions based on the user’s role as 

defined in the Java version of the HP OpenView console

• Minimal configuration and administration:

— No download necessary for client systems
— Same user name and password as that established for the Java 

version of the HP OpenView console 
— The Web Console Administrator page for troubleshooting 

problems

• Online help system that explains the tasks you can perform through 
the web console

Limitations of the Web Console 

Some general features are supported only in the Java version of the HP 
OpenView console and not available in the web console: 

• User-configured workspace groups. (The web console displays a list of 
workspaces for all object types available to the users.)

• Multiple-object-instance selection. 

• Multiple-object-instance update. 

• Cut, copy, and paste. 

• Drag and drop. 

• Persistence of user’s last selected object type and last view selected 
for an object type. 

• The More Choices tab in the Advanced Find window.

Some form features are supported only in Java version of the HP 
OpenView console and are not available in the web console: 

• Ability to create new form definitions or form templates. 
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• The Templates selection list is not organized into a hierarchy of 
template categories. 

• Specialized UI field types (for example, UI Approval Vote).

• Access to Quick views.

• User notifications.

Some view features are supported only in the Java version of the HP 
OpenView console and are not available in the web console: 

• Cannot access views of the following types within the web console:

— Card view type. 

— Combination view type.

— Diagram view type.

— Map view type.

— Project view type. 

— Chart view drill-down. 

• Your view Format Rules settings (established in the Java version of 
the HP OpenView console) are ignored.

• Cannot change your view Filter settings from within the web console 
(data is automatically filtered according to your current settings in 
the Java version of the HP OpenView console). 

• Cannot export your views to external formats such as CSV, HTML, 
XML from within the web console.

Some actions are supported only in the Java version of the HP OpenView 
console and are not available in the web console:

• System Actions.

• Shortcut menus for fields.

• Some UI rules
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Verify the Installation
After installing the software, verify that you can access the web console.

Open the Web Console

1. Start the web console by opening a browser window and entering the 
URL that accesses the web console: 
http://<yourhostname>/ovportal

NOTE If you configured the Apache HTTP Server to a port other than 80, 
use the following URL instead, where port is the configured Apache 
HTTP Server port for the web console:

http://<yourhostname:port>/ovportal

2. On the web console login page, enter a valid name and password, and 
click Login, as shown in Figure 3-3.
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NOTE Only “Application account” users (named and concurrent users) can 
log into web console, “SP Account” users cannot.

Figure 3-3 Login Page

After logging in, the web console shown in Figure 3-4, “Web Console 
with “system” Login,” appears.
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NOTE For help with troubleshooting an installation problem, see Resolve Web 
Console Installation Problems.

Figure 3-4 Web Console with “system” Login
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Exit the Web Console

When you are finished using the web console, log off: 

1. In the upper right-hand corner of the web console main window, click 
the Logout button, 

2. Close your Web browser.
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Essential Web Console Concepts
This section includes the following information:

• “Web Console Authorization and Authentication” on page 67

• “Refresh Model for Modified Configuration and Data Files” on 
page 68

• “Web Console Windowing Behavior” on page 70

• “Configuration Options” on page 74

• “Start Up Options” on page 75

Web Console Authorization and Authentication

Currently the Apache HTTP Server (ovapacheA) does not support 
HTTPS. Therefore, all data is transferred as unencrypted HTTP. For a 
more secure alternative, use the Java Web Start access to the HP 
OpenView console.

Authorization

Authorization is the granting of access privileges to an authenticated 
user. This determines what each user can see and do.

The web console uses the roles established in the Java version of the HP 
OpenView console.

A user logging into the web console as “system” user also gets access to 
the Web Console Administrator page, where certain administrative tasks 
can be performed. The Web Console Administrator page is accessed by 
selecting Web Console Administrator from a drop-down list on the web 
console button bar.

Authentication

Authentication is the process by which users identify and validate 
themselves to the system. The HP OpenView console administrator sets 
up the management server to verify credentials. However, for the HP 
OpenView web console, only the default HP OpenView user 
authentication mechanism is supported: 
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• The default user authentication mechanism (users log in using an 
HP OpenView console account name and password that is stored in 
the HP OpenView database).

• An external authentication mechanism (for example, users log in 
through an Active Directory or LDAP server).

Refresh Model for Modified Configuration and Data 
Files 

Changes take effect in the web console in one of four ways, depending on 
the type of configuration or data change:

• When you access the information by displaying or refreshing the web 
console.

• When you log out and log in again to the web console.

• When you restart the Apache Tomcat Servlet Engine.
Certain data is loaded when the web console is first initialized. This 
data is not refreshed unless the Apache Tomcat Servlet Engine is 
stopped and restarted. 

• On a scheduled, periodic basis, based on a refresh rate that you can 
configure.

Table 3-1 lists each refresh method described above, and indicates the 
type of configuration or data that uses each method. It also indicates the 
procedure for refreshing the data or file.

Table 3-1 Refresh Model for Configuration and Data Files

Refresh 
Method Configuration or Data How to Refresh the Data 

or File

Access User preferences, such as web console skin, 
and user name in the web console title bar.

Display or refresh the web 
console window.
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Logout Changes made using the Java version of the 
HP OpenView console, such as:

• Modifying a role definition

• Creating or modifying a view

• Creating, changing, or assigning a 
template

• Creating and modifying an action

• Creating and modifying an application

• Activating a custom field and adding it to 
a form

• Creating and modifying a form

• Changing fields that are visible on the 
simple page of the Advanced Find dialog

• Changing UI rules

• Changing icon for an item type

• Adding a calculated field; for example, 
adding a calculated field and adding that 
field to a form

NOTE: Some things are cached for the 
duration of a session (for example, views, 
forms, and icons), and changes made using 
the Java version of the HP OpenView console 
only take effect when the user logs out of that 
session and logs in again.

Log out and log in again to 
the web console.

Table 3-1 Refresh Model for Configuration and Data Files (Continued)

Refresh 
Method Configuration or Data How to Refresh the Data 

or File
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Web Console Windowing Behavior

The main window of the web console has a view display panel in which 
various views of data can be displayed. The window behavior differs 
when you activate a link from the view display panel on the main 
window, versus when you activate a link from a menu, tool bar, or 
secondary window.

Restart Configuring applications exposed through 
web console: the Applications.xml file. For 
more information, see “Configure Supported 
Applications for Smart Actions” on page 77.

Configuring URL links to appear in web 
console Links panel: the ovconsole.xml file. 
For more information, see “Configure the 
URLs for the Links Panel” on page 78.

Modifying the size of log files (maxLogSize 
value): the OVPortalConfig.xml file. For 
more information, see “Control the Size of the 
Log Files and Trace Files” on page 84.

Stop and restart the Apache 
Tomcat Servlet Engine. For 
instructions, see “Restart the 
Apache Tomcat Servlet 
Engine” on page 104.

Periodic Configuring the maximum number of forms to 
cache (maxCachedForms value): the 
WebConsoleConfig.xml file. For more 
information, see “Configure the Maximum 
Number of Forms in Cache” on page 86.

Changes take effect 
automatically within the 
time limit defined by the 
configFileReloadInterval 
parameter value in the 
WebConsoleConfig.xml file. 
By default, this occurs every 
30 minutes.

Table 3-1 Refresh Model for Configuration and Data Files (Continued)

Refresh 
Method Configuration or Data How to Refresh the Data 

or File
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Links in the first column of a table view (as shown in Figure 3-5) provide 
drill-down to additional data. When you follow these links, the main 
window content is replaced (as shown in Figure 3-6, “Web Console after 
Link Is Selected (form displayed),”).

Figure 3-5 Web Console with Object Browser Outlined

When you 
click a link in 
the view 
display panel, 
the web 
console page is 
replaced.
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Figure 3-6 Web Console after Link Is Selected (form displayed)
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Activating a link from a menu, tool bar, or secondary window causes the 
requested content to be displayed in a separate window, as shown in 
Figure 3-7.

Figure 3-7 Link from Secondary Window Resulting in Separate Window

A new 
window 
displays 
when you 
activate a 
link from a 
menu, tool 
bar, form, or 
dialog box.
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Configuration Options

The web console offers configuration options that range from 
personalizing the look and feel of the web console to specifying the rate 
at which the data is refreshed. 

Some configuration options are available to all users and others are only 
available to administrators of the web console. Some choices are specified 
through the web console, and others must be specified by editing XML 
files.

User Configuration Options

Two personalization options are available to users and explained in the 
online help:

• Display name in the title bar

• Preferred skin (look and feel)

To access these settings, click the Options button in the upper right 
corner of the web console main window.

Administrator Configuration Options

Several configuration choices are available to the web console 
administrator. Some are configured through the Web Console 
Administrator page and others are configured by editing XML files.

The Web Console Administrator page settings:

• Set logging and tracing levels (see “Logging and Tracing” on 
page 83).

• Restart the Apache Tomcat Servlet Engine (see “Restart the Apache 
Tomcat Servlet Engine” on page 104). 

The Applications.xml file settings:

• Enable smart actions for the web console (see “Configure Supported 
Applications for Smart Actions” on page 77). 

The ovconsole.xml file settings:

• Specify the URL links to appear in the Links panel within the web 
console main window (see “Configure the URLs for the Links Panel” 
on page 78).
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The OVPortalConfig.xml file settings:

• Specify the size of the log files, defined by the maxLogSize parameter 
(see “Control the Size of the Log Files and Trace Files” on page 84).

The WebConsoleConfig.xml file settings:

• Specify the maximum number of forms to be cached per session, 
defined by the maxCachedForms parameter (see “Configure the 
Maximum Number of Forms in Cache” on page 86).

• Specify the rate at which the changes to the WebConsoleConfig.xml 
file take effect, defined by the configFileReloadInterval 
parameter. By default every 30 minutes (see “Configure the 
Maximum Number of Forms in Cache” on page 86).

• Display the names of currently unsupported fields, controlled by the 
displayUnsupportedFieldInfo parameter. This is useful to verify 
that an attribute is not showing up in the web console because it is 
not supported (see “Troubleshoot Missing Form Fields” on page 107).

NOTE Many of your configuration settings in the Java version of the HP 
OpenView console are honored by the web console. If you change settings 
in the Java version of the HP OpenView console, they are automatically 
reflected on the web console. For example, the time zone settings for each 
user.

Start Up Options

Any user can open the web console to a specific view or form.

1. Start the web console by opening a browser window and entering the 
following URL:

http://<yourhostname>/ovportal

NOTE If you configured the Apache HTTP Server to a port other than 80, 
use the following URL instead, where port is the configured Apache 
HTTP Server port for the web console:
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http://<yourhostname:port>/ovportal

2. Log in with your user name and password.

3. Navigate to the desired view or form.

4. Access the URL information:

• Views: In the Object Types list, right click the name of the 
currently highlighted view (that you displayed in the previous 
step), and select Copy Shortcut.

• Forms: Copy the URL from the Address field of the Web Browser.

5. Paste this URL into your browser and follow step one and two.

Use this URL to access the web console to the desired start up 
location.

NOTE This view- or form-specific URL contains management-server-specific 
object identifiers. If load balancing is implemented in your environment, 
this technique may not work because the object identifiers change, 
depending upon which management server intercepts your request.
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This section includes the following information:

• “Configure Supported Applications for Smart Actions” on page 77

• “Configure the URLs for the Links Panel” on page 78

Configure Supported Applications for Smart Actions

Web console provides a way to filter the available smart actions. A smart 
action is available in the web console only if the smart action is first 
configured on the Java version of the HP OpenView console, and then 
that same smart action’s name and type must be listed in the web 
console’s Applications.xml file. 

1. Make a copy of this file. Then open the original file for editing:

Windows operating system:

<install_dir>\data\conf\webconsole\share\modules\console\Applications.xml

UNIX and Linux operating systems:

/var/opt/OV/conf/webconsole/share/modules/console/Applications.xml

2. In the XML file, specify the following three attributes for each 
application, as shown in the following example code:

<Applications>
  <Application name="Internet Explorer" type="WebBrowser"/>
  <Application name="Netscape" type="WebBrowser"/>
  <Application name="Ping" type="Command" timeout="5"/>
</Applications>

• The Application name attribute is configured in the Java 
version of the HP OpenView console, such as “Internet Explorer” 
or “Ping”

• The Application type attribute must have one of two values:

"WebBrowser" = the command is a URL to be opened in a Web 
browser window

"Command" = the command is an executable to be launched on the 
management server
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• The Application timeout attribute is required only when 
type="Command". Specify the number of seconds to wait before 
displaying results. This setting prevents a command from 
causing the web console to hang indefinitely.

3. After modifying the XML, validate that the syntax is correct. For 
information about validating XML syntax, see “Validate XML Files” 
on page 109.

4. After making changes to the Applications.xml file you must stop 
and restart the Apache Tomcat Servlet Engine. For information, see 
“Restart the Apache Tomcat Servlet Engine” on page 104.

NOTE For HP-UX operating system, if you want to execute multiple commands 
that include piping the output (for example, /bin/tail -n12 /tmp/log 
| mail www@localhost), you can do the following:

1. In the Java version of the HP OpenView console, define an 
application 'Shell' that has a command line '/bin/sh' and a starting 
directory '/tmp'

2. In the Java version of the HP OpenView console, create a smart 
action Mail which uses the Shell application, with the parameters 
/bin/tail -n12 /tmp/log | mail www@localhost (no quotes 
around the parameter string).

3. In the web console Applications.xml file, define the application 
name as Mail, as shown below:
 
<Application name="Mail" type="Command" timeout="5"/>

When this smart action is invoked, mail is sent to the user 
www@localhost (or whatever you set up as web user) with the last 12 
lines of the /tmp/log as the contents of the message.

Configure the URLs for the Links Panel

You can configure a list of URL links for HP OpenView web console Links 
panel (directly below the Object Type selection panel). 

Although you may have defined URL views in the HP OpenView console, 
they are not displayed in the web console. You must follow these steps to 
provide URL links in the web console.
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When a user clicks one of your defined links, the URL displays in the web 
console browser window unless you specify a target window name in your 
URL definition. If more than one link refers to the same target, all those 
links reuse the same named window. If each link refers to a different 
target, each link displays in its own named window: one instance 
allowed. Subsequent requests replace the contents of each named 
window.

1. Make a copy of this file. Then open the original file for editing:

Windows operating system:

<install_dir>\data\conf\webconsole\share\views\ovconsole.xml

UNIX and Linux operating systems:
/var/opt/OV/conf/webconsole/share/views/ovconsole.xml

2. In the XML file, specify the following elements and attributes to 
specify the URL links, as shown in the following example code:

<OVConsole>
 <Bookmarks>
   <Entry title="Click here" href="http://www.abc.com" />
   <Entry title="Support call" href="http://my.support.com" target="_blank" />
   <Group title="Links for XYZ Information">
        <Entry title="X Information" href="http://www.X.com" target="win_XYZ" />
        <Entry title="Y Information" href="http://www.Y.com" target="win_XYZ" />
        <Entry title="Z Information" href="http://www.Z.com" target="win_XYZ" />
     </Group>
 </Bookmarks>
</OVConsole>

• The Bookmarks element contains one or more Entry and Group 
elements. If no Bookmarks element is defined, the Links panel 
does not appear.

• Optional: The Group element contains one or more Entry 
elements. When a Group elements is defined, a line of text is 
displayed above the links contained in the group.

title Type the text for the title bar that appears 
above the links included in this group.

• The Entry element attributes establish your URL link:

title Type the text that you want for the link. 

href Type the fully qualified URL.
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target Optional: 

Type a name if you want the contents of this 
URL to display in a specific window. 

"_blank" = launch a new browser window 
every time the user clicks this link.

"_self" = same behavior as not specifying any 
target value (display in the web console 
browser window).

3. After modifying the XML, validate that the syntax is correct. For 
information about validating XML syntax, see “Validate XML Files” 
on page 109.
Chapter 380



The HP OpenView Web Console
Routine Web Console Administration Tasks
Routine Web Console Administration Tasks
This section includes the following information:

• “Access the Web Console Administrator Page” on page 82

• “Logging and Tracing” on page 83

• “Restart the Apache HTTP Server” on page 85

• “Configure the Maximum Number of Forms in Cache” on page 86

See also the following information in the Resolve Web Console 
Installation Problems section:

• “Restart the Apache Tomcat Servlet Engine” on page 104

• “Run the JVM Garbage Collector” on page 104
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Access the Web Console Administrator Page

 Log in using the user name system to access the web console 
administrator privileges. Then in the role selection list, select Web 
Console Administrator. The Administrator can set logging and tracing 
and control the Apache Tomcat Servlet Engine.

Figure 3-8 Administration Page
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Logging and Tracing

A web console log file is available to help you troubleshoot problems with 
the web console. The log file contains warning and error entries:

• A warning is logged to indicate that a problem occurred, but the web 
console continued running, possibly using a default value or some 
assumption. The warning is issued because you may not agree with 
the assumption, and you might want to fix the problem.

• An error is logged when a problem prevents the web console from 
completing a task. For instructions about fixing errors, read the error 
description.

Console tracing is primarily intended for use by HP support. It supplies a 
large amount of extra data that may be used to debug problems. You are 
advised to turn web console tracing on only if instructed to do so by 
support personnel. 

You have these choices, as described in the sections that follow:

• “View the Log Files From Within the Web Console” on page 83

• “Set the Trace Level and View the Trace Files” on page 105

• “Control the Size of the Log Files and Trace Files” on page 84

View the Log Files From Within the Web Console

1. Log into the web console using a role that includes administrator 
privileges. For more information, see “Access the Web Console 
Administrator Page” on page 82.

2. In the role selection list, select Web Console Administrator.

3. To see “warning” and “error” messages, go to the Logging and 
Tracing segment and click the log file View button. 

Click the Help button for more information about log file entries.

The last 500 kb of the log file are displayed in the web console 
interface. 
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View the Log Files Directly

There is actually a series of log files. The log file ends with 
".log.<0-2>". When a log file reaches maximum size, the last number 
automatically increments (check the date/time stamp of each file to 
determine the most recent one):

• Maximum revolving log files = 3

• Maximum log file size = 10 M

• Total maximum size of all three revolving log files = 40 M

If you want to examine the contents of a log file, look in the following 
location:

Windows operating system: 
<install_dir>\data\log\ui-console.log.0
 through 
<install_dir>\data\log\ui-console.log.2

UNIX and Linux operating systems: 
/var/opt/OV/log/ui-console.log.0
through 
/var/opt/OV/log/ui-console.log.2

Control the Size of the Log Files and Trace Files

NOTE See also “Set the Trace Level and View the Trace Files” on page 105.

The default size for a log file or trace file is 10 MB. When that size is 
reached, the file rolls to the next available number. It is possible to lose 
information when a file already exists and is overwritten:

ov-console.log.0 through ov-console.log.2

ov-console.log.0 through ov-console.log.2

To change the size of the log and trace files, do the following:

1. Make a copy of the following file. Then open the original file for 
editing:

Windows operating system: 
<install_dir>\data\conf\webconsole\framework\ 
OVPortalConfig.xml
Chapter 384



The HP OpenView Web Console
Routine Web Console Administration Tasks
UNIX and Linux operating systems: 
/var/opt/OV/conf/webconsole/framework/OVPortalConfig.xml

2. Modify the maxLogSize attribute value (bytes) of the 
OVPortalConfig element, as shown in the following code:

<OVPortalConfig
    tracingLevel="none"
    maxLogSize="10000000"
    portalHeader=""
    portalFooter=""
    showHeader="yes"
    showFooter="yes"
    showTabs="no"
    cacheXSL="yes">

The maxLogSize attribute controls the size of the following files:

ui-ovconsole.log.<0-2>

ui-ovconsoletrace.log.<0-2>

3. After modifying the XML, validate that the syntax is correct. For 
information about validating XML syntax, see “Validate XML Files” 
on page 109.

4. After validating your changes to the OVPortalConfig.xml file, you 
must restart the Apache Tomcat Servlet Engine before your change 
take effect. For information on doing so, see “Restart the Apache 
Tomcat Servlet Engine” on page 104.

Restart the Apache HTTP Server

The Apache HTTP Server is a fully featured web server (the Apache 
Tomcat Servlet Engine is an application server). Apache HTTP Server 
receives requests from web console clients, processes html/image 
requests, and forwards appropriate requests to the Apache Tomcat 
Servlet Engine. You can restrict access to web pages using Apache HTTP 
Server configurations. You can implement load balancing across multiple 
installations to create a solution suited to your security needs. If you 
need to restart the Apache HTTP Server, do the following:

Windows operating system:

1. In the Control Panel, select Administrative Tools→Services. 

2. Stop and then start the HP OpenView Apache(A) Webserver 
Service. 
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TIP Alternatively, at the command prompt, type:
ovc -stop ovapacheA 
ovc -start ovapacheA

UNIX and Linux operating systems:

1. As root, stop the Apache HTTP Server by running the following 
commands:

/opt/OV/bin/ovc -stop ovapacheA

2. Verify that the DISPLAY variable is set properly. See “Ensure an X11 
Display Is Always Available (only UNIX and Linux operating 
systems)” on page 102.

3. As root, start the Apache HTTP Server by running the following 
commands:

/opt/OV/bin/ovc -start ovapacheA

Configure the Maximum Number of Forms in Cache

If virtual memory becomes a problem you can change the cache size 
attribute value that controls how many forms per session are stored in 
cache memory. Each time a user closes a web console secondary window 
without using the OK or Cancel button, the cache memory is not 
released. The cache can fill up. The cache size attribute puts an upper 
limit on the number of forms stored in memory per session.

The WebConsoleConfig.xml file settings apply to each web console user 
session running on your management server. To change the cache file 
settings, do the following:

1. Make a copy of this file. Then open the original file for editing:

Windows operating system:

<install_dir>\data\conf\webconsole\share\modules\console\WebConsoleConfig.xml

UNIX and Linux operating systems:

/var/opt/OV/conf/webconsole/share/modules/console/WebConsoleConfig.xml

2. In the XML file, specify the following three attributes, as shown in 
the following example code:
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<WebConsoleConfig maxCachedForms="30" 
                  configFileReloadInterval="30"
                  displayUnsupportedFieldInfo="false"/>

 The maxCachedForms attribute is the maximum number of forms 
that can be cached for each user session. The value must be greater 
than or equal to 5. 

The configFileReloadInterval attribute is the time (in minutes) 
before changes to this file take effect. The value must be greater than 
or equal to 0. If set to zero, changes take effect immediately. Default 
value is 30 minutes.

The displayUnsupportedFieldInfo attribute displays a list of 
fields that are unsupported in the web console. For more information, 
see “Troubleshoot Missing Form Fields” on page 107.

NOTE This displayUnsupportedFieldInfo feature is designed for web 
console administrators only. Do not set it to True in a production 
environment. This feature displays code in the user interface that 
may cause confusion among end users and result in support calls.

3. After modifying the XML file, validate that the syntax is correct. For 
information about validating XML syntax, see “Validate XML Files” 
on page 109.

4. Force your changes take effect in one of two ways:

• Immediately, by restarting the Apache Tomcat Servlet Engine. 
Be aware that all current web console sessions are terminated 
when you restart the Apache Tomcat Servlet Engine. For more 
information, see “Restart the Apache Tomcat Servlet Engine” on 
page 104.

• After saving the WebConsoleConfig.xml file, wait the amount of 
time specified in your configFileReloadInterval attribute.
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This section includes the following information:

• “Resolve Web Console Installation Problems” on page 88

• “Understand Web Console Display Differences” on page 106

Resolve Web Console Installation Problems

If the web console does not run as expected after installation, verify that 
the following elements are working. Verify them in the order listed in the 
following sections: 

NOTE During installation, the Apache HTTP Server and Apache Tomcat 
Servlet Engine are configured to run on the ports that you specify. You 
need to know these port numbers to complete the following procedures. If 
you do not know which ports are in use, see the Determine Current Web 
Console Port Configuration section. If you need to change a port, see the 
Change Web Console Port Assignments section.

• Verify Communication with the Apache Tomcat Servlet Engine

• Verify Communication with the Apache HTTP Server

• Verify Authentication is Working

• Verify Communication with the Object Server

If you are still having problems after verifying the installation, see the 
following sections for additional troubleshooting techniques:

• Troubleshoot the Apache HTTP Server

• Respond to Routine Error Messages

— “Maximum # concurrent users can log in at one time”

— “The maximum of logins with the same user has been reached”

— “You have been logged out...You have no authorization”

• Resolve the “Internal Server Error” Message
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• Resolve Out of Memory Errors

• Determine which Management Server

• Ensure an X11 Display Is Always Available (only UNIX and Linux 
operating systems)

• Run the JVM Garbage Collector

• Restart the Apache Tomcat Servlet Engine

• Set the Trace Level and View the Trace Files

Verify Communication with the Apache Tomcat Servlet Engine

1. On the management server, at the command prompt, type the 
following to enable the test port (HTTP port):

Windows operating system:
cscript <install_dir>\bin\ovtomcatctl.vbs -enablehttp

UNIX and Linux operating systems: 
/opt/OV/bin/ovtomcatctl -enablehttp

NOTE You may want to disable this port once you are finished 
troubleshooting:

Windows operating system:
cscript <install_dir>\bin\ovtomcatctl.vbs -disablehttp

UNIX and Linux operating systems: 
/opt/OV/bin/ovtomcatctl -disablehttp

2. Determine the currently assigned port number of the HTTP test port 
(see the Determine Current Web Console Port Configuration section 
and find the HTTPPort value).

3. Type the following URL into a web browser to contact the Apache 
Tomcat Servlet Engine (<port> = the HTTPPort value):

http://<serverName>:<port>/ovportal

4. If the web console login page is displayed, then the Apache Tomcat 
Servlet Engine is functioning properly. This page looks odd because 
you are contacting the Apache Tomcat Servlet Engine directly, rather 
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than through the Apache HTTP Server that renders the graphics. Go 
to section Verify Communication with the Apache HTTP Server and 
follow the steps.

If the web console login page does not display, do the following:

Windows operating system:

i. Check the Apache Tomcat Servlet Engine log file for messages or 
clues:

<install_dir>\nonOV\tomcat\a\logs\localhost_log.<yyyy-mm-dd>.txt

ii. At the command line, type:
<install_dir>\bin\ovc -stop ovtomcatA 
<install_dir>\bin\ovc -start ovtomcatA

iii. If this fails, you can attempt to start it with a .bat file from a 
command window, and observe the troubleshooting messages 
displayed in the command window. 

Navigate to the following directory: 
<install_dir>\nonOV\tomcat\a\bin

At the command prompt, type startup.bat

iv. Return to step 3 of this section, type the URL to contact the 
Apache Tomcat Servlet Engine, and repeat Windows 4-i through 
4-iii.

UNIX and Linux operating systems:

i. Check the Apache Tomcat Servlet Engine log file for messages or 
clues:

/opt/OV/nonOV/tomcat/a/logs/localhost_log.<yyyy-mm-dd>.txt

ii. As root, stop the Apache Tomcat Servlet Engine by running the 
following command:

/opt/OV/bin/ovc -stop ovtomcatA

iii. Verify that the DISPLAY variable is set properly. See Ensure an 
X11 Display Is Always Available (only UNIX and Linux 
operating systems).

iv. As root, start the Apache Tomcat Servlet Engine by running the 
following command:

/opt/OV/bin/ovc -start ovtomcatA
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v. Return to step 3 of this section, type the URL to contact the 
Apache Tomcat Servlet Engine, and repeat UNIX 4-i through 
4-iv.

Verify Communication with the Apache HTTP Server

1. Determine the currently assigned HTTP port number (follow the 
instructions in the Determine Current Web Console Port 
Configuration section and find the HTTP value for the Apache HTTP 
Server).

2. Type the following URLs into a web browser to access the Apache 
HTTP Server (<port> = the current Apache HTTP Server HTTP port 
value):

http://<serverName>:<port>

Figure 3-9 Apache HTTP Server Main Window 

If the Apache HTTP Server page is not displayed, but instead you 
receive an error, see the instructions in the Troubleshoot the Apache 
HTTP Server section.

Verify Authentication is Working

1. Type the following URLs into a web browser to launch the web 
console (<port> = the current Apache HTTP Server HTTP port value):

http://<serverName>:<port>/ovportal
Chapter 3 91



The HP OpenView Web Console
Troubleshoot the Web Console
If you don’t know the current Apache HTTP Server HTTP port value, 
follow the instructions in the Determine Current Web Console Port 
Configuration section.

2. Try logging into the web console with a user ID and password.

If you see the error message “Login incorrect”, verify that the user ID 
and password are valid.

The login names and passwords that are created for the HP 
OpenView console, work in the HP OpenView web console. Login 
names and passwords are case sensitive.

3. If you still cannot log in, check the roles.log file for any messages 
or clues:

Windows operating system: <install_dir>\data\log\roles.log
UNIX and Linux operating systems: /var/opt/OV/log/roles.log

4. Regenerate the web console role database by typing the following at 
a command prompt:

Windows operating system: <install_dir>\bin\create_role_db

UNIX and Linux operating systems: (as a user with write permission 
to the /opt/OV/bin directory) /opt/OV/bin/create_role_db

TIP For the create_role_db command to work from outside the bin 
directory, add the following to your PATH variable:

Windows operating system: <install_dir>\bin
UNIX and Linux operating systems: /opt/OV/bin

5. Try logging into the web console again.

Verify Communication with the Object Server

1. On the management server system, type the following at the 
command line:

• Windows operating system:
<install_dir>\bin\ovc -status

• UNIX and Linux operating systems:
/opt/OV/bin/ovc -status
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Text is displayed on your monitor that lists each daemon/process of 
the HP OpenView console and indicates whether or not each is 
currently running. 

2. Locate ovobs and verify that it is running.

If ovobs is not running, at the command line, type the following:

• Windows operating system:
<install_dir>\bin\ovc -start ovobs

• UNIX and Linux operating systems:
/opt/OV/bin/ovc -start ovobs

3. Try to log in to the web console again.

If you are still unable to log into the web console, follow the 
directions in these sections:

• See Resolve the “Internal Server Error” Message if you get this 
message.

• See “Maximum # concurrent users can log in at one time” if you 
get this message.

• Resolve Out of Memory Errors

• If you encounter some other behavior, call HP support.

Determine Current Web Console Port Configuration

Two ports are used by the web console:

1. One port from the browser to the Apache HTTP Server.

2. One port for communication with the Apache Tomcat Servlet Engine. 
There are actually three possible ports, but the web console uses only 
one.

To determine the current port to the Apache HTTP Server:

On the management server system, type the following at the command 
line:
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• Windows operating system:
cscript <install_dir>\bin\OvApacheCtl.vbs -getconf

• UNIX and Linux operating systems:
/opt/OV/bin/ovapachectl -getconf

Three parameters are displayed on your monitor that specify the current 
port configuration for the Apache HTTP Server (the order may be 
different): 

Port=<port>
ServerName=<serverName>
WebStartEnabled=<True/False>

To determine the current ports to the Apache Tomcat Servlet Engine:

On the management server system, type the following at the command 
line and find the JK2AJP13Port setting:

• Windows operating system:
cscript <install_dir>\bin\ovtomcatctl.vbs -getconf

• UNIX and Linux operating systems: 
/opt/OV/bin/ovtomcatctl -getconf

Several parameters are displayed on your monitor that specify current 
port configuration for the Apache Tomcat Servlet Engine (the order may 
be different). The ones that are important for web console 
troubleshooting tasks are in bold: 

HTTPPort=<port>
EnableHTTP=<True/False> 
HTTPSPort=<port>
EnableHTTPS=<True/False> 
Jk2Ajp13Port=<port>
EnableJk2Ajp13=True 

The web console uses the following port settings:

• The JK2AJP13Port value is the JK2 port

• The HTTPPort value is the HTTP port (only used when enabled for 
testing purposes)
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Change Web Console Port Assignments

Two ports are used by the web console, one for the Apache HTTP Server 
and one for the Apache Tomcat Servlet Engine. These two processes talk 
to each other, so you should stop both of them before changing the port 
for either of them. 

1. On the management server system, type the following at the 
command line:

Windows operating system:
<install_dir>\bin\ovc -stop ovapacheA
<install_dir>\bin\ovc -stop ovtomcatA

UNIX and Linux operating systems: 
(as root) /opt/OV/bin/ovc -stop ovapacheA
/opt/OV/bin/ovc -stop ovtomcatA

2. To change the port number for the Apache HTTP Server, type the 
following at the command line. Replace <port> with the port number 
you want to use:

• Windows operating system:

cscript <install_dir>\bin\OvApacheCtl.vbs -setport <port>

• UNIX and Linux operating systems:
/opt/OV/bin/ovapachectl -setport <port>

3. To change the J2K port number for the Apache Tomcat Servlet 
Engine, at the command line, type the following. Replace <port> 
with the port number you want to use:

• Windows operating system:

cscript <install_dir>\bin\ovtomcatctl.vbs -setjk2port <port>
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• UNIX and Linux operating systems: 
/opt/OV/bin/ovtomcatctl -setjk2port <port>

4. Start the Apache Tomcat Servlet Engine, at the command line, type 
the following:

Windows operating system:
<install_dir>\bin\ovc -start ovtomcatA

UNIX and Linux operating systems:

i. Verify that the DISPLAY variable is set properly. Follow the 
instructions in the Ensure an X11 Display Is Always Available 
(only UNIX and Linux operating systems) section.

ii. As root, run the following command:

/opt/OV/bin/ovc -start ovtomcatA

5. Start the Apache HTTP Server. Type the following at the command 
line:

Windows operating system:
<install_dir>\bin\ovc -start ovapacheA

UNIX and Linux operating systems:
(as root) /opt/OV/bin/ovc -start ovapacheA

Troubleshoot the Apache HTTP Server

You tried to open the web console, but got an error message indicating 
that the management server is not responding and may be down. You 
need to start the Apache HTTP Server.

Windows operating system:

If you need to temporarily enable and set the troubleshooting port (HTTP 
port) :

Windows operating system:
cscript <install_dir>\bin\ovtomcatctl.vbs -enablehttp
cscript <install_dir>\bin\ovtomcatctl.vbs -sethttpport <port>

UNIX and Linux operating systems: 
/opt/OV/bin/ovtomcatctl -enablehttp
/opt/OV/bin/ovtomcatctl -sethttpport <port>
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1. Check to see if the Apache HTTP Server is running by typing the 
following at the command prompt:

 <install_dir>\bin\ovc -status ovapacheA.

Check the output list to see if the Apache HTTP Server is running.

2. If the Apache HTTP Server is not running, type the following 
command at a command prompt:

<install_dir>\bin\ovc -stop ovapacheA 
<install_dir>\bin\ovc -start ovapacheA

3. Type the following URLs into a web browser to access the Apache 
HTTP Server (<port> = the current Apache HTTP Server HTTP port 
value (if you don’t know the current port number, follow the 
instructions in the Determine Current Web Console Port 
Configuration section):

http://<serverName>:<port>

Figure 3-10 Apache HTTP Server Main Window 

If it still does not display, check the Apache HTTP Server log file for 
messages or clues:

<install_dir>\data\log\apache\a\error_log

UNIX and Linux operating systems:

1. Check to see if the Apache HTTP Server is running by typing the 
following at the command prompt:
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 /opt/OV/bin/ovc -status ovapacheA.

Check the output list to see if the Apache HTTP Server is running.

2. If the Apache HTTP Server is not running, type the following 
command at a command prompt:

/opt/OV/bin/ovc -start ovapacheA

3. Type the following URLs into a web browser to access the Apache 
HTTP Server (<port> = the current Apache HTTP Server HTTP port 
value (if you don’t know the current port number, follow the 
instructions in the Determine Current Web Console Port 
Configuration section):

http://<serverName>:<port>

Figure 3-11 Apache HTTP Server Main Window 

If it still does not display, check the Apache HTTP Server log file for 
messages or clues:

/var/opt/OV/log/apache/a/error_log

Respond to Routine Error Messages

Following are error messages you may get while using the web console. 
They appear here in alphabetical order.

“Maximum # concurrent users can log in at one time”  This error 
message can occur when:

• A user is logging into the web console, or
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• A user is already logged in, and the session times out and tries to 
reconnect, but there are no longer any concurrent user licenses 
available.

Problem

Too many users are logged into the web console. 

If a user is logged in to the web console, but has been idle for a while, and 
in the meantime other concurrent users log in, the above message can be 
displayed.

In the OVPortalConfig.xml file, you can control the following aspects:

• SessionTimeout = the web console session time-out (default value 9 
hours entered as 23400 seconds). 

• InvalidSessionTimeout = the invalid session time-out value 
(default 1.5 hours entered as 5400 seconds). After the 1.5-hour 
session time-out value is reached, the web console automatically 
attempts to reconnect to the management server upon the next user 
request to update the web page. If in the meantime, other concurrent 
users log in and the “Concurrent Users” limit of your license is 
exceeded (that is, the total number of “sessions” allowed for all 
accounts designated as concurrent users), the above error message 
appears.

• SessionCleanupInterval = the per-user session time-out value 
(default 5 minutes entered as 300 seconds)

Solution

Wait until someone else logs out and then log in. If this happens 
regularly, consider purchasing more licenses.

“The maximum of logins with the same user has been reached”  

This error message can occur when:

• A user is logging into the web console, or

• A user is already logged in and the session times out and tries to 
reconnect but there are no more active sessions available for this 
user.
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Problem

The basic problem is that a named user has exceeded the fixed number of 
active sessions allowed per user. When this number is exceeded the 
above error message appears in the web console.

The web console has a default number of active sessions allowed per user 
(set in OVPortalConfig.xml).

Solution

Stay within the fixed number of active sessions granted to a named user. 
If you need to change the default setting, edit the following file:

 Windows operating system:

<install_dir>/data/conf/webconsole/framework/OVPortalConfig.xml

UNIX and Linux operating systems:

/var/op/OV/conf/webconsole/framework/OVPortalConfig.xml

“You have been logged out...You have no authorization”  When 
starting the web console, you get a login page but cannot log in and then 
receive an authorization error such as “You have been logged out with 
the following message: You have no authorization.”

Problem

The web console role database may not be working properly. Regenerate 
the web console role database.

Solution

Follow the instructions in Verify Authentication is Working.

Resolve the “Internal Server Error” Message

1. First verify that the Apache Tomcat Servlet Engine (ovtomcatA) is 
running on the correct host. Follow the directions in these sections: 

• Determine which Management Server.

• Verify Communication with the Apache Tomcat Servlet Engine 
(if you have not already done so).

2. Then clear the web console cache by removing the following 
directory:
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Windows operating system: 

<install_dir>\data\datafiles\webconsole\Application Data\

UNIX and Linux operating systems: 
/var/opt/OV/datafiles/webconsole/.ov/

3. Log into the web console as the web console administrator and clear 
the virtual cache (follow the instructions in the Run the JVM 
Garbage Collector section), and restart the Apache Tomcat Servlet 
Engine (follow the instructions in the Restart the Apache Tomcat 
Servlet Engine section). 

Resolve Out of Memory Errors

The Apache Tomcat Servlet Engine fails to start because the Java 
Virtual Machine is not running. You receive out of memory errors.

Problem and Solution:

You need to increase the Java Virtual Machine memory limit.

Windows operating system:

1. Launch regedit.

2. Navigate to 

HKEY_LOCAL_MACHINE\System\CurrentControlSet\Services\OVTomcatA\Parameters

3.  Select \JVM Option Number 1

4. Increase the value (default is -Xmx512M)

5. Follow the instructions in the Restart the Apache Tomcat Servlet 
Engine section.

UNIX and Linux operating systems:

1. Increase MAX_HEAP_SIZE in /etc/rc.config.d/ovtomcatA (default 
is 512m).

2. Follow the instructions in the Restart the Apache Tomcat Servlet 
Engine section.

Determine which Management Server

It is possible to set up a pool of management servers for load balancing. 
In this case, there may be times when you need to determine which 
management server is providing access to the web console.
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To determine if a pool of management servers is enabled:

1. Run the following tool:

Windows operating system:

<install_dir>/bin/OvObsServerSettingsEditor.bat

UNIX and Linux operating systems:

/opt/OV/bin/OvObsServerSettingsEditor

2. Check the settings for Advanced, Join Multiple Servers (True/False). 
If True, the management server currently in use at any time is 
determined at runtime.

If a pool of management servers is enabled, to determine which 
management server is providing access to the web console:

1. Set the tracing level to “tracing”. For more information, see the Set 
the Trace Level and View the Trace Files section.

2. In the trace file look for a line like the following:

Login succeeded: user = "<accountName>" server = "<serverName>"

Ensure an X11 Display Is Always Available (only UNIX and Linux 
operating systems)

The management server uses Java’s Abstract Windows Toolkit (AWT) to 
generate graphical images for chart views. On UNIX and Linux 
operating systems, this means that the Apache Tomcat Servlet Engine 
requires access to a running X11 display at all times. If the specified X 
window locks or goes into a modal state, the management server is no 
longer available. For this reason, it may be advisable to use a dedicated 
virtual X11 display server. 

Edit the Apache Tomcat Servlet Engine configuration file 
(/etc/rc.config.d/ovtomcat) so that the DISPLAY environment 
variable points to either your hardware X11 display or your virtual X11 
display server:

DISPLAY=<hostname>:<#>

hostname The system where the X11 display server is running.

# The DISPLAY number associated with the X11 display 
server process.
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To point to an active X11 display server, uncomment the second line of 
this text block so that matches the following:

#### Uncomment this line for hardware X11 display
HARDWARE_DISPLAY=localhost:0

To point to an active virtual X11 display server, uncomment the second 
line of this text block so that matches the following, and adjust the 
DISPLAY number if necessary:

#### Uncomment this line for VNC virtual X11 display
VNC_DISPLAY=localhost:1

Installing a Virtual DISPLAY Server   If you plan to use a virtual 
X11 display server, the latest version of the Xvnc (Virtual Network 
Computing) display server is available from the following web site:

http://www.realvnc.com/

This site has a Download section with VNC installation packages for the 
Solaris operating system and (in Depot format) the HP-UX operating 
system. This site also has an active mailing list and complete 
documentation.

Solaris operating system users have two other sources for VNC. There is 
an installation package provided on the Solaris “Software Companion 
CD”. Also, the following website includes a free VNC installation 
Package:

http://www.blastwave.org

Once VNC is installed, log in using the user name and password 
assigned to the Apache Tomcat Servlet. Open VNC and establish a 
password. Then modify the Tomcat launch script to call out the DISPLAY 
number of the virtual display. Here are some important points to 
remember when installing VNC on Solaris or HP-UX operating systems:

• Don’t run VNC under the root-user, which would be a security risk. 
Run VNC under the same user name that Tomcat is using, the 
default is www.

• Make sure the VNC user was write-access to the directory:  
/tmp/.X11-unix

• /etc/rc.config.d/ovtomcat file: modify the line that defines the 
DISPLAY variable. This file is overwritten if you reinstall the HP 
OpenView console. 
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• /opt/OV/nonOV/tomcat/bin/catalina.sh file: comment-out the 
-Djava.awt.headless=true option. This file is overwritten if you 
reinstall the HP OpenView console. 

• Use a secure password for your VNC session, and (for better security) 
consider using the vncserver -localhost option.

• The log files and startup options are found in the VNC user’s home 
.vnc sub-directory.

Run the JVM Garbage Collector

The web console can force your Java Virtual Machine (JVM) to free up 
any previously requested system memory that is currently not being 
used:

1. Log into the web console using a role that includes administrator 
privileges.

2. In the role selection list, select Web Console Administrator.

3. In the Servlet Engine Control segment, click Garbage Collect.

Restart the Apache Tomcat Servlet Engine

The web console is a Java servlet that is accessed through the Apache 
Tomcat Servlet Engine. After making certain configuration changes in 
the web console, you must restart the Apache Tomcat Servlet Engine 
before your changes take effect.

From the Web Console Administrator Page  Be aware that you and 
all other web console users will be logged out when you restart the 
Apache Tomcat Servlet Engine.

1. Log into the web console using a role that includes administrator 
privileges.

2. In the role selection list, select Web Console Administrator.

3. In the Servlet Engine Control segment, click Restart.

From Outside of the Web Console  Be aware that you and all other 
web console users will be logged out when you restart the Apache Tomcat 
Servlet Engine.

Windows operating system:
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1. Check to see if the Apache Tomcat Servlet Engine is running by 
typing the following at the command prompt:

 <install_dir>\bin\ovc -status ovtomcatA.

Check the output list to see if the Apache HTTP Server is running.

2. If the Apache HTTP Server is not running, type the following 
command at a command prompt:

<install_dir>\bin\ovc -stop ovtomcatA 
<install_dir>\bin\ovc -start ovtomcatA

UNIX and Linux operating systems:

1. As root, stop the Apache Tomcat Servlet Engine by running the 
following commands:

/opt/OV/bin/ovc -stop ovtomcatA

2. Verify that the DISPLAY variable is set properly. See “Ensure an X11 
Display Is Always Available (only UNIX and Linux operating 
systems)” on page 102.

3. As root, start the Apache Tomcat Servlet Engine by running the 
following commands:

/opt/OV/bin/ovc -start ovtomcatA

Set the Trace Level and View the Trace Files

Turn on tracing only if instructed to do so by support personnel. To turn 
on tracing, perform the following steps:

1. Log into the web console using a role that includes administrator 
privileges.

2. In the role selection list, select Web Console Administrator.

3. In the Logging and Tracing segment, set the trace level.

Tracing can be turned on for either all web console sessions on the 
management server or only the current session. 

Setting the trace level to greater than “none” causes entries to be 
written to the trace file. Click the Help button for more information 
about tracing levels: Error, Info, Warning, or Verbose.

4. Click Apply at the bottom of the page.

5. Display the trace file by clicking the View trace file View button.
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NOTE Only the last 500 kb of the trace file is displayed in the web console 
interface. If you want to examine the contents of the entire file, see the 
following:

Windows operating system: 
<install_dir>\data\log\ui-consoletrace.log.0
 through 
<install_dir>\data\log\ui-consoletrace.log.2

UNIX and Linux operating systems: 
/var/opt/OV/log/ui-consoletrace.log.0
through 
/var/opt/OV/log/ui-consoletrace.log.2

Understand Web Console Display Differences

The behavior of the web console does not exactly match what you see in 
the HP OpenView console. This section explains some of those 
differences:

• “Understand the Timezone Field on the Login Page” on page 106

• “Troubleshoot Missing Form Fields” on page 107

• “The New button is missing from Service Today views” on page 107

• “The initially displayed view is not predictable” on page 107

• “There is no way to determine which filter is currently active in any 
view” on page 108

• “Understand Lookup Field Behavior” on page 108

Understand the Timezone Field on the Login Page

On the web console login page, a Timezone selection field appears 
sometimes, but not at other times.

This is expected behavior. Whenever the Apache Tomcat Servlet Engine 
is restarted, the Timezone selection field does not appear on the login 
page until after the first successful login has occurred. With each 
additional login, the Timezone field appears on the login page (unless, of 
course, the Apache Tomcat Servlet Engine has been restarted again).
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Troubleshoot Missing Form Fields

Sometimes a field appears on a form in the Java version of the HP 
OpenView console, but when that same form is accessed using the web 
console, the field is missing. Several form fields are not supported in this 
release of the web console.

By editing an XML file, you can enable a feature that will help you 
determine or confirm which fields are unsupported.

CAUTION This feature is designed for web console administrators only. Do not 
enable it in a production environment. This feature displays code in the 
user interface, that may cause confusion among end users and result in 
support calls.

You need to edit the following file. Follow the directions in the “Configure 
the Maximum Number of Forms in Cache” on page 86 section:

Windows operating system:

<install_dir>\data\conf\webconsole\share\modules\console\WebConsoleConfig.xml

UNIX and Linux operating systems: 

/var/opt/OV/conf/webconsole/share/modules/console/WebConsoleConfig.xml

The New button is missing from Service Today views

The “New” button is not available on Service Today views. And “New” is 
not available on the Choose a Menu Item drop-down list. However, if you 
use a Service Today view in table format, you can right click on any row 
and display the shortcut menu. The New menu item is available on the 
shortcut menu. This is because multiple object types are displayed in the 
Service Today view. You need to select the which object type you wish to 
create before selecting New.

The initially displayed view is not predictable

The view you were using at the end of your last web console session is not 
the view displayed then you initiate another web console session. The 
initially displayed view is based upon your role’s default view. To open 
the web console to a different location, follow the instructions in the 
“Start Up Options” on page 75 section.
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There is no way to determine which filter is currently active in 
any view

The web console does not have any filter manipulation features. The web 
console does not show current filter selection, nor allow the user to apply 
filters. If any filters are applied to a view in the Java version of the HP 
OpenView console, then the web console honors them (filtering the data 
appropriately), but there is no indication that a filter is applied. There is 
no work around at this time.

Understand Lookup Field Behavior

Lookup field behavior in the web console may not match the lookup field 
behavior in the Java version of the HP OpenView console.

In the Java version of the HP OpenView console, you can type part of an 
item's search text into a Lookup field; and if the entered text matches 
more than one object, a list of those matches automatically appears after 
you move focus to the next field.

In the web console, if there are multiple matches, the list is not 
automatically displayed. When multiple matches exist, the form 
validation fails. You must click the Quick Find button next to that 
Lookup field to display the list and make a selection.
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Rules When Editing XML Files
This section includes the following information:

• “Back Up XML Files” on page 109

• “Validate XML Files” on page 109

Back Up XML Files

Make a backup of any XML configuration file before you make changes. 
If you edit the file and use incorrect XML syntax, you can revert to the 
previous version of your file.

Validate XML Files

The web console detects and reports an invalid XML configuration file. 
However, after you make modifications to an XML file, it is important 
that you validate your XML syntax. 

The xmlvalidate command, checks an XML file to see if it is 
well-formed and valid. This command uses the same XML parser as the 
web console, so if xmlvalidate validates the XML file, it will work with 
the web console. 

The JAVA_HOME environment variable must be set to run xmlvalidate. 

NOTE For the command to work from outside the bin directory, add the 
following to your PATH variable:

Windows operating system: <install_dir>\bin
UNIX and Linux operating systems: /opt/OV/bin

The correct usage of the xmlvalidate command is:

xmlvalidate <xml file name>

An XML file is well formed if it conforms to a minimal set of rules defined 
for all XML documents. It is “valid” if it conforms to the DTD listed at the 
beginning of the XML file.
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Sometimes an error reported by xmlvalidate may not clearly indicate 
how to fix the problem. For example, a message like “Attribute <name> 
must be declared for element type <name>” is an indication that the 
attribute ‘name’ may have been misspelled.

As an alternative to xmlvalidate, you can find an XML validation tool 
for Windows at www.xmlspy.com. 
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4 E-mail

This chapter explains how to integrate e-mail with Service Desk, and the 
options available for e-mail messaging with Service Desk.
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You can configure Service Desk to perform specified functions in 
response to incoming e-mail, and to send outgoing e-mail in response to 
specified events. 

The following example shows how e-mail messaging can be used with 
Service Desk:

1. A caller experiences a problem in the IT infrastructure and sends an 
e-mail message to Service Desk requesting service.

2. The e-mail message is received by Service Desk and a service call is 
created using a template. The service call is completed based on 
information in the e-mail and default values in the service call 
template.

3. The service call is assigned to the specialist whose name was entered 
by default from the service call template. A notification e-mail is 
automatically sent to the specialist.

4. The specialist fixes the problem and sends an e-mail message to 
Service Desk. This automatically updates the service call with the 
solution and the status field is changed to Solved.

5. A database rule is triggered by the change in status, and the caller is 
notified by e-mail of the solution.

6. The caller applies the solution, then sends an e-mail message to 
Service Desk to automatically change the service call status to 
Closed.
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Inbound E-mail
E-mail messages sent to Service Desk are referred to as Inbound E-mail. 
Information in the e-mail heading (From, To, Cc, and Subject lines) 
determines how Service Desk processes the e-mail message. Information 
in the message body text is used to provide details for the action that is 
performed.

Inbound E-mail messages can trigger Service Desk to do the following:

• Create a service call.

• Update a service call.

• Add a history line to a service call.

• Recall a service call.

The e-mail sender can use an Inbound E-mail message to:

• Request and receive a list of open service calls reported by or 
assigned to the sender.

• Accept or reject the solution a specialist has entered for a service call. 

• Ask for help.

Inbound E-mail messaging has the following limitations:

• Inbound E-mails can be plain text or HTML-based. 

• Attachments are accepted, but inline attachments (for example, a 
graphic inserted into the body of the message) are not. 

• Only service calls can be created and updated through Inbound 
E-mail messaging. Other objects (for example, configuration items, 
persons, and changes) cannot be created or updated.

Service Desk can accept e-mail messages from any standard SMTP based 
e-mail application. 

You can set e-mail access filters to limit the addresses from which 
Service Desk accepts Inbound E-mail messages. For details, see “Filter 
Inbound E-mail” on page 124.
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Outbound E-mail
E-mail messages sent from Service Desk are referred to as Outbound 
E-mail.

Service Desk can use Outbound E-mail to do the following:

• Send e-mail notifications to people when they are assigned a service 
call, problem, change, work order or other object. For more 
information, see “Receive Outbound E-mail Messages” on page 115.

• Send a confirmation message to a caller when a service call is created 
for that caller. For more information, see “Inbound E-mail 
Commands” on page 140.

• Send e-mail messages based on events that occur in the Service Desk 
database, using the Rule Manager. For example, Service Desk can 
send an e-mail message notifying a caller of changes to the status or 
solution field of a service call created by that caller.

NOTE For information about configuring the Rule Manager to send e-mail 
messages, see Information for Administrators→Rules→Creating 
Database Rules and UI Rules in the HP OpenView Service Desk online 
help.

All recipients of Outbound E-mail must be registered in Service Desk 
with a valid e-mail address. This applies to members of external 
organizations, as well as members of Service Desk workgroups.
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Receive Outbound E-mail Messages

In the Service Desk client application, users can select the check boxes 
to: 

• Receive e-mail notification from Service Desk when an object is 
assigned to them

• Receive e-mail notification when an object needs their approval

These options are stored in the database as attributes of the person 
object. You can add the check boxes to a Person form to maintain these 
settings. 

Administrators can also set these default options during installation. 

To receive Outbound E-mail messages:

1. Click Tools→Options. The Options dialog box opens.

2. Click the Notification tab.

3. Select the following check boxes:

• Send Me E-mail When Objects are Assigned to Me 

• Send Me E-mail If I Need to Approve an Object

4. Click OK.
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Configuring E-mail Integration
To configure Service Desk to send and receive e-mail messages, perform 
these tasks:

• Mandatory tasks

— Server

— Select the Activate the SMTP Protocol check box and set the 
IP port number in the server settings editor (for Inbound 
E-mail)

— Enter e-mail addresses for Person objects

— Client

— Select the option Send Me E-mail When Objects Are 
Assigned to Me in Service Desk

— Define e-mail server settings in the System Settings 
workspace

— Enter one or more Inbound E-mail addresses for Service 
Desk in the System Settings workspace and link each one to 
a service call template

• Optional tasks

— Modify the default e-mail commands

— Modify the e-mail templates used for service calls

— Set the access filters

— Map the importance levels of Inbound E-mail messages to 
Service Desk object priority codes

NOTE Make sure that the client machines for your organization use 
MIME-compatible e-mail applications, and that the character set 
selected (in the E-mail Properties dialog box) is available to these clients.
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Define General E-mail Settings

You can perform most of the configuration tasks for e-mail messaging in 
the E-mail Properties dialog box located in the System Settings 
workspace. 

NOTE For more information about SMTP configuration tasks, refer to the HP 
OpenView Service Desk Installation Guide.)

To enter general settings for e-mail messaging:

1. In the HP OpenView Configuration workspace group, click the 
System Settings workspace.

2. Double-click the E-mail icon.
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The E-mail Properties dialog box opens. The General tab shows 
information about your e-mail server.

3. Enter the complete name of your e-mail server in the E-mail Server 
field.

4. Enter the number of your SMTP port.

(For Inbound E-mail, make sure you have selected the Activate the 
SMTP Protocol check box and the Port Number in the server settings 
editor.)

5. In the From Address field, enter the return e-mail address.

6. In the From Alias field, you can enter an alternative name that users 
see in the From field when they receive e-mail messages from Service 
Desk.
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CAUTION Entering the address for your Service Desk application server in the 
From Address field or the From Alias field is not recommended. 
Doing so may result in the creation of unwanted service calls or 
e-mail messages.

7. In the Reply To field, enter the e-mail address for people to use when 
they reply to messages from Service Desk.

8. In the Character Set field, enter the character set that the e-mail 
recipient uses. 

The default is US-ASCII. If sending e-mail in any other format, you 
may need to use the encoding option and you need to use one of the 
character sets supported by Service Desk. (Service Desk supports all 
character sets which are listed and implemented by Sun.)

For more information about character sets, see the Sun web site:

http://java.sun.com/j2se/1.4/docs/guide/intl/encoding.doc.html

If your database or operating system does not support the character 
set used, the object you want to create or modify may be corrupted 
(for example, a message sent using a Japanese character set does not 
appear correctly on a machine using an English Windows NT 
operating system). If the character set you use is not on the list, you 
can probably use UTF-8.

See Table 4-1, “Commonly Used Character Set Names,” on page 120, 
for examples of what can be entered in the character set field. Note 
that these names are case-sensitive. You may enter any other 
character set name that is supported by Sun.

9. Select the Use Base 64 Encoding check box to enable message 
encoding. 

10. Click Send Test Mail to verify that the settings are correct by 
sending a test message.

NOTE The Send Test Mail button is not available until save your changes. 
To do so, click Apply, or click OK and then re-open the E-mail 
Properties dialog box.
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11. Optional: Enter an e-mail address in the E-mail Address For 
Logging E-mail Messages field.

All confirmation messages for handled messages are copied to that 
address. 

12. Optional: Enter an e-mail address in the E-mail Address For 
Logging Wrong E-mail Messages field.

All responding error messages sent from Service Desk are copied to 
that address.

13. Select the E-mail Debug check box to add additional information to 
the application server log file when e-mail messaging errors occur. 

NOTE Select the E-mail Debug check box only for debugging, as setting this 
option has a negative effect on performance.

Table 4-1 Commonly Used Character Set Names

Character set name Description

Big5 Traditional Chinese

EUC-JP EUC encoding, Japanese

EUC-KR EUC encoding, Korean

GB2312 EUC encoding, Simplified Chinese

ISO-2022-JP Japanese (JIS X 0201 and JIS X 
0208)

ISO-2022-KR Korean

ISO-8859-1 Latin alphabet No. 1

ISO-8859-2 Latin alphabet No. 2

ISO-8859-3 Latin alphabet No. 3

ISO-8859-4 Latin alphabet No. 4

ISO-8859-5 Latin/Cyrillic alphabet

ISO-8859-6 Latin/Arabic alphabet
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NOTE Additional information on encoding and MIME compliance is available 
on the Internet at the following web addresses:

http://www.faqs.org/rfcs/rfc1521.html

http://www.faqs.org/rfcs/rfc1522.html

ISO-8859-7 Latin/Greek alphabet

ISO-8859-8 Latin/Hebrew alphabet

ISO-8859-9 Latin alphabet No. 5

KOI8-R Russian

Shift_JIS Japanese

US-ASCII American Standard Code for 
Information Interchange

UTF-7 Seven-bit Unicode Transformation 
Format

UTF-8 Eight-bit Unicode Transformation 
Format

windows-1250 Windows Eastern European

windows-1251 Windows Cyrillic 

windows-1253 Windows Greek

Table 4-1 Commonly Used Character Set Names (Continued)

Character set name Description
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Add Inbound E-mail Addresses

The Inbound E-mail Addresses tab of the E-mail Properties dialog box, 
shown in Figure 4-1, is used to enter Service Desk e-mail addresses that 
can receive Inbound E-mail. Each e-mail address can be linked to a 
specific template, which is used to create new service calls.

Figure 4-1 Inbound E-mail Addresses
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To add Inbound E-mail addresses and link them to service call 
templates:

1. In the New - Inbound E-mail Address dialog box, click Add, and then 
enter the Service Desk E-mail Address.

2. Click the Quick Find icon next to the Service Call Template field to 
select a template to be used when the new service call command is 
received at this e-mail address.

3. Click OK to save. 

4. Optional: Repeat steps 1 to 3 to add additional addresses and link 
them to service call templates.

NOTE Service calls contain mandatory fields. Before linking a template to a 
Service Desk e-mail address, make sure you enter a default value for the 
mandatory fields in that template.
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Filter Inbound E-mail

You use the Access Filter tab to create a list of addresses from which 
Service Desk does accept Inbound E-mail messages, and a list of 
addresses from which Service Desk does not accept Inbound E-mail. You 
can use the asterisk symbol (*) as a wildcard at the beginning and end of 
address entries. 

If you do not enter any e-mail addresses in the Allowed Addresses area of 
the Access Filter dialog box, Service Desk accepts e-mail from all e-mail 
addresses.

If there is a conflict between an allowed address and a denied address, 
the allowed address takes precedence. For example, if jane.doe@hp.com 
is allowed, and *@hp.com is denied, Jane Doe is allowed access.

To set access filters for Inbound E-mail:

1. Select the Access Filters tab in the E-mail Properties dialog box.

2. In the Allowed Addresses area, click the New button to add a new 
e-mail address. 

The New - Allowed Address dialog box opens.
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3. Enter an e-mail address from which you want to receive Inbound 
E-mail. You can use wildcard characters such as an asterisk (*).

4. Click File→Save and Close to close the New - Allowed Address 
dialog box.

5. Edit e-mail filters by highlighting the filter in the Access Filter tab 
and clicking the Edit button.

6. Remove filters by highlighting the filter and clicking the Delete 
button.
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7. Follow steps 2 to 6 in the Denied Addresses area to create and 
modify addresses from which you do not want to receive Inbound 
E-mail.

8. After you create all the required filters, click OK.
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Overview of Inbound E-mail Commands

When users send e-mail messages to Service Desk, they can enter 
commands in the subject line of the message. These commands tell 
Service Desk what action to perform when the message is received. The 
E-mail Commands tab in the E-mail Properties dialog box allows you to 
modify the options for each command. You can do the following: 

• Set the access level for each command.

• Specify if attachments are allowed.

• Specify if a history line is added when the command is executed.

• Send a confirmation message when a command is received.

• Specify the template to be used for the command.

Table 4-2 lists all commands available for Inbound E-mail, the actions 
triggered by that command, and the programmed response from Service 
Desk.

For a full description of each command, see “Inbound E-mail Commands” 
on page 140.

Table 4-2 Overview of Inbound E-mail Commands

Command Action System 
Response Remark

New Creates a new 
service call 
using attribute 
values from the 
e-mail message 
and from the 
template linked 
to the target 
e-mail address.

Sends e-mail 
reply to the 
e-mail address 
of the sender 
with details of 
the new service 
call.

Automatic 
system response 
is optional.
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Update<id> Updates the 
service call 
specified by 
<id>, based on 
the attribute 
values entered 
in the message.

Sends e-mail 
reply to the 
sender with the 
details of the 
modified 
service call.

Automatic 
response is 
optional.

View<id> None Sends e-mail 
reply to the 
sender with the 
details of the 
service call 
specified.

Service call 
attachments can 
also be sent 
(optional).

List None Sends e-mail 
reply to the 
sender with a 
list of all open 
calls from that 
sender.

Service calls 
announced by 
sender and 
service calls 
assigned to 
sender.

RE:RFI<id> Adds a history 
line to the 
service call 
specified by 
<id>. For 
example, you 
can change the 
status to 
additional info 
received.

Sends e-mail 
reply to the 
sender 
“Information is 
received”.

Automatic 
system response 
is optional.

Table 4-2 Overview of Inbound E-mail Commands (Continued)

Command Action System 
Response Remark
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RE:Solution 
Accepted<id>

Adds a history 
line to the 
service call 
specified by 
<id>. For 
example, 
change service 
call status to 
“solution 
accepted”.

Sends e-mail 
reply to the 
sender “Service 
call closed”

Automatic 
system response 
is optional.

RE:Solution 
Rejected<id>

Adds a history 
line to the 
service call 
specified by 
<id>. For 
example, 
change service 
call status to 
“solution 
rejected”.

Sends e-mail 
reply to the 
sender “Service 
call is not 
closed”.

Automatic 
system response 
is optional. 
Caller has not 
accepted the 
solution.

Recall<id> Adds a history 
line to the 
service call 
specified by 
<id>. For 
example, 
change service 
call status to 
“recalled”.

Sends e-mail 
reply to the 
sender “Service 
call recalled”.

Automatic 
system response 
is optional. 

Help None Sends e-mail 
reply to the 
sender with 
e-mail 
command help 
text.

Help text is 
editable.

Table 4-2 Overview of Inbound E-mail Commands (Continued)

Command Action System 
Response Remark
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no 
recognizable 
command

None Sends e-mail 
reply to the 
sender with the 
original 
command and 
a failed 
message.

You can 
configure the 
integration to 
create a new 
service call for 
all e-mail 
messages that 
come in with an 
unrecognizable 
command.

Table 4-2 Overview of Inbound E-mail Commands (Continued)

Command Action System 
Response Remark
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Configure E-mail Commands

In the E-mail Properties dialog box, you can define how Service Desk 
processes each inbound e-mail command when it is received in an 
Inbound E-mail message. You can also restrict the use of e-mail 
commands to specific users.

To configure an Inbound E-mail command:

1. In the E-mail Properties dialog box, click the E-mail Commands tab.

The E-mail Commands tab page lists the available commands, with 
their default settings.

2. Select the command you want to edit, and click Edit. 
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The E-mail Command dialog box opens.

3. In the Command field, enter the command to be sent by users to 
Service Desk. 

The name of the command cannot be changed, but the command 
itself can be changed. For example, the New command could be called 
Service. To create a service call, Inbound E-mail users would then 
enter Service instead of New in the subject field of their e-mail 
message.

4. Set the Access Level for each command by selecting one of the 
following options:

• Unrestricted
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All e-mail messages sent to a Service Desk address are accepted. 
The Service Desk system administrator account is used to 
provide access.

• Only Existing Persons

The name in the From field of the e-mail message must match a 
person registered in Service Desk. The sender’s name and e-mail 
address are entered in the service call. The system account is 
used for access. If there is more than one name in the From field, 
or the name is not recognized as a person registered in Service 
Desk, an error message reply is sent.

• Only Existing Person with Account

The name in the From field of the e-mail message must match a 
person registered in Service Desk. The sender’s name and 
account name are entered in the service call. The roles and 
authorizations for that person’s account are used (for example, 
authorization to create service calls, or authorization to change 
the status when updating a service call). If there is more than 
one name in the From field, or the name is not recognized as that 
of a person registered in Service Desk, an error message reply is 
sent.

• Unavailable

Turns the command off. E-mail messages are not accepted with 
that command.

5. Optional: Set additional access restrictions for commands:

• Person Does Not Have to be Caller or Assignee

Any person who has access to Service Desk can use the 
command. This is the only option available for the New service 
call command.

• Person Must be Caller

The name or e-mail address of the person who wants to update a 
service call must match the original service call. The sender’s 
e-mail address must match that of the person in the Service Desk 
Caller field, or the e-mail address in the Information field.

• Person Must be Assignee
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The name or e-mail address of the person who wants to update a 
service call must be the person to whom the service call is 
currently assigned. If the service call is assigned to a group, the 
assignee can be any person from that group. 

If a service call is assigned to an external person, only that 
person can update the service call. Other members of the 
external organization cannot update the service call.

• Person Must be Caller or Assignee

The name or e-mail address of the person who wants to update a 
service call must match the original service call, or must match 
the person to whom the service call is currently assigned. If the 
service call is assigned to a group, the assignee can be any person 
from that group.

If a service call is assigned to an external person, only that 
person can update the service call. Other members of the 
external organization cannot update the service call.

6. Optional: To enable Service Desk to accept attachments for the 
command, select the Insert Attachments Allowed check box.

7. Optional: To add a history line when the command is executed, select 
the Add History line check box.

In the Subject History Line field, type the text you want to be copied 
to the Subject field of the new history line (for example, New 
service call from e-mail).

8. In the Status field, enter the status you want new service calls and 
updates to receive. 

If you do not select a status from the list, a status is not entered 
when the command is executed (unless a status is entered in the 
default template for the New service call command).

9. Optional: To change the template, click the E-mail Templates tab.

The E-mail Template field shows the e-mail template for reply 
messages that was assigned to the command in the E-mail 
Templates dialog box. 

10. Optional: If you want Service Desk to send a confirmation message to 
the sender of the e-mail message, select the Send Confirmation 
check box.
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11. Optional: Select the Send Attachments check box if you want Service 
Desk to forward attachments that are received with Inbound E-mails 
using this command.
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Map E-mail Priority

Incoming e-mail messages can have an importance level assigned to 
them in the external e-mail program by the sender. You can configure 
Service Desk to automatically translate the importance level of an e-mail 
message into a priority code, and then assign that priority code to the 
relevant Service Desk object. You map e-mail importance levels to 
priority codes in the E-mail Priority Mapping dialog box.

To map e-mail importance levels to priority codes:

1. In the E-mail Properties dialog box, select the E-mail Priority 
Mapping tab. The available importance levels are listed.
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2. Select an importance level and click Edit. The E-mail Priority 
Mapping dialog box opens.

3. Select a Priority code from the drop-down list.

4. Select File→Save.

5. Click OK or Apply in the E-mail Priority Mapping tab page.
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Modify Outbound E-mail Templates

Service Desk uses e-mail templates to send automatic replies to Inbound 
E-mail commands. The templates contain standard text and possibly 
some variable fields (for example, the help text that is sent to a requestor 
who sends an e-mail to Service Desk with the Help command, or the 
confirmation message that is sent when a new service call is created). 
You can edit the text in these templates to match the needs of your 
organization.

To modify Outbound E-mail templates:

1. In the E-mail Properties dialog box, click the E-mail Templates tab.

The E-mail Templates dialog box opens.
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2. Select the command and template you want to modify, and click Edit. 

The E-mail Template dialog box opens.

3. Edit the information that forms the Subject line of the e-mail.

4. Edit the Body text. 

5. Click OK to save.
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Inbound E-mail Commands
This section explains how to use e-mail commands.

Sending Inbound E-mail Commands

• E-mail messages can be plain text or HTML-based.

• E-mail commands are not case-sensitive.

• Attachments are accepted. Inline attachments (for example, graphics 
inserted into the body of the message) are not accepted.

• If your e-mail program inserts footers, use the BEGIN and END tags 
to mark the message text.

Processing Inbound E-mail Commands

• After a command is received, Service Desk can send a confirmation 
message to notify the sender that the service call was created or that 
the creation failed. To send confirmation messages, make sure you 
select the Send Confirmation check box for the command in the 
E-mail Command dialog box.

• The confirmation message that is sent in response to a command is 
based on the template defined in the E-mail Template field in the 
E-mail Command dialog box. You can modify templates in the E-mail 
Templates dialog box.

• The message body of the confirmation message can include both fixed 
text and keywords. The keywords are replaced by service call specific 
information.
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New Command

When Service Desk receives the New command, it performs the following 
actions:

• A new service call is created using the default values in the service 
call template that is linked to the e-mail address in the To field.

• The following service call fields are filled in from the e-mail message:

Description The text in the subject line that follows the 
command New

Information The body of the e-mail

Priority The priority of the e-mail (mapped in the E-mail 
Settings dialog box)

Caller The person linked to the sender’s e-mail address

Attachments E-mail attachments

History Line Added when defined in E-mail Command dialog 
box

To use the New command:

1. Send the e-mail from the e-mail account that you want Service Desk 
to use as the caller. 

Service Desk uses the e-mail address in the From field to determine 
the Caller for the service call. If there is no person in the database 
linked to that e-mail address, or if it is linked to multiple persons, the 
service call is not created and a message stating the error is sent 
back to the requestor.
Chapter 4 141



E-mail
Inbound E-mail Commands
2. Enter an e-mail address for Service Desk in the To field. This 
determines the template that is used for the new service call.

For more information about linking Inbound E-mail addresses to 
templates, see “Add Inbound E-mail Addresses” on page 122.

3. Enter the New command in the Subject field of the e-mail message. 

4. Enter a description for the service call in the Subject field after the 
New command. This text is copied to the Description field of the 
service call.

5. Enter information about the service call in the e-mail body. This text 
is copied to the Information field of the service call. 

NOTE If the text is more than 4000 characters, it is truncated and the 
complete message body text is copied to an attachment. A comment 
is inserted in the Information field:

Warning: Text truncated, see attachment <file name> for 
complete e-mail text.

Some e-mail programs insert footer text or graphics automatically into 
e-mail messages when they are sent. The Inbound E-mail program does 
not recognize these elements, and rejects the e-mail message. To prevent 
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this problem, insert BEGIN at the start of your message text, and END at 
the end of your message. If you use only BEGIN, everything after that 
point is used. If you use only END, all text before that point is used.

Additional information can be sent as an attachment if that option is 
selected. You can select the attachment option for each command in the 
E-mail Command dialog box.
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Update <id> Command

The Update <id> command is used to update a service call. All service 
call fields can be updated.

The sender can assign a value to a service desk attribute in the e-mail 
body. The following table shows the string parsing rules for the Update 
command.

Table 4-3

Type Example 
Attribute String format Example 

Values

Boolean Frequently 
Asked Question

When “1”, “true”, “yes” or 
“on” then TRUE else 
FALSE

“1”, “0”, 
“true”, 
“FALSE”, 
“on”

Date 
Time

Actual Start A datetime string (this 
depends on the date and 
time format adjustments 
of the current account), 
“0”=>today, 
“+n”=>number of days 
after today, 
“-n”=>number of days 
before today, or a date in 
the format 
“yyyy.MM.dd.HH.mm.ss” 

The date is parsed as 
local time for the current 
account.

“0”, “+1”, 
“-2”, 
“11-11-2004 
14:20”, 
“2004.01.15.
14.20.59”, 
“NULL

Entity 
Reference

Status, 
Configuration 
Item

An existing object id or a 
unique value of the 
Search attribute of the 
related entity.

“00000000-0
000-0000-00
01-000129f0
01cf”, 
“2814783140
66123”, 
“Waiting”, 
“NULL”
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Figure 4-2 shows how you can use the Update command in an e-mail 
message.

Figure 4-2 Update <id> Command Message

Entity 
Set 
Reference

History Lines N/A N/A

Double, 
Float, 
Integer, 
Long, 
Currency

Actual Cost A valid number. The use 
of “.” or “,” depends on the 
number adjustments of 
the current account.

“2.5”, “2323”, 
“NULL”

Duration Actual 
Duration

Number of days. The use 
of “.” or “,” depends on the 
number adjustments of 
the current account.

String Solution String. Maximum length 
is checked.

a ‘unicode’ 
text, “NULL”

Table 4-3  (Continued)

Type Example 
Attribute String format Example 

Values
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To use the Update <id> command:

1. In the subject line of the inbound e-mail, enter the command followed 
by the service call ID.

Example: 

Update 1160

2. Enter the field you want to modify in the message body text, followed 
by a colon (:) or an equal sign (=), followed by the value. 

Use a new line for each field that you want to modify. The field 
names and values used must match those used in the service call 
form.
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Add History Line <id>

When Service Desk receives the Add History Line <id> command, it 
performs the following actions:

• Creates a new history line for the service call identified by the <id>.

• Copies the text that you entered in the Subject Historyline field in 
the E-mail Command dialog box to the Subject field of the new 
history line.

• Copies the text in the e-mail body to the Information field of the new 
history line.

If the text is more than 4000 characters, it is truncated, and the 
complete message body text is put in an attachment. The following 
message is inserted in the Information field:

Warning: Text truncated, see attachment <file name> for 
complete e-mail text. 

• Sets the status of the service call to the value that you defined for 
New Status in the E-mail Command dialog box. 

• Sends a confirmation e-mail to the requestor (if you selected the 
Send Confirmation check box in the E-mail Command dialog box).

To use the Add History Line <id> command

1. In the subject line of the inbound e-mail, enter the command followed 
by the service call ID.

Example:

Add History Line 1160

2. In the body of the inbound e-mail, enter the text to be copied to the 
new history line.
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View <id>

When Service Desk receives the View <id> command, an e-mail 
message containing the details of the service call, specified by the ID in 
the command, is sent to the requestor.

To use the View <id> command:

In the subject line of the inbound e-mail, enter the command followed by 
the service call ID.

Example:

View 1160
Chapter 4148



E-mail
Inbound E-mail Commands
List

When Service Desk receives the List command, an e-mail message is 
sent to the requestor containing a list of all open service calls assigned to 
the requestor and all open service calls announced by the requestor. Each 
service call’s ID and description are included in the e-mail message.

A service call is considered open when the Actual Finish date field is 
empty. 

To use the List command:

In the subject line of the inbound e-mail, enter List.
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RE:RFI <id>

The RE:RFI <id> is used to add additional information to the history 
line of a service call. When Service Desk receives the RE:RFI <id> 
command, it performs the following actions:

• Creates a new history line for the service call identified by the <id>.

• Copies the text that you entered in the Subject Historyline field in 
the E-mail Command dialog box to the Subject field of the new 
history line. 

• Copies the text in the e-mail body to the Information field of the new 
history line.

If the text is more than 4000 characters, it is truncated, and the 
complete message body text is put in an attachment. The following 
message is inserted in the Information field:

Warning: Text truncated, see attachment <file name> for 
complete e-mail text. 

• Sets the status of the service call to the value that you defined for 
New Status in the E-mail Command dialog box (for example, 
Additional Information Received).

• Sends a confirmation e-mail to the requestor (if you selected the 
Send Confirmation check box in the E-mail Command dialog box).

To use the RE:RFI <id> command:

1. In the subject line of the inbound e-mail, enter RE:RFI followed by 
the service call ID.

Example:

RE:RFI 1160

2. In the body of the inbound e-mail, enter the text to be copied to the 
new history line.
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RE:Solution Accepted <id>

When Service Desk receives the RE:Solution Accepted <id> 
command, it performs the following actions:

• Creates a new history line for the service call identified by the <id>.

• Copies the text that you entered in the Subject Historyline field in 
the E-mail Command dialog box to the Subject field of the new 
history line.

• Copies the text in the e-mail body to the Information field of the new 
history line.

If the text is more than 4000 characters, it is truncated, and the 
complete message body text is put in an attachment. The following 
message is inserted in the Information field:

Warning: Text truncated, see attachment <file name> for 
complete e-mail text. 

• Sets the status of the service call to the value that you defined for 
New Status in the E-mail Command dialog box (for example, 
Solution Accepted).

• Sends a confirmation e-mail to the requestor (if you selected the 
Send Confirmation check box in the E-mail Command dialog box).

To accept the solution to a service call:

1. In the subject line of the inbound e-mail, enter RE:Solution 
Accepted and the service call ID.

Example:

RE:Solution Accepted 1160

2. In the body of the inbound e-mail, enter the text to be copied into the 
new history line.
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RE:Solution Rejected <id>

When Service Desk receives the RE:Solution Rejected <id> 
command, it performs the following actions:

• Creates a new history line for the service call identified by the <id>.

• Copies the text that you entered in the Subject Historyline field in 
the E-mail Command dialog box to the Subject field of the new 
history line.

• Copies the text in the e-mail body to the Information field of the new 
history line.

If the text is more than 4000 characters, it is truncated, and the 
complete message body text is put in an attachment. The following 
message is inserted in the Information field:

Warning: Text truncated, see attachment <file name> for 
complete e-mail text. 

• Sets the status of the service call to the value that you entered in the 
New Status field in the E-mail Command dialog box (for example, 
Solution Rejected).

• Sends a confirmation e-mail the requestor (if you selected the Send 
Confirmation check box in the E-mail Command dialog box).

To reject the solution provided for a service call:

1. In the subject line of the inbound e-mail, enter RE:Solution 
Rejected and the service call ID.

Example:

RE:Solution Rejected 1160

2. In the body of the inbound e-mail, enter the text to be copied to the 
new history line.
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Recall <id>

When Service Desk receives the Recall <id> command, it performs the 
following actions:

• Creates a new history line for the service call identified by the <id>.

• Copies the text that you entered in the Subject Historyline field in 
the E-mail Command dialog box to the Subject field of the new 
history line.

• Copies the e-mail message body text to the Information field of the 
new history line.

If the text is more than 4000 characters, it is truncated, and the 
complete message body text is put in an attachment. The following 
message is inserted in the Information field:

Warning: Text truncated, see attachment <file name> for 
complete e-mail text. 

• Sets the status of the service call to the value that you defined for 
New Status in the E-mail Command dialog box (for example, 
Recalled).

• Sends a confirmation e-mail to the requestor (if you selected the 
Send Confirmation check box in the E-mail Command dialog box).

To use the Recall <id> command:

1. In the subject line of the inbound e-mail, enter Recall and the 
service call ID.

Example:

Recall 1160

2. In the body of the inbound e-mail, enter the text to be added to the 
new history line.
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Help

When Service Desk receives the Help command, it sends an e-mail 
message to the person in the From field. The message contains a list of 
the commands available for use with Inbound E-mail, and a short 
description of each command. You can edit the help text. 

To use the Help command:

In the subject line of the inbound e-mail, enter Help.
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Troubleshooting E-mail Problems
This section is provided to assist you in identifying and solving errors in 
your inbound or Outbound E-mail messaging. 

Start your troubleshooting process by making sure that:

• E-mail client is MIME compliant.

• Database, operating system, and Service Desk server all support the 
character set used. 

TIP Service Desk supports all character sets which are listed and 
implemented by Sun. If in doubt, use UTF-8. 

For more information about character sets, see the Sun web site:

http://java.sun.com/j2se/1.4/docs/guide/intl/encoding.doc.html

For more information about troubleshooting problems with your e-mail 
integration in Service Desk, see the following web sites:

http://www.faqs.org/rfcs/rfc1521.html

http://www.faqs.org/rfcs/rfc1522.html
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E-mail Debugging

You can add information to the application server log file about e-mail 
messaging errors by selecting the E-mail Debug check box in the E-mail 
Properties dialog box. 

For more information about e-mail properties, see “Define General 
E-mail Settings” on page 117.

Error Messages

When a command cannot be processed correctly, Service Desk generates 
an error message:

• Mail Error

E-mail command is not executed.

• Command Not Recognized

Command is partially executed. 

An Outbound E-mail message, containing the error message, is sent to 
the person who sent the e-mail command. 

You can modify the error messages in the E-mail Templates dialog box. 
For more information about Outbound E-mail templates, see “Modify 
Outbound E-mail Templates” on page 138.

Other errors may occur that are not directly related to the Service Desk 
e-mail program, or the commands used (for example, differences in the 
supported character set).

Error Handling

Table 4-4 lists the possible cause and solution of a variety of errors in 
your Inbound or Outbound E-mail messaging.

Table 4-4 E-mail Errors

Symptom Cause Solution

Objects created or modified by 
Inbound E-mail (for example, 
a new service call) are 
corrupted.

Database does not 
support the character 
set used.

Use a character set supported 
by Service Desk and your 
database. 
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E-mail sent by Service Desk 
appears garbled or malformed 
on the client machine.

Client machine does not 
support encoding.

Turn off the encoding option in 
the General Settings dialog 
box. Make sure the client 
platform is MIME- compliant 
and supports the character set 
used. For example, a Japanese 
character set may be readable 
if used on an English 
operating system.

Inbound E-mail results in 
malformed or truncated 
characters in Service Desk. 
Characters appear as “?”

Unsupported character 
set was used.

Use a supported character set. 
If using a character set other 
than US-ASCII, use the 
encoding option. 

Service call is not created. Caller could not be 
determined for new 
service call creation.

Verify the Caller is a person in 
Service Desk. Include an 
e-mail address. Check the 
Access Level set for the 
command.

Service call is not changed. No authorization for 
updating a service call. 
Includes the following 
commands:

• Update <id>

• RE:RFI <id>

• Recall <id>

• RE:Solution <id>

Change the authorizations for 
the person in Service Desk.

Nothing happens. No authorization for 
viewing service call 
data. Includes the 
following commands:

• Update <id>

• View <id>

Change the authorizations for 
the person in Service Desk.

Table 4-4 E-mail Errors (Continued)

Symptom Cause Solution
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Nothing happens. Command not 
recognized.

Use the correct command 
syntax.

Service Desk rejects the 
Inbound E-mail.

Message syntax not 
recognized because the 
e-mail program inserted 
additional text or 
graphics when the 
message was sent to 
Service Desk.

 The Inbound E-mail program 
does not recognize footers and 
graphic. The e-mail message is 
rejected. To prevent this 
problem, insert BEGIN at the 
start of the message text, and 
END at the end of the 
message. 

Table 4-4 E-mail Errors (Continued)

Symptom Cause Solution
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5 Command Line Utility

The HP OpenView console provides a utility that enables you to interact 
with the console from the command line. This is useful for integrating 
other programs or tools with the console.
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Using the command line utility, you can instruct the console to do the 
following things: 

• Open a form for an existing object

• Open a form for a new object

• Find an object

• Display a view

• Invoke an action

• Get the object type associated with a given form

• Get a list of all the objects of a given type that meet certain criteria

• Determine whether the console is or is not running

• Start the console

• Shutdown the console.

The program or script invoking the command line utility can pass 
parameters to the console to accomplish these tasks. In some cases, the 
utility returns a value.

The ovconsolecmd utility is only available from the command line when 
the HP OpenView console is installed locally. If you are running the 
console using Java WebStart, however, you can create a smart action to 
invoke the functions of ovconsolecmd.
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About ovconsolecmd
You can use the ovconsolecmd utility to send commands to the console 
either from the command line or from an external script or program. This 
is particularly useful if you want to integrate another application with 
your HP OpenView software.

The ovconsolecmd command has the following syntax:

ovconsolecmd [-Duser.home=<userHomeDir> | 
-port=<PortNumber>] [-launch] [command] [command args...]

where <userHomeDir> is the directory where the console stores and 
looks for configuration, log, and cache files for the pertinent console 
session. For additional information about this directory, see the online 
help topic titled “Multiple Console Sessions.”

NOTE The command line arguments are described in “ovconsolecmd” on 
page 177. 

You can use the ovconsolecmd utility to instruct the console to carry out 
the following functions from the command line:

• “Find Objects” on page 162

• “Open a Form” on page 163

• “Display a View” on page 164

• “Invoke an Action” on page 167

• “Get an Object Type for a Form” on page 168

• “Determine the Status of the Console” on page 169

• “Shut Down the Console” on page 171
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Find Objects
From the command line, you can instruct the console to find the object 
IDs for all or some of the objects of a particular object type in the HP 
OpenView database. To do this, use the following variation of the 
ovconsolecmd utility:

ovconsolecmd -find -itemName=<objectType> 
[-filter=”<filterName>”] 

NOTE For simplicity, the optional -file | -port and -launch arguments for 
ovconsolecmd are not shown in these examples. See “ovconsolecmd” on 
page 177 for descriptions of these arguments.

For example, if you want to find the object IDs for all the Workgroup 
objects in the database, type the following command:

ovconsolecmd -find -itemName=Workgroup

If you want to find the objectIDs for a subset of the Workgroup objects, 
you can use an existing named filter:

ovconsolecmd -itemName=Workgroup -filter=”My Filter”

In this case, only those Workgroup objects that meet the filter criteria 
specified in “My Filter” are returned.

The -filter argument is useful, for example, in the following scenarios: 

• You want to find all Workgroups that report to a certain manager.

• You want to find all critical Incidents that are currently open.

• You want to find all the Service Calls that have originated from a 
particular telephone number.

NOTE Before you can use the -filter argument, you must create a named 
filter in the console using Data→Named Filters feature in the HP 
OpenView Configuration workspace. See the online help topic titled 
“Named Filters” for more information.
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Open a Form
From the command line, you can instruct the console to open a specific 
form for one or more objects. To do this, use the following variation of the 
ovconsolecmd utility:

ovconsolecmd -showForm -itemName=item -objectIds="id id id 
..." [-formName="form name"]

NOTE For simplicity, the optional -file | -port and -launch arguments for 
ovconsolecmd are not shown in these examples. See “ovconsolecmd” on 
page 177 for descriptions of these arguments.

For example, you can use the -find command to determine the object 
IDs for all the Workgroup objects in your HP OpenView database:

ovconsolecmd -find -itemName=Workgroup

Then, you can use the -showForm command to open the default form for 
each Workgroup object:

ovconsolecmd -showForm -itemName=Workgroup 
-objectIds=“00000000-0000-0000-0219-9d1e0d7dd815 
00000000-0000-0000-0219-9d1e0d7dd816”

The object IDs must be concatenated and separated by spaces. In this 
example, there are two objects of type Workgroup in the database. If you 
want to open a form called “MyForm” instead of the default form, you can 
use the following variation:

ovconsolecmd -showForm -itemName=Workgroup 
-objectIds=“00000000-0000-0000-0219-9d1e0d7dd815 
00000000-0000-0000-0219-9d1e0d7dd816”-formName=“MyForm”

TIP The -showForm option works only for existing objects. To create a new 
object and open a form for it, use -showNewForm.
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Display a View
From the command line, you can instruct the console to display a specific 
view associated with a particular object type. To do this, use the 
following variation of the ovconsolecmd utility:

ovconsolecmd -showView -itemName=item 
[-viewName=”view name”] [-objectIds=”id id id...”] 
[-filter=”filter name”] 

NOTE For simplicity, the optional -file | -port and -launch arguments for 
ovconsolecmd are not shown in these examples. See “ovconsolecmd” on 
page 177 for descriptions of these arguments.

For example, if you want to display the default view for the Workgroup 
object type, type the following command:

ovconsolecmd -showView -itemName=Workgroup

If you want to display a specific view called “My View” instead of the 
default view, use this command:

ovconsolecmd -showView -itemName=Workgroup -viewName=”My 
View”

If you know the object IDs of the objects you want to display in the view 
(from the -find command, for example), you can restrict your view to the 
objects that you specify. The object IDs must be concatenated and 
separated by spaces, as shown here. 

ovconsolecmd -showView -itemName=Workgroup 
-objectIds=“00000000-0000-0000-0219-9d1e0d7dd815 
00000000-0000-0000-0219-9d1e0d7dd816”

NOTE The -objectIds option is not available in Service Desk 5.0.
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You can also apply a filter to a view. If a filter named “My Filter” exists in 
the console, for example, you can use the following command to open the 
default view for the Workgroup object type and display only those objects 
that meet the filter criteria:

ovconsolecmd -showView -itemName=Workgroup -filter=”My 
Filter”

The -filter argument is useful, for example, in the following scenarios: 

• You want to display a view showing all Workgroups that report to a 
certain manager.

• You want to display a table of critical Incidents that are currently 
open.

• You want to display a list of Service Calls that have all originated 
from the same telephone number.

NOTE Before you can use the -filter argument, you must create a named 
filter in the console using the Advanced Find dialog.
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Initiate a Search
From the command line, you can initiate a search using the Advanced 
Find dialog. To do this, use the following variation of the ovconsolecmd 
utility:

ovconsolecmd -advancedFind -itemName=<objectType> 
[-filter="<filterName>"]

NOTE For simplicity, the optional -file | -port and -launch arguments for 
ovconsolecmd are not shown in these examples. See “ovconsolecmd” on 
page 177 for descriptions of these arguments.

For example, you can open an empty Advanced Find window for the 
Person object type using the following command:

ovconsolecmd -advancedFind -itemName=Person

You can also open the Advanced Find window and load a named filter:

ovconsolecmd -advancedFind -itemName=Person -filter=”My 
Filter”

If you specify a filter, that filter must exist in the console. The search 
criteria that the filter uses are loaded into the Advanced Find dialog, but 
they are not applied until you click the Add Criteria button and then the 
Search button.

NOTE The -filter option is not available in Service Desk 5.0.
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Invoke an Action
From the command line, you can invoke an action for one or more objects. 
To do this, use the following variation of the ovconsolecmd utility:

ovconsolecmd -invokeAction -itemName=item -objectIds=”id id 
id...” -actionName=”action name”

NOTE For simplicity, the optional -file | -port and -launch arguments for 
ovconsolecmd are not shown in these examples. See “ovconsolecmd” on 
page 177 for descriptions of these arguments.
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Get an Object Type for a Form
If you know the name of a form, but you don’t know the name of the 
object type associated with that form, you can get the object type name 
using the ovconsolecmd utility. To do this, use the following variation:

ovconsolecmd -getItemForForm -formName="<formName>" 

The -getItemForForm option only works for forms that are stored in the 
HP OpenView database; these objects are visible in the 
Presentation→Forms list in the HP OpenView Configuration workspace.

NOTE For simplicity, the optional -file | -port and -launch arguments for 
ovconsolecmd are not shown in these examples. See “ovconsolecmd” on 
page 177 for descriptions of these arguments.

The name of the object type is written to stdout. If <formName> contains 
spaces, it must be enclosed in quotes. For example, if a form called “My 
Form” for the Incident object type exists in the console, and you typed the 
following command:

ovconsolecmd -getItemForForm -formName="My Form"

The ovconsolecmd utility writes the following to stdout:

Incident
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Determine the Status of the Console
From the command line, you can determine whether the console is 
running. To do this, use the following variation of the ovconsolecmd 
utility:

ovconsolecmd -isRunning

NOTE For simplicity, the optional -file | -port and -launch arguments for 
ovconsolecmd are not shown in these examples. See “ovconsolecmd” on 
page 177 for descriptions of these arguments.

If the console is running, the following message appears in stdout:

OVConsole is running

If the console is not running, the following message appears in stdout:

OVConsole is not running
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Start the Console
From the command line, you can start the console. To do this, use the 
following variation of the ovconsolecmd utility:

ovconsolecmd -launch

NOTE For simplicity, the optional -file | -port arguments for ovconsolecmd 
are not shown in these examples. See “ovconsolecmd” on page 177 for 
descriptions of these arguments.

If the console is not running, this command starts it. If the console is 
already running, the command has no effect.
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Shut Down the Console
From the command line, you can shut the console down. To do this, use 
the following variation of the ovconsolecmd utility:

ovconsolecmd -shutdown

NOTE For simplicity, the optional -file | -port and -launch arguments for 
ovconsolecmd are not shown in these examples. See “ovconsolecmd” on 
page 177 for descriptions of these arguments.

If the console is running, this command shuts it down. If the console is 
not running, the following message appears in stdout:

OVConsole is not running
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Invoke ovconsolecmd from a Smart Action
You can issue ovconsolecmd commands from the console by using smart 
actions. For example, you can create a smart action that automatically 
opens a specific form or view when certain conditions occur in the HP 
OpenView database. This type of action works the same way whether 
you are running the console locally or accessing it remotely using Java 
WebStart. 

To invoke ovconsolecmd using a smart action, you must first create an 
application that starts ovconsolecmd and then create a smart action 
that calls that application. This smart action can then be invoked 
directly by a console user—provided that the user’s role grants the 
necessary access privileges—or it can be invoked by a rule.

To set up ovconsolecmd using a smart action:

1. In the HP OpenView Configuration workspace, click Actions & 
Rules→Applications.

2. Create a new application called ovconsolecmd, as shown here:
Chapter 5172



Command Line Utility
Invoke ovconsolecmd from a Smart Action
a. In the Name box, type a name of your choice for the application.

b. In the Command line box, type ovconsolecmd

c. In the Start in box, type anything. The Start in field is required to 
have a value, but that value is not used in this instance.

d. In the Description box, type any notes that you want to record 
for yourself or other console administrators.

3. In the Application dialog, click File→Save and Close.

4. Also in the HP OpenView Configuration workspace, click Actions & 
Rules→Actions→Smart Actions.
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5. Create a new smart action that calls the ovconsolecmd application 
you created in step 2, as shown here:

a. In the Smart Actions tree, double-click the object type that you 
want to associate this action with.

b. Right-click anywhere in the right pane, and click New.

c. In the Smart Action dialog, fill in the following fields:

• In the Text box, type a name for your smart action.
Chapter 5174



Command Line Utility
Invoke ovconsolecmd from a Smart Action
• In the Application box, click the  (quick find) button to 
search for the application you created in step 2. Select that 
application, and click Choose.

• In the Parameters box, type the ovconsolecmd parameters 
that you want to use. See “ovconsolecmd” on page 177 for a 
complete list.

To insert an attribute, position the cursor in the proper 
location in the Parameters text, and click Attribute. Select 
the attribute that you want to use, and click OK.

• Optional: Click the  (filter) button if you want to apply a 
filter to this action. Either select an existing filter, or create a 
new one.

• Optional: Type any pertinent notes in the Comment box.

6. In the Smart Action dialog, click File→Save and Close.
Chapter 5 175



Command Line Utility
Console Port Number for Command Line Access
Console Port Number for Command Line 
Access
The port number for the console is 35000 by default. The console port 
number is stored in a file called cliPort.dat. This file is located in the 
following directory:

When you run ovconsolecmd from the command line, you can specify the 
console port using the -port=<portNumber> argument. When you 
invoke ovconsolecmd using a smart action, this argument is 
automatically set to the correct port for the console. 

If multiple console sessions are started on the same machine 
concurrently, the most recent session increments the port number by one 
and the new port number in cliPort.dat. If this happens, 
ovconsolecmd will fail to connect if invoked from the command line if 
the old port number—or no port number—is specified. If ovconsolecmd 
is invoked from a smart action within the console, however, it will still 
work. This point is important only if ovconsolecmd is invoked from the 
command line.

HP-UX, 
Solaris, 
Linux

<userhome>/.ov/data/guifw

Windows Local Console:
C:\Documents and Settings\<user>\Application 
Data\HP OpenView\data\guifw

Java WebStart Console:
C:\Documents and Settings\<user>\Application 
Data\HP OpenView\webstart\<host>\Application 
Data\HP OpenView\data\guifw
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ovconsolecmd

NAME
ovconsolecmd – provides a utility that enables you to interact with the HP OpenView 
console from the command line

SYNOPSIS
ovconsolecmd  [-Duser.home=<userHomeDir> | 
-port=<portNumber>] -isRunning 

ovconsolecmd  [-Duser.home=<userHomeDir> | 
-port=<portNumber>] -shutdown 

ovconsolecmd  [-Duser.home=<userHomeDir> | 
-port=<portNumber>] [-launch] -find 
-itemName=<objectType> 

ovconsolecmd  [-Duser.home=<userHomeDir> | 
-port=<portNumber>] [-launch] -showView 
-itemName=<objectType> [-viewName=”<viewName>”] 
[-objectIds=”<id1> <id2> <id3>...”] 

ovconsolecmd  [-Duser.home=<userHomeDir> | 
-port=<portNumber>] [-launch] -showForm 
-itemName=<objectType> -objectIds=”<id1> <id2> <id3>...” 
[-formName=”<formName>”] 

ovconsolecmd  [-Duser.home=<userHomeDir> | 
-port=<portNumber>] [-launch] -showNewForm 
-itemName=<objectType> -objectIds=”<id1> <id2> <id3>...” 
[-formName=”<formName>”] [-template=”<templateName>”] 
[-initialValues=”<attribute1>=<value1> 
<attribute2>=<value2> <attribute3>=value3>...”] 

ovconsolecmd  [-Duser.home=<userHomeDir> | 
-port=<portNumber>] [-launch] -invokeAction 
-itemName=<objectType> -objectIds=”<id1> <id2> <id3>...” 
-actionName=”<action name>” 
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DESCRIPTION
The ovconsolecmd utility enables you to send commands to the HP 
OpenView console from the command line. This is useful for integrating 
other programs or tools with the console. 

Using the ovconsolecmd, you can instruct the console to do the following 
things: 

• Open a form for an existing object

• Open a form for a new object

• Find an object

• Display a view

• Invoke an action

• Get the object type associated with a given form

• Get a list of all the objects of a given type that meet certain criteria

• Determine whether the console is or is not running

• Shutdown the console

The program or script invoking ovconsolecmd can pass parameters to 
the console to accomplish these tasks. In some cases, ovconsolecmd 
returns a value.

The -Duser.home, -port, and -launch arguments are common to all 
ovconsolecmd commands, and they are optional. Before the 
ovconsolecmd can communicate with the console, it must create a 
connection to the console using a particular port. You can use either the 
-Duser.home argument or the -port argument to specify the port 
number. You can use the -launch argument to start the console if it is 
not yet running.

The ovconsolecmd utility is only available from the command line when 
the HP OpenView console is installed locally. If you are running the 
console using Java WebStart, you can create a smart action to invoke the 
functions of ovconsolecmd.

Parameters
ovconsolecmd recognizes the following options:

-help
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Displays all available options for the ovconsolecmd 
command.

-Duser.home=<userHomeDir> | -port=<portNumber>

You can specify either the -Duser.home option or the 
-port option, but not both.

The userHomeDir option specifies the directory where 
the console stores and looks for configuration, log, and 
cache files for the pertinent console session. This 
directory contains the cliPort.dat file, which 
contains the port number that ovconsolecmd will use 
to connect to the console.

The -port option directly specifies the port number 
that ovconsolecmd will use to connect to the console. 
The portNumber must be an integer.

If neither option is specified, ovconsolecmd attempts to 
establish a connection to the console by iteratively 
testing ports. It begins with port 35000 and increments 
the port until either a connection can be made or it 
runs out of possible ports.

If both the -file and -port options are specified, 
ovconsolecmd returns an error and does not establish 
a connection to the console.

See the online help topic titled “Multiple Console 
Sessions” for additional information about the locations 
of configuration and data files.

-launch

If the console is not running, and -launch is specified, 
a new console session is initiated. If the console is 
already running, -launch has no effect. 

If the console is not running, and -launch is not 
specified, ovconsolecmd reports that the console is not 
running and does not attempt to launch a new console 
session.

-isRunning

If the console is running, the following message 
appears in stdout:
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OVConsole is running

If the console is not running, the following message 
appears in stdout:

OVConsole is not running

-shutdown

If the console is running, this command shuts it down. 
If the console is not running, the following message 
appears in stdout:

OVConsole is not running

-find -itemName=<objectType> [-filter=”<filterName>”]

The -find option returns the object IDs for all objects 
of type <objectType>. You can specify an optional 
named filter if you like. If you specify a named filter, 
the object IDs for those objects of type <objectType> 
that satisfy the filter criteria are returned.

-showView -itemName=<objectType> [-viewName=”<viewName>”] 
[-objectIds=”<id1> <id2> <id3>...”] [-filter=”<filterName>”]

The -showView option displays a view for objects of 
type <objectType>. This view is opened in a new, 
standalone window. If you specify the -viewName 
argument, the console displays the specific view that 
you name; if you do not specify a view name, the 
console displays the default view for the specified 
<objectType>. By using the -objectIds argument, 
you can specify which objects appear in the view. 

NOTE The -objectIds option is not available in Service Desk 
5.0.

You can also specify a named filter if you like. If you 
specify a named filter, only those objects of type 
<objectType> that satisfy the filter criteria are 
displayed in the view. If you specify both the 
-objectIds argument and the -filter argument, 
only those objects in your list of object IDs that satisfy 
the filter criteria will be displayed.
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-showForm -itemName=<objectType> -objectIds=”<id1> <id2> 
<id3>...” [-formName=”<formName>”]

The -showForm option opens a form for one or more 
existing objects of type <objectType>. This option 
only works for forms that are stored in the HP 
OpenView database; these objects are visible in the 
Presentation→Forms list in the HP OpenView 
Configuration workspace. 

The object IDs of the individual objects must be 
concatenated and separated by spaces in the 
objectIds argument. You can find object IDs for 
objects of a given type using the -find command.

The optional -formName argument specifies a 
particular form in the console. If -formName is not 
specified, the default form for the object type is used.

NOTE The -showForm option works only for existing objects. 
To create a new object and open a form for it, use 
-showNewForm.

-showNewForm -itemName=<objectType> -objectIds=”<id1> <id2> 
<id3>...” [-formName=”<formName>”] 
[-template=”<templateName>”] 
[-initialValues=”<attribute1>=<value1> 
<attribute2>=<value2> <attribute3>=value3>...”]

The -showNewForm option opens a form for a new object 
of type <objectType>. The optional -formName 
argument specifies a particular form associated with 
this object type. If -formName is not specified, the 
default form for the object type is used.

The optional -template argument specifies the 
template that should be used to fill in one or more 
attribute values when the object is created. The 
-initialValues argument (also optional) allows you 
to specify values for individual attributes. 
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NOTE If you specify both a template and initial values, the 
initial values supersede the attribute values supplied 
by the template.

-invokeAction -itemName=<objectType> -objectIds=”<id1> 
<id2> <id3>...” -actionName=”<action name>”

The -invokeAction option invokes an action for the 
objects of type <objectType> that are included in the 
-objectIds list. The object IDs in the list must be 
concatenated and separated by spaces. 

The -actionName argument must match an action that 
is already defined in the console.

-getItemForForm -formName=”<formName>”

The -getItemForForm option returns the name of the 
object type that is associated with the form specified in 
the -formName argument.

-advancedFind -itemName=<objectType> [-filter=”<filterName>”]

The -advancedFind option opens the Advanced Find 
dialog for objects of type <objectType>. If you specify 
a named filter, the filter criteria are displayed in the 
Advanced Find dialog.

NOTE The -filter option is not available in Service Desk 
5.0.

AUTHOR
ovconsolecmd was developed by Hewlett-Packard Company.

EXIT STATUS
ovconsolecmd does not return an exit status value.
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EXAMPLES
The following examples show how to use the ovconsolecmd command 
and some of its options to access information in the HP OpenView 
database and manipulate the console from the command line. These 
examples assume that the console is installed locally.

• Find the object IDs for all the Workgroup objects in the database:

ovconsolecmd -find -itemName=Workgroup

• First, use the -find option to determine the object IDs for all the 
Workgroup objects in your HP OpenView database:

ovconsolecmd -find -itemName=Workgroup

Then, use the -showForm option to open the default form for each 
Workgroup object:

ovconsolecmd -showForm -itemName=Workgroup 
-objectIds=“00000000-0000-0000-0219-9d1e0d7dd815 
00000000-0000-0000-0219-9d1e0d7dd816”

The object IDs must be concatenated and separated by spaces. In this 
example, there are two objects of type Workgroup in the database. If 
you want to open a form called “MyForm” instead of the default form, 
you can use the following variation:

ovconsolecmd -showForm -itemName=Workgroup 
-objectIds=“00000000-0000-0000-0219-9d1e0d7dd815 
00000000-0000-0000-0219-9d1e0d7dd816”-formName=“MyForm”

• To display the default view for the Workgroup object type, type the 
following command:

ovconsolecmd -showView -itemName=Workgroup

To display a specific view called “My View” instead of the default 
view, use this command:

ovconsolecmd -showView -itemName=Workgroup -viewName=”My 
View”

If you know the object IDs of the objects you want to display in the 
view (from the -find command, for example), you can restrict your 
view to the objects that you specify. The object IDs must be 
concatenated and separated by spaces, as shown here. 
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ovconsolecmd
ovconsolecmd -showView -itemName=Workgroup 
-objectIds=“00000000-0000-0000-0219-9d1e0d7dd815 
00000000-0000-0000-0219-9d1e0d7dd816”

• To open an Advanced Find window for the Person object type, use the 
following command:

ovconsolecmd -advancedFind -itemName=Person

• If a form called “My Form” for the Incident object type exists in the 
console, and you typed the following command:

ovconsolecmd -getItemForForm -formName="My Form"

The ovconsolecmd utility writes the following to stdout:

Incident
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6 Reporting

This chapter describes the reporting capabilities of Service Desk, and 
how you can create database views and a data dictionary for use with 
your third-party reporting tool. Using this information, you can create a 
variety of reports based on the data in your Service Desk database.
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Reports allow users to assess the status of both the IT infrastructure and 
of services. A report can show the current status and also whether the 
status is improving or deteriorating.

A report may comprise a simple printout of a service call, to be used as a 
handy reference. Value can be added to the report by including 
information from a number of objects. This can give the reader a more 
complete overview of the situation.

To produce a report that provides a customized overview of information 
suitable for analysis, it may be necessary to use a third-party reporting 
tool.

Service Desk 5.0 supplies four main reporting capabilities: 

• Console

You can define table, chart, card, and explorer views to create online 
printable overviews of data.

• Database

The Service Desk database contains reporting views that you can use 
with a third-party reporting tool to create reports. 

• Analyzed Data

Analyzed Data reports allow you to track changes to selected Service 
Desk objects. 

• OVPI Report Packs

OVPI reports provide detailed information about the Helpdesk 
Manager and Change Manager entities. For more information, see 
Chapter 7, “OVPI Reports Administration,” on page 211.

• SLM Reporting

For more information about Service Level Manager Reporting, see 
the HP OpenView Service Desk: Service Level Manager Guide.
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Console Reports
You can use the views in the Presentation workspace as reports. Card, 
chart, table, and explorer views are powerful overviews of objects. Views 
group objects and display the absolute or relative size of the groups in a 
variety of ways. There are a number of different styles of views that you 
can use to present your information. For example, some charts can be 
viewed in 3D. A view is an easy-to-read, on-screen report that is 
printable.

Views also provide easy access to objects in the groups. You access objects 
by clicking on a portion of the view. A table appears, containing the 
objects related to that portion. You can then select an object for more 
detailed information.

The size of the group can mean different things, such as:

• Number of objects in the group

• Total of a summation of field values

• Average value of a field in the group

• Minimum or maximum value of a field in the group

Views can be customized to change the appearance of the report. 

To print a view as a report:

• Select File→Print from the main console toolbar.
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Database Reports
Database reports are based on the reporting views that you can generate 
from Service Desk. 

Service Desk provides a utility to produce reporting views and a data 
dictionary to facilitate the production of reports using third-party 
reporting tools. All data relating to a single object is contained in one 
view, for optimal performance. 

The Service Desk reporting views are defined by queries that collect 
information from the database tables and present it in a readable report 
format. (The tables supplied by Service Desk are optimized for 
operational use and are difficult to read from outside Service Desk.)

To improve performance, you can select from the reporting views into a 
reporting database. You can then produce reports from the reporting 
database without impacting the operational database.

Figure 6-1 Reporting Process
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Reporting Tools

Examples of reporting tools are BusinessObjects, Crystal Reports, 
Microsoft Access, and Microsoft Excel.

Third-party reporting tools supply the functionality to create more 
detailed reports than is possible using the Service Desk user console. 
Your external tool can produce reports that a user can edit and format, 
combining content such as text, charts, pictures and sound. Because such 
tools use a visual layout approach, you can use drag and drop techniques 
to arrange data, graphics, charts and text. For example, you can use a 
reporting tool to integrate Service Desk information into presentations 
and reports for your customers, where high quality layout is required.

For more information, refer to your reporting tool vendor’s 
documentation.
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Generate Reporting Views

The first step in the reporting process is the generation of the database 
reporting views.

Reporting views expose all the data in the database, so the user is not 
limited when designing reports. The views make it easier for the user to 
access the data, rather than having to query the operational tables. 
(Directly querying operational tables for reporting is not supported in 
Service Desk 5.0.)

Database views can be localized based on the language of your 
third-party reporting tool.

NOTE Modifications such as localization or the addition of custom fields do not 
appear in the reporting views until the views are regenerated.

To generate reporting views:

1. In the HP OpenView Configuration workspace group, select the 
System Settings workspace.

2. Double-click the Report Settings icon.
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3. The Report Settings dialog box opens.

4. Click the (Re)generate Database Views for Reporting button. The 
(Re)generate Database Views for Reporting dialog box opens.
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5. Select a time zone from the drop-down list.

6. Select the check boxes to customize your reporting view names. 

NOTE When you select a check box to customize your view names, a new set 
of views is generated using the customized name format. The 
original views with standard-format names are not deleted. For 
example, if you select each check box in turn and regenerate after 
each selection, the result is that you have four identical sets of views, 
each using a different name format, in your database.

7. Click OK. A warning dialog box appears.

8. Click OK to continue generating database views.

Service Desk generates the database views. 

9. Click OK or Cancel to close the Report Settings dialog box.
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Access Reporting Views

After you have generated the database views, you can access the 
database to examine the structure of the views. Consult your database 
administrator for the user name and password to access the database. 

When viewing the database objects, note that all views have the prefix 
V_.

NOTE In addition to operational data, repository data such as account 
information is displayed in the database views. Although you cannot 
modify data using the database views, you can view all repository 
information in the reporting tables. 
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Generate a Data Dictionary

The data dictionary is a collection of descriptions of the operational 
tables in the Service Desk database. Each database table is listed with a 
descriptive name, its relationships to other tables, and its columns. Each 
column is listed with its data type, possible predefined values, and a brief 
textual description. The data dictionary can be organized into a book for 
reference.

To generate a data dictionary:

1. In the HP OpenView Configuration workspace group, select the 
System Settings workspace.

2. Double-click the Report Settings icon. 

The Report Settings dialog box opens.

3. Click the Generate Data Dictionary button. 

The print preview of the data dictionary appears.
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4. Print the data dictionary by selecting Print from the toolbar, or 
publish the data dictionary in HTML format by selecting Publish 
from the toolbar.

5. Click Close in the data dictionary print preview.

6. Click OK or Cancel to close the Report Settings dialog box.
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Copy Reporting Views to Tables

Copying the contents of multiple views to a table can resolve the 
performance problems you may experience with complex reports. The 
poor performance of joined reporting views is not related to the 
information in the reports, but to the reporting views themselves. Each 
reporting view is defined by a query that retrieves data from the 
operational source tables. Resolving one query is usually quick, but when 
two views are joined, the resolution time increases exponentially. By 
copying the contents of the views to a table, you consolidate the 
information, and reports based on that table perform more efficiently.

Advantages:

• Moderately complex, depending on the use of subreports and the 
target location of the copied table.

• Good performance, even with complex reports. In general, a report 
takes less time to collect information from a single table than from 
multiple reporting views.

• Minimal influence on operational use of Service Desk.

• You can use standardized names for your target tables. This can be 
useful when exchanging reports between different Service Desk 
implementations.

• The reporting views reside in the operational database. By copying 
the information in the reporting views to another database, you can 
create an extra layer of security.

Disadvantages:

• The copy task may need to be scheduled. This affects how up-to-date 
the report information is.

• The copy task may require coordination between report user and 
database administrator.

To prevent interference with the operational use of Service Desk, it may 
be necessary to copy the contents of the reporting views at a time when 
there is minimal use of Service Desk. For example, the copying action 
may be scheduled to perform every night at midnight, and this may 
result in the report information not being completely up-to-date. 
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How you copy information depends on your database and your target 
location. For more information about how to copy reporting view 
information to a table, refer to your database vendor’s documentation.
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Data Warehousing

The use of data warehousing tools considerably extends the possibilities 
for reporting. Data warehousing means you copy information from an 
operational database to a reporting database. The reporting database is 
designed specifically for your organization’s reporting needs. When 
copying the information, you transform it, in order to optimize it for 
reporting. Data warehouses optimize the data for retrieval flexibility, 
standard reporting tasks, and performance of reports.

Advantages:

• Data warehousing is the best way to customize reporting information 
for your organization. The steps required for data warehousing 
include the transformation of data to meet your organization’s 
reporting requirements.

• Data warehouses allow flexible creation of reports.

• Ultimately simplifies use of the reporting tool, but may require extra 
training.

• Good performance of reports. The data is optimized for reporting, so 
most reports perform efficiently, regardless of the size of the data 
warehousing database.

• No impact on the performance of Service Desk, because the 
information is copied away from the operational database.

Disadvantages:

• Implementation can be complex. Creation of a good data warehouse 
depends on prior definition of the required reports.

• Requires data warehouse tools.
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Analyzed Data Reports
Service Desk provides a number of configurable reports that provide 
information about changes to selected Service Desk objects (for example, 
the assignment of a service call from one person or workgroup to another, 
or the average time between the registration and the closure of service 
calls). These reports can be viewed in the console, printed, or published 
in HTML format.

The data that is included in Analyzed Data reports can be gathered in 
two ways:

• From the history lines of objects (when you refresh the data in batch 
mode)

• By evaluating changes as they occur in the database (when you 
refresh the data in on-save mode)

The data is stored in a database table, and the reports are based on this 
table. 

To set up analyzed data reporting, perform the following tasks:

• Enable auditing. 

For instructions, see “Enable Auditing” on page 200.

• Select the object types that you wish to analyze and include in the 
report set.

For instructions, see “Select Object Types for Analysis” on page 201.

• Block any report types that you do not require.

For instructions, see “Block Analyzed Data Reports” on page 203.

• Generate the analyzed data in batch mode if the data has never been 
generated, or if you wish to limit the data to a specific time period.

For instructions, see “Refresh Analyzed Data in Batch Mode” on 
page 204.

• Select the option to refresh the analyzed data in on-save mode if you 
wish to update the analyzed data continuously in the future.

For instructions, see “Refresh Analyzed Data in On-Save Mode” on 
page 207.
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Enable Auditing

In the Audit Rules dialog box, you can switch on auditing for specific 
object types. You can also choose to audit only selected attributes for each 
object type.

To enable auditing:

1. In the Users & Security workspace, select Audit→Audit Rules.

2. In the right-hand pane, double-click the object type you want to 
include in analyzed data reports (for example, Service Call). The 
Audit Rules dialog box opens.

3. Select the option to Audit these Attributes.

4. Select the check box next to each attribute that you want to audit (for 
example, Status, Assignment: To Person or Workgroup).

5. Click OK.
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Select Object Types for Analysis

Analyzed Data reports can be produced for service calls, problems, 
changes, incidents, work orders, and projects. 

To select object types for analysis:

1. In the HP OpenView Configuration workspace group, select the 
System Settings workspace.

2. In the right-hand pane, double-click the Report Settings icon. The 
Report Settings dialog box opens.

3. Select the Enable ‘Generate Analyzed Data’ for items tab.

4. Select the check box for each object type that you wish to analyze and 
include in the set of analyzed data reports.

5. Select a status from the Status Solved drop-down list next to each 
selected object type. This setting is used in the Solution Time report.

6. Select a status from the Status Accepted drop-down list next to each 
selected object type. This setting is used in the Pick-up Time report. 

Table 6-1 shows the types of Analyzed Data reports that are 
available in Service Desk.

Table 6-1 Analyzed Data Report Types

Report Type Description

Passed on by The assignment of objects from one person or 
workgroup to another.

Solved by Details of who resolved objects, and when they 
were resolved.

Pick-up time The number of hours and minutes between the 
time objects were registered and the time the 
object status was set to Status Accepted (as 
defined in the Report Settings dialog box).

Solution time The number of hours and minutes between the 
time objects were registered and the time the 
object status was set to Status Solved (as defined 
in the Report Settings dialog box).
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NOTE Changes to the report settings are not reflected in the analyzed data 
reports until you regenerate the analyzed data. After you change the 
settings, refresh the data using batch-mode processing. 

Total work time The number of hours and minutes between initial 
and final status.

Assignment 
time

The number of hours and minutes taken to assign 
objects from one person or workgroup to another.

Status time The number of hours and minutes taken for 
objects to progress from one status to another.

Table 6-1 Analyzed Data Report Types (Continued)

Report Type Description
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Block Analyzed Data Reports

In the Report Settings dialog box, you can switch off those Analyzed Data 
reports that you do not need.

To block Analyzed Data reports:

1. In the HP OpenView Configuration workspace group, select the 
System Settings workspace.

2. In the right-hand pane, double-click the Report Settings icon. 

The Report Settings dialog box opens. The General tab displays a list 
of report types.

3. Double-click the report type name, or select the report type and click 
the Edit button. 

The Report Types dialog box opens.

4. Select the Blocked check box to exclude a report type from the 
analyzed data report set. 

5. Click OK.
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Refresh Analyzed Data in Batch Mode

Batch mode allows you to refresh the analyzed data at a scheduled time.

In batch mode, the analyzed data is derived solely from the history lines 
of objects. First, all existing analyzed data is deleted from the analyzed 
data table. Then the history lines of the selected objects are evaluated in 
order to re-populate the table.

You can use batch-mode processing to generate the data when, for 
example, you generate the data for the first time, or when the updating 
of the reporting database fails. 

Information that is evaluated and stored using batch mode is guaranteed 
to be accurate only at the time of the update.

The disadvantage of using batch mode is that many objects are evaluated 
at one time, causing the performance of the operational database to 
deteriorate during that period.

You can refresh data in batch mode in two ways:

• From the console

• From the command line

To refresh analyzed data in batch mode from the console:

1. In the HP OpenView Configuration workspace group, select the 
System Settings workspace.

2. Double-click the Report Settings icon. 

The Report Settings dialog box opens.
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3. In the General tab page, click the Refresh Analyzed Data button. 
The Refresh Analyzed Data dialog box opens.

4. Select All Data to analyze all data in the Service Desk database, or 
select Modified/Inserted After and a date to limit the regeneration to 
more recent data.

To refresh analyzed data in batch mode from the command line:

Refresh the data in batch mode using a .bat/.sh file. 

Usage:

OvSdRefreshAnalyzedData [options]

Options:
Chapter 6 205



Reporting
Analyzed Data Reports
/help displays this help information

/allitems refreshes all objects (not only new or modified objects)

When this file is executed without any options, it refreshes all objects 
that were created or modified since the last batch.
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Refresh Analyzed Data in On-Save Mode

In on-save mode, the reporting rule evaluates objects at the moment 
when they are saved to the database. The analyzed data table is updated 
with information about changes when they happen, so there is no need to 
refer to the history lines of objects.

Information that is evaluated and stored using on-save mode has a 
greater accuracy than that saved in batch mode, because the data is 
updated continually.

When you use on-save mode to refresh your analyzed data, the action of 
saving a change takes slightly longer, but any degradation of 
performance is spread over normal operational time.

To refresh analyzed data in on-save mode:

1. In the HP OpenView Configuration workspace group, select the 
System Settings workspace.

2. Double-click the Report Settings icon. The Report Settings dialog 
box opens.
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3. Select the General tab.

4. Select the Enable on save refresh of Analyzed Data check box.

5. Click OK.
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Access Analyzed Data Reports

Service Desk provides a wizard to allow you to access your Analyzed 
Data reports using the program of your choice.

To access an analyzed data report:

1. Select the Analyzed Data workspace. The right-hand pane shows a 
list of analyzed data reports.

2. Double-click the report that you wish to view, or highlight the report 
and then select File→Export from the toolbar. The Export Wizard 
appears.

3. Follow the instructions in the wizard to export the report to a 
suitable program (for example Microsoft Excel).

CAUTION When Service Desk objects are archived, the analyzed data for those 
objects is removed from the database. Make sure that any analyzed data 
you wish to retain is consolidated in reports or a reporting database 
before the objects are archived.
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7 OVPI Reports Administration

This chapter describes the administrative tasks associated with using 
OVPI Helpdesk and Change Manager report packs with Service Desk. 
For a complete description of OVPI reporting, refer to the OVPI 
documentation set. 
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Overview
If you have module licenses for the Helpdesk and Change Manager 
modules, you can purchase OVPI report packs to produce reports relating 
to the data contained in each of these modules. 

Before you can produce reports on the OVPI server, you must export the 
Helpdesk and Change Manager data from Service Desk and import it 
into the OVPI database.

To export Service Desk data, perform the following tasks:

• Update or create an OVPI Report Connection, specifying your OVPI 
server details.

See “Create an OVPI Report Connection” on page 213.

• Make sure that the Reporting Administration workspace is visible in 
your HP OpenView Configuration workspace group.

See “Enable the Reporting Administration Workspace” on page 215.

• Perform a full export of data to populate the OVPI database.

See “Export the Helpdesk Module” on page 217 and “Export the 
Change Manager Module” on page 221.

• Set up the incremental export to update the OVPI database 
periodically.

NOTE For information about SLM Reporting, refer to the HP OpenView Service 
Desk Service Level Manager Guide.
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Create an OVPI Report Connection
An OVPI Report Connection specifies your OVPI server parameters. 
Service Desk reporting reads the OVPI Report Connection object to 
determine the destination server for the exported Service Desk data. 

To create or update an OVPI Report Connection:

1. In the HP OpenView Configuration workspace group, select the OVPI 
Report Connection workspace.

NOTE If the workspace is not visible, add it to the workspace group by 
right-clicking in the HP OpenView Configuration workspace group 
and selecting Add Workspace from the pop-up menu.

2. In the OVPI Report Connection view, right-click and select New 
OVPI Report Connection from the pop-up menu. Alternatively, 
right-click on the current object and select Edit from the pop-up 
menu.

The OVPI Report Connection dialog box opens.

3. Enter values for the hostname, port, username and password for 
your OVPI server.

4. Save and close the OVPI Report Connection form.
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5. Restart Object Server to load the updated parameters.

6. The daemon for Service Desk reporting is automatically started 
during the installation. If you need to start it manually, run the 
command:

ovc -start ovsdreport

7. In a multiple-server installation, only one server is required for 
Service Desk reporting. To unregister the daemon, run the following 
command:

• Windows

C:\Program Files\HP OpenView\lbin\report\ 
unregisterSDReporting.bat

• UNIX

/opt/OV/lbin/report/unregisterSDReporting.sh
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Enable the Reporting Administration 
Workspace
This section describes how to add the Reporting Administration 
workspace to the HP OpenView Configuration workspace group. You 
need to enable the Reporting Administration workspace only if it is not 
already visible in the group.

To enable the Reporting Administration workspace:

1. Right-click in the HP OpenView Configuration workspace group and 
select Add Workspace from the pop-up menu. The Add Workspace 
dialog box opens.
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2. Select the Object radio button, and then select Reporting 
Administration from the list.

3. Click OK. The Reporting Administration workspace appears in the 
HP OpenView Configuration workspace group.
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Export the Helpdesk Module
This section describes how to export the Helpdesk module data to your 
OVPI server, so that you can produce reports using the OVPI Helpdesk 
report pack. OVPI Helpdesk reports display information relating to 
service call, problem and incident objects. 

Perform a Full Export of Helpdesk Data

This process exports all data relating to service call, incident, and 
problem objects from Service Desk and imports it into the OVPI system. 

The first export of Helpdesk data that you perform must be a full export. 
This full export initializes the OVPI database with all current Helpdesk 
data. Subsequently, scheduled incremental exports periodically update 
the OVPI database with changes to Helpdesk data. 

If an incremental export fails, you can perform a full export in order to 
repopulate the OVPI database with all current Helpdesk module data.

A full export can take several minutes, depending on the amount of data. 

To perform a full export of the Helpdesk module:

1. Log on to the server where Service Desk has been installed.

2. Do one of the following:

• Run the OvObsReportAdmin script to export the Helpdesk 
module. 

— Windows 

C:\Program Files\HP 
OpenView\bin\OvObsReportAdmin.bat 
-moduleName=HelpDesk

— UNIX

/opt/OV/bin/OvObsReportAdmin.sh 
-moduleName=HelpDesk

or
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• In the HP OpenView Configuration workspace group, select the 
Reporting Administration workspace. The Reporting 
Administration view shows details of Helpdesk and Change 
Manager exports. Select the HelpDesk record, then right-click 
and select Full Export from the pop-up menu.

The Reporting Administration view shows the current date and 
time and the status (In Progress) of the Helpdesk full export. 
When the full export is complete, the status field shows a value of 
Completed.

Set Up Incremental Exports of Helpdesk

The incremental export is run periodically (for example, every hour) to 
export only the changes to the Helpdesk module data (service calls, 
problems, and incidents) that have occurred since the last export. 

To enable the incremental export, you initialize the Start Date field with 
the date of the last successful full export.

Only one incremental export can be run at one time. If two incremental 
exports are scheduled to be run at the same time, they are run 
sequentially.
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If an error occurs during an incremental export, you can run a manual 
full export to repopulate the OVPI database.

To set up incremental exports of the Helpdesk module:

1. In the HP OpenView Configuration workspace group, select the 
Reporting Administration workspace. 

The Reporting Administration view shows details of Helpdesk and 
Change Manager exports.

2. Double-click the HelpDesk record, or select the record, then 
right-click and select Edit from the pop-up menu.

The Reporting Administration dialog box opens.

3. Copy the value that appears in the Last Successful Full Export field 
to the Start Date field. 

This is the time from which scheduling of incremental exports 
begins.

4. In the Export Period field, enter a value for the number of hours 
between incremental exports.

5. Select the Enable/Disable check box to enable the incremental 
export. 

If you select this check box, you cannot run a manual full export. If 
you clear this check box, the incremental export is disabled and you 
can run a manual full export.
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NOTE You cannot run a full export and an incremental export at the same 
time.

6. Click File→Save & Close. 

The incremental export process schedules the next export for the 
specified period. The Incremental Export Results tab shows details 
of the incremental export after the export runs.
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Export the Change Manager Module
This section describes how to export the Change Manager module data to 
your OVPI server, so that you can produce reports using the OVPI 
Change Manager report pack. OVPI Change Manager reports display 
information relating to change objects.

Perform a Full Export of Change Manager Data

This process exports all data relating to change objects from Service 
Desk and imports it into the OVPI system. 

The first export of Change Manager data that you perform must be a full 
export, in order to initialize the OVPI database with all current Change 
Manager data. Subsequently, scheduled incremental exports periodically 
update the OVPI database with changes to Change Manager data. 

If an incremental export fails, you can perform a full export in order to 
repopulate the OVPI database with all current Change Manager module 
data.

A full export can take several minutes, depending on the amount of data. 

To perform a full export of the Change Manager module:

1. Log on to the server where Service Desk has been installed.

2. Do one of the following: 

• Run the OvObsReportAdmin script to export the Change 
Manager module. 

— Windows 

C:\Program Files\HP 
OpenView\bin\OvObsReportAdmin.bat 
-moduleName=ChangeManagement

— UNIX

/opt/OV/bin/OvObsReportAdmin.sh 
-moduleName=ChangeManagement

or
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• In the HP OpenView Configuration workspace group, select the 
Reporting Administration workspace. The Reporting 
Administration view shows details of Helpdesk and Change 
Manager exports. Select the ChangeManagement record, then 
right-click and select Full Export from the pop-up menu.

The Reporting Administration view shows the current date and 
time and the status (In Progress) of the Change Manager full 
export. When the full export is complete, the status field shows a 
value of Completed.

Set Up Incremental Exports of Change Manager

The incremental export is run periodically (for example, every hour) to 
export only the changes to the Change Manager module data that have 
occurred since the last export. 

To enable the incremental export, you initialize the Start Date field with 
the date of the last successful full export.

Only one incremental export can be run at one time. If two incremental 
exports are scheduled to be run at the same time, they are run 
sequentially.
Chapter 7222



OVPI Reports Administration
Export the Change Manager Module
If an error occurs during an incremental export, you can run a manual 
full export to repopulate the OVPI database.

To set up the incremental export for the Change Manager module:

1. In the HP OpenView Configuration workspace group, select the 
Reporting Administration workspace. 

The Reporting Administration view lists Helpdesk and Change 
Manager exports.

NOTE You cannot configure incremental exports until a full export has 
successfully completed. If the Last Full Export field shows a value of 
No Status, a full export has yet not been performed. For more 
information about how to perform a full export, see “Perform a Full 
Export of Change Manager Data” on page 221.

2. Double-click the ChangeManagement record, or select the record, 
then right-click and select Edit from the pop-up menu. 

The Reporting Administration dialog box opens.

3. Copy the value that appears in the Last Successful Full Export field 
to the Start Date field.

This is the time from which scheduling of incremental exports 
begins.
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4. In the Export Period field, enter a value for the number of hours 
between incremental exports.

5. Select the Enable/Disable check box to enable the incremental 
export. 

When this check box is selected, you cannot run a manual full export. 
When this check box is cleared, the incremental export is disabled 
and you can run a manual full export.

6. Click File→Save & Close. 

The incremental export process schedules the next export for the 
specified period. The Incremental Export Results tab shows details 
of the incremental export after the export runs.
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Troubleshooting OVPI Reports 
Administration
If an error occurs during an export, the Status field in the Reporting 
Administration view displays a value of “Error”.

To find out more about the error, check the following files:

• Global Service Desk log file 

<installDir>/data/log/System*.*en_US

• Dedicated Service Desk Reporting log file 

<installDir>/data/log/sd_report_admin.log*.*.en_US

• OVPI log on the OVPI server 

<OVPIInstallDir>/log/trend.log

In addition, you can activate tracing on the Service Desk Reporting 
application and check the trace files.
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8 OVPI Service Desk Reporting

OVPI Service Desk Reporting allows you to report on how your Service 
Desk is performing. It enables you to analyze calls in various ways 
including by category, classification and closure code, and identify trends 
in the number of calls that are closed before deadline.
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View Reports from the OpenView Console
Using OVPI reports you can:

• Monitor average call durations

• Analyze calls 

— by category

— by classification

— closed before deadline

— closed before deadline by category

— closed on the first call

— by closure code

• Monitor number of calls over time

• Display call details

You can view operational Service Desk reports using the OVPI report 
viewer embedded in the OpenView console. When you do this, the report 
displays context-specific information. 

To view a Service Desk report:

1. In the Service Desk workspace group, highlight one of the following 
workspaces:

• Change

• Service Call

• Problem

• Incident

2. Do one of the following:

• Select an object displayed in the view, then select one of the 
reports from the Action menu.

• Right-click an object displayed in the view, and select one of the 
reports from the drop-down menu.
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The report opens in a new window. The contents of the report depend 
on the object you select. 
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Change Manager Reports
The following reports are available:

Administration

• Configuration and logging

Changes

• Average Duration of Changes

• Changes by Category

• Changes by Classification

• Changes Closed before Deadline by Category

• Changes Closed by Deadline

• Changes Closed on First Call

• Changes Details

• Changes by Closure Code

• Incoming Changes (History)

• Incoming Changes (Recent)

NOTE In the beta release, although reports are formatted to display 
information about users (such as the customer relationship manager), 
the users are labeled as unknown.

For information about scheduling reports and generating reports on 
demand in OVPI, refer to the OVPI documentation.

Configuration and Logging Report

This report displays configuration information relating to Service Desk 
Reporting data import. It lists the most recent log table entries for 
ReportPack internal procedures. The report is limited to the 200 most 
recent entries.
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Report Schedules

• On demand

• Scheduled (daily, weekly, or monthly), configurable by the user

Report Fields

Figure 8-1 Sample Configuration and Logging Report

Average Duration of Changes Report

This report shows the average duration of changes in days per 
classification, category, priority and workgroup. 

Table 8-1 Configuration and Logging Report

Report Item Description

Current logging 
level

Error, warning or information (or any combination)

ReportPack log 
entries table

• Time the log entry was created

• The component to which the log entry refers

• The log message
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The user selects start and end dates for the evaluation period. The report 
shows changes that were registered on or after the start date, and before 
the end date. 

Report Schedules

• On demand

• Scheduled (daily, weekly, or monthly), configurable by the user

Report Fields

Table 8-2 Average Duration of Changes Report

Report Item Description

Start Date field Drop-down list. The start date of the evaluation 
period.

End Date field Drop-down list. The end date of the evaluation 
period.

Total changes 
table

Total number of changes and average duration (in 
days).

Classification 
table

Number of changes and average duration per 
classification.

Category table Number of changes and average duration per 
category.

Priority table Number of changes and average duration per 
priority code.

Tabbed area with 
bar charts

Average duration of changes at weekly, monthly or 
quarterly intervals (where applicable).
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Figure 8-2 Sample Average Duration of Changes Report
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Changes by Category Report

This report shows the total number of changes in the selected category, 
with a further breakdown by impact, priority and classification.

The user selects start and end dates for the evaluation period. The report 
shows changes that were registered on or after the start date, and before 
the end date. 

Report Schedules

• On demand

• Scheduled (daily, weekly, or monthly), configurable by the user

Report Fields

Table 8-3 Changes by Category Report

Report Item Description

Start Date field Drop-down list. The start date of the evaluation 
period.

End Date field Drop-down list. The end date of the evaluation 
period.

Drill-down 
category table

Number of changes per category. Click the drill 
icon to display information for a particular 
category.

Total changes 
table

Total number of changes.

Impact table Number of changes opened per impact code in the 
selected category.

Priority table Number of changes opened per priority code in the 
selected category.

Classification 
table

Number of changes opened per classification code 
in the selected category.

Tabbed area with 
bar charts

Number of changes at weekly, monthly or 
quarterly intervals (where applicable) within the 
evaluation period and in the selected category.
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Figure 8-3 Sample Changes by Category Report
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Changes by Classification Report

This report shows the total number of changes with the selected 
classification with a further breakdown by category. 

The user selects start and end dates for the evaluation period. The report 
shows changes that were registered on or after the start date, and before 
the end date. 

Report Schedules

• On demand

• Scheduled (daily, weekly, or monthly), configurable by the user

Report Fields

Table 8-4 Changes by Classification Report

Report Item Description

Start Date field Drop-down list. The start date of the evaluation 
period.

End Date field Drop-down list. The end date of the evaluation 
period.

Changes table Total number of changes.

Drill-down 
classification 
table

Number of changes per classification. Click the 
drill icon to display information for a particular 
classification.

Category table Number of changes per category with the selected 
classification.

Tabbed area with 
bar charts

Number of changes at weekly, monthly or 
quarterly intervals (where applicable) within the 
evaluation period and with the selected 
classification.
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Figure 8-4 Sample Changes by Classification Report
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Changes Closed before Deadline by Category Report

This report shows the percentage of changes closed before the deadline in 
the selected category, with a further breakdown by closure code.

The user selects start and end dates for the evaluation period. The report 
shows changes that were registered on or after the start date, and before 
the end date. 

Report Schedules

• On demand

• Scheduled (daily, weekly, or monthly), configurable by the user

Report Fields

Table 8-5 Changes Closed before Deadline by Category Report

Report Item Description

Start Date field Drop-down list. The start date of the evaluation 
period.

End Date field Drop-down list. The end date of the evaluation 
period.

Changes closed 
table

• Total number of changes closed

• Number of changes closed before deadline

• Percentage closed before deadline

• Number closed after deadline

Drill-down 
category table

Per category:

• Number of changes closed

• Number of changes closed before deadline

• Percentage closed before deadline

• Number closed after deadline

Click the drill icon to display information for a 
particular category.
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Closure code 
table

Per closure code in the selected category:

• Number of changes closed

• Number of changes closed before deadline

• Percentage closed before deadline

• Number closed after deadline

Tabbed area with 
bar charts

Number of changes closed before deadline at 
weekly, monthly or quarterly intervals (where 
applicable) within the evaluation period and in the 
selected category.

Table 8-5 Changes Closed before Deadline by Category Report (Continued)

Report Item Description
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Figure 8-5 Sample Changes Closed before Deadline by Category Report
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Changes Closed before Deadline Report

This report shows the percentage of changes closed before the deadline 
per classification, category, priority and workgroup. 

The user selects start and end dates for the evaluation period. The report 
shows changes that were registered on or after the start date, and before 
the end date. 

Report Schedules

• On demand

• Scheduled (daily, weekly, or monthly), configurable by the user

Report Fields

Table 8-6 Changes Closed before Deadline Report

Report Item Description

Start Date field Drop-down list. The start date of the evaluation 
period.

End Date field Drop-down list. The end date of the evaluation 
period.

Changes closed 
table

• Total number of changes closed

• Number of changes closed before deadline

• Percentage closed before deadline

• Number closed after deadline

Classification 
table

Per classification:

• Number of changes closed

• Number of changes closed before deadline

• Percentage closed before deadline

• Number closed after deadline
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Category table Per category:

• Number of changes closed

• Number of changes closed before deadline

• Percentage closed before deadline

• Number closed after deadline

Priority table Per priority code:

• Number of changes closed

• Number of changes closed before deadline

• Percentage closed before deadline

• Number closed after deadline

Organization 
table

Per organization:

• Number of changes closed

• Number of changes closed before deadline

• Percentage closed before deadline

• Number closed after deadline

Tabbed area with 
bar charts

Number of changes closed before deadline at 
weekly, monthly or quarterly intervals (where 
applicable) within the evaluation period.

Table 8-6 Changes Closed before Deadline Report (Continued)

Report Item Description
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Figure 8-6 Sample Changes Closed before Deadline Report
Chapter 8 243



OVPI Service Desk Reporting
Change Manager Reports
Changes Closed on First Call Report

This report shows the percentage of changes closed on the first call per 
classification, category, priority and workgroup. 

The user selects start and end dates for the evaluation period. The report 
shows changes that were registered on or after the start date, and before 
the end date. 

Report Schedules

• On demand

• Scheduled (daily, weekly, or monthly), configurable by the user

Report Fields

Table 8-7 Changes Closed on First Call Report

Report Item Description

Start Date field Drop-down list. The start date of the evaluation 
period.

End Date field Drop-down list. The end date of the evaluation 
period.

Changes closed 
table

• Total number of changes closed

• Number of changes closed on first call

• Percentage closed on first call

Classification 
table

Per classification:

• Number of changes closed

• Number of changes closed on first call

• Percentage closed on first call

Category table Per category:

• Number of changes closed

• Number of changes closed on first call

• Percentage closed on first call
Chapter 8244



OVPI Service Desk Reporting
Change Manager Reports
Priority table Per priority code:

• Number of changes closed

• Number of changes closed on first call

• Percentage closed on first call

Organization 
table

Per organization:

• Number of changes closed

• Number of changes closed on first call

• Percentage closed on first call

Tabbed area with 
bar charts

Number of changes closed on first call at weekly, 
monthly or quarterly intervals (where applicable) 
within the evaluation period.

Table 8-7 Changes Closed on First Call Report (Continued)

Report Item Description
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Figure 8-7 Sample Changes Closed on First Call Report
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Changes Details Report

This report shows the change records which have been received for 
reporting and processing by the warehouse system. Only recent changes 
are available. 

The user selects start and end dates for the evaluation period. The user 
can also set filters to reduce the selection and find specific cases. The 
primary table displays a limited set of rows (defaulted to 500 at most) 
and the lower table provides further details for the selected item.

Report Schedules

• On demand

• Scheduled (daily, weekly, or monthly), configurable by the user

Report Fields

Table 8-8 Changes Details Report

Report Item Description

Start Date field Drop-down list. The start date of the evaluation 
period.

End Date field Drop-down list. The end date of the evaluation 
period.

Choose Category 
field

Drop-down list. The report is limited to changes in 
the selected category.

Choose 
Classification 
field

Drop-down list. The report is limited to changes 
with the selected classification.

Choose 
Workgroup field

Drop-down list. The report is limited to changes 
for the selected workgroup.

Choose Priority 
field

Drop-down list. The report is limited to changes 
with the selected priority code.

Choose Closure 
Code field

Drop-down list. The report is limited to changes 
with the selected closure code.
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Choose Impact 
field

Drop-down list. The report is limited to changes 
with the selected impact.

Choose 
Organization 
field

Drop-down list. The report is limited to changes 
for the selected organization.

Change details 
list

Details of the changes which meet the selected 
parameters. Select an object for further details.

Further details 
list

Further details of the selected object.

Table 8-8 Changes Details Report (Continued)

Report Item Description
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Figure 8-8 Sample Changes Details Report
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Changes by Closure Code Report

This report shows the total number of changes in the selected category, 
with a further breakdown by closure code.

The user selects start and end dates for the evaluation period. The report 
shows changes that were registered on or after the start date, and before 
the end date. 

Report Schedules

• On demand

• Scheduled (daily, weekly, or monthly), configurable by the user

Report Fields

Table 8-9 Changes by Closure Code Report

Report Item Description

Start Date field Drop-down list. The start date of the evaluation 
period.

End Date field Drop-down list. The end date of the evaluation 
period.

Drill-down 
category table

Per category:

• Number of changes

• Number of changes closed before deadline

• Percentage closed on before deadline

• Number of changes closed after deadline

Click the drill icon to display information for a 
particular category.

Total changes 
table

• Total number of changes

• Number of changes closed before deadline

• Percentage closed on before deadline

• Number of changes closed after deadline
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Closure code 
table

Number of changes per closure code in the selected 
category.

Tabbed area with 
bar charts

Number of changes closed before deadline at 
weekly, monthly or quarterly intervals (where 
applicable) within the evaluation period and for 
the selected category.

Table 8-9 Changes by Closure Code Report (Continued)

Report Item Description
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Figure 8-9 Sample Changes by Closure Code Report
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Incoming Changes (History) Report

This report shows the total number of changes per classification, 
category, priority and organization. 

The user selects start and end dates for the evaluation period. The report 
shows changes that were registered on or after the start date, and before 
the end date. 

Report Schedules

• On demand

• Scheduled (daily, weekly, or monthly), configurable by the user

Report Fields

Table 8-10 Incoming Changes (History) Report

Report Item Description

Start Date field Drop-down list. The start date of the evaluation 
period.

End Date field Drop-down list. The end date of the evaluation 
period.

Changes table Total number of changes opened.

Classification 
table

Number of changes opened per classification.

Category table Number of changes opened per category.

Priority table Number of changes opened per priority code.

Organization 
table

Number of changes opened per organization.

Tabbed area with 
bar charts

Percentage of changes opened at weekly, monthly 
or quarterly intervals (where applicable) within 
the evaluation period.
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Figure 8-10 Sample Incoming Changes (History) Report
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Incoming Changes (Recent) Report

This report shows the total number of changes per classification, 
category, priority and workgroup.

The user selects start and end dates and times for the evaluation period. 
The report shows changes that were registered on or after the start date 
and time, and before the end date and time. 

Report Schedules

• On demand

• Scheduled (daily, weekly, or monthly), configurable by the user

Report Fields

Table 8-11 Incoming Changes (Recent) Report

Report Item Description

Start Date field Drop-down list. The start date of the evaluation 
period.

End Date field Drop-down list. The end date of the evaluation 
period.

Start Hour field Drop-down list. The start time of the evaluation 
period.

End Hour field Drop-down list. The end time of the evaluation 
period.

Changes table Total number of changes opened.

Classification 
table

Number of changes opened per classification.

Category table Number of changes opened per category.

Priority table Number of changes opened per priority code.

Organization 
table

Number of changes opened per organization.
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Tabbed area with 
bar charts

Number of changes opened at hourly or daily 
intervals (where applicable) within the evaluation 
period.

Table 8-11 Incoming Changes (Recent) Report (Continued)

Report Item Description
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Figure 8-11 Sample Incoming Changes (Recent) Report
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Help Desk Reports
Administration

• Configuration and Logging

Incidents

• Average Duration of Incidents

• Incidents by Category

• Incidents by Classification

• Incidents Closed Before Deadline by Category

• Incidents Closed by Deadline

• Incidents Closed on First Call

• Incident Details

• Incidents by Closure Code

• Incoming Incidents (History)

• Incoming Incidents (Recent)

Problems

• Average Duration of Problems

• Problems by Category

• Problems by Classification

• Problems Closed before Deadline by Category

• Problems Closed by Deadline

• Problems Closed on First Call

• Problem Details

• Problems by Closure Code

• Incoming Problems (History)

• Incoming Problems (Recent)

Service Calls
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• Average Duration of Service Calls

• Service Calls by Category

• Service Calls by Classification

• Service Calls Closed before Deadline by Category

• Service Calls Closed by Deadline

• Service Calls Closed on First Call

• Service Call Details

• Service Calls by Closure Code

• Incoming Service Calls (History)

• Incoming Service Calls (Recent)

Configuration and Logging Report

This report displays configuration information relating to Service Desk 
Reporting data import. It lists the most recent log table entries for 
ReportPack internal procedures. The report is limited to the 200 most 
recent entries.

Report Schedules

• On demand

• Scheduled (daily, weekly, or monthly), configurable by the user

Report Fields

Table 8-12 Configuration and Logging Report

Report Item Description

Current logging 
level

Error, warning or information (or any combination)

ReportPack log 
entries table

• Time the log entry was created

• The component to which the log entry refers

• The log message
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Figure 8-12 Sample Configuration and Logging Report
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Average Duration of Incidents Report

This report shows the average duration of incidents in days per 
classification, category, priority and workgroup. 

The user selects start and end dates for the evaluation period. The report 
shows incidents that were registered on or after the start date, and 
before the end date. 

Report Schedules

• On demand

• Scheduled (daily, weekly, or monthly), configurable by the user

Report Fields

Table 8-13 Average Duration of Incidents Report

Report Item Description

Start Date field Drop-down list. The start date of the evaluation 
period.

End Date field Drop-down list. The end date of the evaluation 
period.

Total incidents 
table

Total number of incidents and average duration 
(in days).

Classification 
table

Number of incidents and average duration per 
classification.

Category table Number of incidents and average duration per 
category.

Priority table Number of incidents and average duration per 
priority code.

Tabbed area with 
bar charts

Average duration of incidents at weekly, monthly 
or quarterly intervals (where applicable) within 
the evaluation period.
Chapter 8 261



OVPI Service Desk Reporting
Help Desk Reports
Figure 8-13 Sample Average Duration of Incidents Report
Chapter 8262



OVPI Service Desk Reporting
Help Desk Reports
Incidents by Category Report

This report shows the total number of incidents in the selected category 
with a further breakdown by impact, priority and classification. 

The user selects start and end dates for the evaluation period. The report 
shows incidents that were registered on or after the start date, and 
before the end date. 

Report Schedules

• On demand

• Scheduled (daily, weekly, or monthly), configurable by the user

Report Fields

Table 8-14 Incidents by Category Report

Report Item Description

Start Date field Drop-down list. The start date of the evaluation 
period.

End Date field Drop-down list. The end date of the evaluation 
period.

Drill-down 
category table

Number of incidents per category. Click the drill 
icon to display information for a particular 
category.

Incidents table Total number of incidents.

Impact table Number of incidents opened per impact code in the 
selected category.

Priority table Number of incidents opened per priority code in 
the selected category.

Classification 
table

Number of incidents opened per classification in 
the selected category.

Tabbed area with 
bar charts

Number of incidents at weekly, monthly or 
quarterly intervals (where applicable) within the 
evaluation period and in the selected category.
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Figure 8-14 Sample Incidents by Category Report
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Incidents by Classification Report

This report shows the total number of incidents with the selected 
classification, with a further breakdown by category. 

The user selects start and end dates for the evaluation period. The report 
shows incidents that were registered on or after the start date, and 
before the end date. 

Report Schedules

• On demand

• Scheduled (daily, weekly, or monthly), configurable by the user

Report Fields

Table 8-15 Incidents by Classification Report

Report Item Description

Start Date field Drop-down list. The start date of the evaluation 
period.

End Date field Drop-down list. The end date of the evaluation 
period.

Incidents table Total number of incidents.

Drill-down 
classification 
table

Number of incidents per classification. Click the 
drill icon to display information for a particular 
classification.

Category table Number of incidents per category with the 
selected classification.

Tabbed area with 
bar charts

Number of incidents at weekly, monthly or 
quarterly intervals (where applicable) within the 
evaluation period and with the selected 
classification.
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Figure 8-15 Sample Incidents by Classification Report
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Incidents Closed before Deadline by Category Report

This report shows the total number of incidents closed before the 
deadline in the selected category, with a further breakdown by closure 
code.

The user selects start and end dates for the evaluation period. The report 
shows incidents that were registered on or after the start date, and 
before the end date. 

Report Schedules

• On demand

• Scheduled (daily, weekly, or monthly), configurable by the user

Report Fields

Table 8-16 Incidents Closed before Deadline by Category Report

Report Item Description

Start Date field Drop-down list. The start date of the evaluation 
period.

End Date field Drop-down list. The end date of the evaluation 
period.

Incidents closed 
table

• Total number of incidents closed

• Number of incidents closed before deadline

• Percentage closed before deadline

• Number closed after deadline

Drill-down 
category table

Per category:

• Number of incidents closed

• Number of incidents closed before deadline

• Percentage closed before deadline

• Number closed after deadline

Click the drill icon to display information for a 
particular category.
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Closure code 
table

Per closure code in the selected category:

• Number of incidents closed

• Number of incidents closed before deadline

• Percentage closed before deadline

• Number closed after deadline

Tabbed area with 
bar charts

Number of incidents closed before deadline at 
weekly, monthly or quarterly intervals (where 
applicable) within the evaluation period and in the 
selected category.

Table 8-16 Incidents Closed before Deadline by Category Report 

Report Item Description
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Figure 8-16 Sample Incidents Closed before Deadline by Category Report
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Incidents Closed before Deadline Report

This report shows the percentage of incidents closed before the deadline 
per classification, category, priority and workgroup.

The user selects start and end dates for the evaluation period. The report 
shows incidents that were registered on or after the start date, and 
before the end date. 

Report Schedules

• On demand

• Scheduled (daily, weekly, or monthly), configurable by the user

Report Fields

Table 8-17 Incidents Closed before Deadline Report

Report Item Description

Start Date field Drop-down list. The start date of the evaluation 
period.

End Date field Drop-down list. The end date of the evaluation 
period.

Incidents closed 
table

• Total number of incidents closed

• Number of incidents closed before deadline

• Percentage closed before deadline

• Number closed after deadline

Classification 
table

Per classification:

• Number of incidents closed

• Number of incidents closed before deadline

• Percentage closed before deadline

• Number closed after deadline
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Category table Per category:

• Number of incidents closed

• Number of incidents closed before deadline

• Percentage closed before deadline

• Number closed after deadline

Priority table Per priority code:

• Number of incidents closed

• Number of incidents closed before deadline

• Percentage closed before deadline

• Number closed after deadline

Organization 
table

Per organization:

• Number of incidents closed

• Number of incidents closed before deadline

• Percentage closed before deadline

• Number closed after deadline

Tabbed area with 
bar charts

Number of incidents closed before deadline at 
weekly, monthly or quarterly intervals (where 
applicable) within the evaluation period.

Table 8-17 Incidents Closed before Deadline Report (Continued)

Report Item Description
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Figure 8-17 Sample Incidents Closed before Deadline Report
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Incidents Closed on First Call Report

This report shows the percentage incidents closed on the first call per 
classification, category, priority and workgroup. 

The user selects start and end dates for the evaluation period. The report 
shows incidents that were registered on or after the start date, and 
before the end date. 

Report Schedules

• On demand

• Scheduled (daily, weekly, or monthly), configurable by the user

Report Fields

Table 8-18 Incidents Closed on First Call Report

Report Item Description

Start Date field Drop-down list. The start date of the evaluation 
period.

End Date field Drop-down list. The end date of the evaluation 
period.

Incidents closed 
table

• Total number of incidents closed

• Number of incidents closed on first call

• Percentage closed on first call

Classification 
table

Per classification:

• Number of incidents closed

• Number of incidents closed on first call

• Percentage closed on first call

Category table Per category:

• Number of incidents closed

• Number of incidents closed on first call

• Percentage closed on first call
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Priority table Per priority code:

• Number of incidents closed

• Number of incidents closed on first call

• Percentage closed on first call

Organization 
table

Per organization:

• Number of incidents closed

• Number of incidents closed on first call

• Percentage closed on first call

Tabbed area with 
bar charts

Number of incidents closed on first call at weekly, 
monthly or quarterly intervals (where applicable) 
within the evaluation period.

Table 8-18 Incidents Closed on First Call Report (Continued)

Report Item Description
Chapter 8274



OVPI Service Desk Reporting
Help Desk Reports
Figure 8-18 Sample Incidents Closed on First Call Report
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Incidents Details Report

This report shows the incident records which have been received for 
reporting and processing by the warehouse system. 

The user selects start and end dates for the evaluation period. The user 
can also set filters to reduce the selection and find specific cases. The 
primary table displays a limited set of rows (defaulted to 500 at most) 
and the lower table provides further details for the selected item.

Report Schedules

• On demand

• Scheduled (daily, weekly, or monthly), configurable by the user

Report Fields

Table 8-19 Incidents Details Report

Report Item Description

Start Date field Drop-down list. The start date of the evaluation 
period.

End Date field Drop-down list. The end date of the evaluation 
period.

Choose Category 
field

Drop-down list. The report is limited to incidents 
in the selected category.

Choose 
Classification 
field

Drop-down list. The report is limited to incidents 
with the selected classification.

Choose 
Workgroup field

Drop-down list. The report is limited to incidents 
for the selected workgroup.

Choose Priority 
field

Drop-down list. The report is limited to incidents 
with the selected priority code.

Choose Closure 
Code field

Drop-down list. The report is limited to incidents 
with the selected closure code.

Choose Impact 
field

Drop-down list. The report is limited to incidents 
with the selected impact.
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Choose 
Organization 
field

Drop-down list. The report is limited to incidents 
for the selected organization.

Change details 
list

Details of the incidents which meet the selected 
parameters. Select an object for further details.

Further details 
list

Further details of the selected object.

Table 8-19 Incidents Details Report (Continued)

Report Item Description
Chapter 8 277



OVPI Service Desk Reporting
Help Desk Reports
Figure 8-19 Sample Incidents Details Report
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Incidents by Closure Code Report

This report shows the total number of incidents in the selected category 
with a further breakdown by closure code.

The user selects start and end dates for the evaluation period. The report 
shows incidents that were registered on or after the start date, and 
before the end date. 

Report Schedules

• On demand

• Scheduled (daily, weekly, or monthly), configurable by the user

Report Fields

Table 8-20 Incidents by Closure Code Report

Report Item Description

Start Date field Drop-down list. The start date of the evaluation 
period.

End Date field Drop-down list. The end date of the evaluation 
period.

Drill-down 
category table

Per category:

• Number of incidents closed

• Number of incidents closed before deadline

• Percentage closed before deadline

• Number of incidents closed after deadline

Click the drill icon to display information in a 
particular category.

Total incidents 
table

• Total number of incidents closed before 
deadline

• Number of incidents closed

• Percentage closed before deadline

• Number of incidents closed after deadline
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Closure code 
table

Number of incidents closed per closure code in the 
selected category.

Tabbed area with 
bar charts

Number of incidents closed before deadline at 
weekly, monthly or quarterly intervals (where 
applicable) within the evaluation period and in the 
selected category.

Table 8-20 Incidents by Closure Code Report (Continued)

Report Item Description
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Figure 8-20 Sample Incidents by Closure Code Report
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Incoming Incidents (History) Report

This report shows the total number of incidents per classification, 
category, priority and organization.

The user selects start and end dates for the evaluation period. The report 
shows incidents that were registered on or after the start date, and 
before the end date. 

Report Schedules

• On demand

• Scheduled (daily, weekly, or monthly), configurable by the user

Report Fields

Table 8-21 Incoming Incidents (History) Report

Report Item Description

Start Date field Drop-down list. The start date of the evaluation 
period.

End Date field Drop-down list. The end date of the evaluation 
period.

Incidents table Total number of incidents opened.

Classification 
table

Number of incidents opened per classification.

Category table Number of incidents opened per category.

Priority table Number of incidents opened per priority code.

Organization 
table

Number of incidents opened per organization.

Tabbed area with 
bar charts

Percentage of incidents opened at weekly, monthly 
or quarterly intervals (where applicable) within 
the evaluation period.
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Incoming Incidents (Recent) Report

This report shows the total number of incidents per classification, 
category, priority and workgroup.

The user selects start and end dates and times for the evaluation period. 
The report shows incidents that were registered on or after the start date 
and time, and before the end date and time. 

Report Schedules

• On demand

• Scheduled (daily, weekly, or monthly), configurable by the user

Report Fields

Table 8-22 Incoming Incidents (Recent) Report

Report Item Description

Start Date field Drop-down list. The start date of the evaluation 
period.

End Date field Drop-down list. The end date of the evaluation 
period.

Start Hour field Drop-down list. The start time of the evaluation 
period.

End Hour field Drop-down list. The end time of the evaluation 
period.

Incidents table Total number of incidents opened.

Classification 
table

Number of incidents opened per classification.

Category table Number of incidents opened per category.

Priority table Number of incidents opened per priority code.

Organization 
table

Number of incidents opened per organization.
Chapter 8284



OVPI Service Desk Reporting
Help Desk Reports
Tabbed area with 
bar charts

Number of incidents opened at hourly or daily 
intervals (where applicable) within the evaluation 
period.

Table 8-22 Incoming Incidents (Recent) Report (Continued)

Report Item Description
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Figure 8-22 Sample Incoming Incidents (Recent) Report
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Average Duration of Problems Report

This report shows the average duration of problems in days per 
classification, category, priority and workgroup. 

The user selects start and end dates for the evaluation period. The report 
shows problems that were registered on or after the start date, and 
before the end date. 

Report Schedules

• On demand

• Scheduled (daily, weekly, or monthly), configurable by the user

Report Fields

Table 8-23 Average Duration of Problems Report

Report Item Description

Start Date field Drop-down list. The start date of the evaluation 
period.

End Date field Drop-down list. The end date of the evaluation 
period.

Total problems 
table

Total number of problems and average duration 
(in days).

Classification 
table

Number of problems and average duration per 
classification.

Category table Number of problems and average duration per 
category.

Priority table Number of problems and average duration per 
priority code.

Tabbed area with 
bar charts

Average duration of problems at weekly, monthly 
or quarterly intervals (where applicable) within 
the evaluation period.
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Problems by Category Report

This report shows the total number of problems in the selected category 
with a further breakdown by impact, priority and classification.

The user selects start and end dates for the evaluation period. The report 
shows problems that were registered on or after the start date, and 
before the end date. 

Report Schedules

• On demand

• Scheduled (daily, weekly, or monthly), configurable by the user

Report Fields

Table 8-24 Problems by Category Report

Report Item Description

Start Date field Drop-down list. The start date of the evaluation 
period.

End Date field Drop-down list. The end date of the evaluation 
period.

Drill-down 
category table

Number of problems per category. Click the drill 
icon to display information for a particular 
category.

Total problems 
table

Total number of problems.

Impact table Number of problems opened per impact code in the 
selected category.

Priority table Number of problems opened per priority code in 
the selected category.

Classification 
table

Number of problems opened per classification code 
in the selected category.

Tabbed area with 
bar charts

Number of problems at weekly, monthly or 
quarterly intervals (where applicable) within the 
evaluation period and in the selected category.
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Figure 8-24 Sample Problems by Category Report
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Problems by Classification Report

This report shows the total number of problems with the selected 
classification, with a further breakdown by category.

The user selects start and end dates for the evaluation period. The report 
shows problems that were registered on or after the start date, and 
before the end date. 

Report Schedules

• On demand

• Scheduled (daily, weekly, or monthly), configurable by the user

Report Fields

Table 8-25 Problems by Classification Report

Report Item Description

Start Date field Drop-down list. The start date of the evaluation 
period.

End Date field Drop-down list. The end date of the evaluation 
period.

Problems table Total number of problems.

Drill-down 
classification 
table

Number of problems per classification. Click the 
drill icon to display information for a particular 
classification.

Category table Number of problems per category with the 
selected classification.

Tabbed area with 
bar charts

Number of problems at weekly, monthly or 
quarterly intervals (where applicable) within the 
evaluation period and with the selected 
classification.
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Problems Closed before Deadline by Category Report

This report shows the percentage of problems closed before the deadline 
in the selected category, with a further breakdown by closure code.

The user selects start and end dates for the evaluation period. The report 
shows problems that were registered on or after the start date, and 
before the end date. 

Report Schedules

• On demand

• Scheduled (daily, weekly, or monthly), configurable by the user

Report Fields

Table 8-26 Problems Closed before Deadline by Category Report

Report Item Description

Start Date field Drop-down list. The start date of the evaluation 
period.

End Date field Drop-down list. The end date of the evaluation 
period.

Problems closed 
table

• Total number of problems closed

• Number of problems closed before deadline

• Percentage closed before deadline

• Number closed after deadline

Drill-down 
category table

Per category:

• Number of problems closed

• Number of problems closed before deadline

• Percentage closed before deadline

• Number closed after deadline

Click the drill icon to display information for a 
particular category.
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Closure code 
table

Per closure code in the selected category:

• Number of problems closed

• Number of problems closed before deadline

• Percentage closed before deadline

• Number closed after deadline

Tabbed area with 
bar charts

Number of problems closed before deadline at 
weekly, monthly or quarterly intervals (where 
applicable) within the evaluation period and in the 
selected category.

Table 8-26 Problems Closed before Deadline by Category Report 

Report Item Description
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Problems Closed by Deadline Report

This report shows the percentage of problems closed before the deadline 
per classification, category, priority and workgroup.

The user selects start and end dates for the evaluation period. The report 
shows problems that were registered on or after the start date, and 
before the end date. 

Report Schedules

• On demand

• Scheduled (daily, weekly, or monthly), configurable by the user

Report Fields

Table 8-27 Problems Closed before Deadline Report

Report Item Description

Start Date field Drop-down list. The start date of the evaluation 
period.

End Date field Drop-down list. The end date of the evaluation 
period.

Problems closed 
table

• Total number of problems closed

• Number of problems closed before deadline

• Percentage closed before deadline

• Number closed after deadline

Classification 
table

Per classification:

• Number of problems closed

• Number of problems closed before deadline

• Percentage closed before deadline

• Number closed after deadline
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Category table Per category:

• Number of problems closed

• Number of problems closed before deadline

• Percentage closed before deadline

• Number closed after deadline

Priority table Per priority code:

• Number of problems closed

• Number of problems closed before deadline

• Percentage closed before deadline

• Number closed after deadline

Organization 
table

Per organization:

• Number of problems closed

• Number of problems closed before deadline

• Percentage closed before deadline

• Number closed after deadline

Tabbed area with 
bar charts

Number of problems closed before deadline at 
weekly, monthly or quarterly intervals (where 
applicable) within the evaluation period.

Table 8-27 Problems Closed before Deadline Report (Continued)

Report Item Description
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Problems Closed on First Call Report

This report shows the percentage of problems closed on the first call per 
classification, category, priority and workgroup.

The user selects start and end dates for the evaluation period. The report 
shows problems that were registered on or after the start date, and 
before the end date. 

Report Schedules

• On demand

• Scheduled (daily, weekly, or monthly), configurable by the user

Report Fields

Table 8-28 Problems Closed on First Call Report

Report Item Description

Start Date field Drop-down list. The start date of the evaluation 
period.

End Date field Drop-down list. The end date of the evaluation 
period.

Problems closed 
table

• Total number of problems closed

• Number of problems closed on first call

• Percentage closed on first call

Classification 
table

Per classification:

• Number of problems closed

• Number of problems closed on first call

• Percentage closed on first call

Category table Per category:

• Number of problems closed

• Number of problems closed on first call

• Percentage closed on first call
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Priority table Per priority code:

• Number of problems closed

• Number of problems closed on first call

• Percentage closed on first call

Organization 
table

Per organization:

• Number of problems closed

• Number of problems closed on first call

• Percentage closed on first call

Tabbed area with 
bar charts

Number of problems closed on first call at weekly, 
monthly or quarterly intervals (where applicable) 
within the evaluation period.

Table 8-28 Problems Closed on First Call Report (Continued)

Report Item Description
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Figure 8-28 Sample Problems Closed on First Call Report
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Problems Details Report

This report shows the problem records which have been received for 
reporting and processing by the warehouse system. 

The user selects start and end dates for the evaluation period. The user 
can also set filters to reduce the selection and find specific cases. The 
primary table displays a limited set of rows (defaulted to 500 at most) 
and the lower table provides further details for the selected item.

Report Schedules

• On demand

• Scheduled (daily, weekly, or monthly), configurable by the user

Report Fields

Table 8-29 Problems Details Report

Report Item Description

Start Date field Drop-down list. The start date of the evaluation 
period.

End Date field Drop-down list. The end date of the evaluation 
period.

Choose Category 
field

Drop-down list. The report is limited to problems 
in the selected category.

Choose 
Classification 
field

Drop-down list. The report is limited to problems 
with the selected classification.

Choose 
Workgroup field

Drop-down list. The report is limited to problems 
for the selected workgroup.

Choose Priority 
field

Drop-down list. The report is limited to problems 
with the selected priority code.

Choose Closure 
Code field

Drop-down list. The report is limited to problems 
with the selected closure code.

Choose Impact 
field

Drop-down list. The report is limited to problems 
with the selected impact.
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Choose 
Organization 
field

Drop-down list. The report is limited to problems 
for the selected organization.

Change details 
list

Details of the problems which meet the selected 
parameters. Select an object for further details.

Further details 
list

Further details of the selected object.

Table 8-29 Problems Details Report (Continued)

Report Item Description
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Figure 8-29 Sample Problems Details Report
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Problems by Closure Code Report

This report shows the total number of problems for the selected category 
with a further breakdown by closure code.

The user selects start and end dates for the evaluation period. The report 
shows problems that were registered on or after the start date, and 
before the end date. 

Report Schedules

• On demand

• Scheduled (daily, weekly, or monthly), configurable by the user

Report Fields

Table 8-30 Problems by Closure Code Report

Report Item Description

Start Date field Drop-down list. The start date of the evaluation 
period.

End Date field Drop-down list. The end date of the evaluation 
period.

Drill-down 
category table

Per category:

• Number of problems closed

• Number of problems closed before deadline

• Percentage closed before deadline

• Number of problems closed after deadline

Click the drill icon to display information for a 
particular category.

Total problems 
table

• Total number of problems closed

• Number of problems closed before deadline

• Percentage closed before deadline

• Number of problems closed after deadline
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Closure code 
table

Number of problems per closure code in the 
selected category.

Tabbed area with 
bar charts

Number of problems closed before deadline at 
weekly, monthly or quarterly intervals (where 
applicable) within the evaluation period and in the 
selected category.

Table 8-30 Problems by Closure Code Report (Continued)

Report Item Description
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Figure 8-30 Sample Problems by Closure Code Report
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Incoming Problems (History) Report

This report shows the total number of problems per classification, 
category, priority and organization.

The user selects start and end dates for the evaluation period. The report 
shows problems that were registered on or after the start date, and 
before the end date. 

Report Schedules

• On demand

• Scheduled (daily, weekly, or monthly), configurable by the user

Report Fields

Table 8-31 Incoming Problems (History) Report

Report Item Description

Start Date field Drop-down list. The start date of the evaluation 
period.

End Date field Drop-down list. The end date of the evaluation 
period.

Problems table Total number of problems opened.

Classification 
table

Number of problems opened per classification.

Category table Number of problems opened per category.

Priority table Number of problems opened per priority code.

Organization 
table

Number of problems opened per organization.

Tabbed area with 
bar charts

Percentage of problems opened at weekly, monthly 
or quarterly intervals (where applicable) within 
the evaluation period.
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Figure 8-31 Sample Incoming Problems (History) Report
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Incoming Problems (Recent) Report

This report shows the total number of problems per classification, 
category, priority and workgroup.

The user selects start and end dates and times for the evaluation period. 
The report shows problems that were registered on or after the start date 
and time, and before the end date and time. 

Report Schedules

• On demand

• Scheduled (daily, weekly, or monthly), configurable by the user

Report Fields

Table 8-32 Incoming Problems (Recent) Report

Report Item Description

Start Date field Drop-down list. The start date of the evaluation 
period.

End Date field Drop-down list. The end date of the evaluation 
period.

Start Hour field Drop-down list. The start time of the evaluation 
period.

End Hour field Drop-down list. The end time of the evaluation 
period.

Problems table Total number of problems opened.

Classification 
table

Number of problems opened per classification.

Category table Number of problems opened per category.

Priority table Number of problems opened per priority code.

Organization 
table

Number of problems opened per organization.
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Tabbed area with 
bar charts

Number of problems opened at hourly or daily 
intervals (where applicable) within the evaluation 
period.

Table 8-32 Incoming Problems (Recent) Report (Continued)

Report Item Description
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Figure 8-32 Sample Incoming Problems (Recent) Report
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Average Duration of Service Calls Report

This report shows the average duration of service calls in days per 
classification, category, priority and workgroup.

The user selects start and end dates for the evaluation period. The report 
shows service calls that were registered on or after the start date, and 
before the end date. 

Report Schedules

• On demand

• Scheduled (daily, weekly, or monthly), configurable by the user

Report Fields

Table 8-33 Average Duration of Service Calls Report

Report Item Description

Start Date field Drop-down list. The start date of the evaluation 
period.

End Date field Drop-down list. The end date of the evaluation 
period.

Total service 
calls table

Total number of service calls and average duration 
(in days).

Classification 
table

Number of service calls and average duration per 
classification.

Category table Number of service calls and average duration per 
category.

Priority table Number of service calls and average duration per 
priority code.

Tabbed area with 
bar charts

Average duration of service calls at weekly, 
monthly or quarterly intervals (where applicable) 
within the evaluation period.
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Service Calls by Category Report

This report shows the total number of service calls in the selected 
category with a further breakdown by impact, priority and classification.

The user selects start and end dates for the evaluation period. The report 
shows service calls that were registered on or after the start date, and 
before the end date. 

Report Schedules

• On demand

• Scheduled (daily, weekly, or monthly), configurable by the user

Report Fields

Table 8-34 Service Calls by Category Report

Report Item Description

Start Date field Drop-down list. The start date of the evaluation 
period.

End Date field Drop-down list. The end date of the evaluation 
period.

Drill-down 
category table

Number of service calls per category. Click the 
drill icon to display information for a particular 
category.

Total service 
calls table

Total number of service calls.

Impact table Number of service calls opened per impact code in 
the selected category.

Priority table Number of service calls opened per priority code in 
the selected category.

Classification 
table

Number of service calls opened per classification 
code in the selected category.

Tabbed area with 
bar charts

Number of service calls at weekly, monthly or 
quarterly intervals (where applicable) within the 
evaluation period and in the selected category.
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Figure 8-34 Sample Service Calls by Category Report
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Service Calls by Classification Report

This report shows the total number of service calls with the selected 
classification, with a further breakdown by category.

The user selects start and end dates for the evaluation period. The report 
shows service calls that were registered on or after the start date, and 
before the end date. 

Report Schedules

• On demand

• Scheduled (daily, weekly, or monthly), configurable by the user

Report Fields

Table 8-35 Service Calls by Classification Report

Report Item Description

Start Date field Drop-down list. The start date of the evaluation 
period.

End Date field Drop-down list. The end date of the evaluation 
period.

Service Calls 
table

Total number of service calls.

Drill-down 
classification 
table

Number of service calls per classification. Click 
the drill icon to display information for a 
particular classification.

Category table Number of service calls per category with the 
selected classification.

Tabbed area with 
bar charts

Number of service calls at weekly, monthly or 
quarterly intervals (where applicable) within the 
evaluation period and with the selected 
classification.
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Service Calls Closed before Deadline by Category 
Report

This report shows the percentage of service calls closed before the 
deadline in the selected category, with a further breakdown by closure 
code.

The user selects start and end dates for the evaluation period. The report 
shows service calls that were registered on or after the start date, and 
before the end date. 

Report Schedules

• On demand

• Scheduled (daily, weekly, or monthly), configurable by the user

Report Fields

Table 8-36 Service Calls Closed before Deadline by Category Report

Report Item Description

Start Date field Drop-down list. The start date of the evaluation 
period.

End Date field Drop-down list. The end date of the evaluation 
period.

Service Calls 
closed table

• Total number of service calls closed

• Number of service calls closed before deadline

• Percentage closed before deadline

• Number of service calls closed after deadline
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Drill-down 
category table

Per category:

• Number of service calls closed

• Number of service calls closed before deadline

• Percentage closed before deadline

• Number of service calls closed after deadline

Click the drill icon to display information for a 
particular category.

Closure code 
table

Per closure code in the selected category:

• Number of service calls closed

• Number of service calls closed before deadline

• Percentage closed before deadline

• Number of service calls closed after deadline

Tabbed area with 
bar charts

Number of service calls closed before deadline at 
weekly, monthly or quarterly intervals (where 
applicable) within the evaluation period and in the 
selected category.

Table 8-36 Service Calls Closed before Deadline by Category Report 

Report Item Description
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Figure 8-36 Sample Service Calls Closed before Deadline by Category Report
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Service Calls Closed by Deadline Report

This report shows the percentage of service calls closed before the 
deadline per classification, category, priority and workgroup.

The user selects start and end dates for the evaluation period. The report 
shows service calls that were registered on or after the start date, and 
before the end date. 

Report Schedules

• On demand

• Scheduled (daily, weekly, or monthly), configurable by the user

Report Fields

Table 8-37 Service Calls Closed before Deadline Report

Report Item Description

Start Date field Drop-down list. The start date of the evaluation 
period.

End Date field Drop-down list. The end date of the evaluation 
period.

Service Calls 
closed table

• Total number of service calls closed

• Number of service calls closed before deadline

• Percentage closed before deadline

• Number of service calls closed after deadline

Classification 
table

Per classification:

• Number of service calls closed

• Number of service calls closed before deadline

• Percentage closed before deadline

• Number of service calls closed after deadline
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Category table Per category:

• Number of service calls closed

• Number of service calls closed before deadline

• Percentage closed before deadline

• Number of service calls closed after deadline

Priority table Per priority code:

• Number of service calls closed

• Number of service calls closed before deadline

• Percentage closed before deadline

• Number of service calls closed after deadline

Organization 
table

Per organization:

• Number of service calls closed

• Number of service calls closed before deadline

• Percentage closed before deadline

• Number of service calls closed after deadline

Tabbed area with 
bar charts

Number of service calls closed before deadline at 
weekly, monthly or quarterly intervals (where 
applicable) within the evaluation period.

Table 8-37 Service Calls Closed before Deadline Report (Continued)

Report Item Description
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Service Calls Closed on First Call Report

This report shows the percentage of service calls closed on the first call 
per classification, category, priority and workgroup.

The user selects start and end dates for the evaluation period. The report 
shows service calls that were registered on or after the start date, and 
before the end date. 

Report Schedules

• On demand

• Scheduled (daily, weekly, or monthly), configurable by the user

Report Fields

Table 8-38 Service Calls Closed on First Call Report

Report Item Description

Start Date field Drop-down list. The start date of the evaluation 
period.

End Date field Drop-down list. The end date of the evaluation 
period.

Service Calls 
closed table

• Total number of service calls closed

• Number of service calls closed on first call

• Percentage closed on first call

Classification 
table

Per classification:

• Number of service calls closed

• Number of service calls closed on first call

• Percentage closed on first call

Category table Per category:

• Number of service calls closed

• Number of service calls closed on first call

• Percentage closed on first call
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Priority table Per priority code:

• Number of service calls closed

• Number of service calls closed on first call

• Percentage closed on first call

Organization 
table

Per organization:

• Number of service calls closed

• Number of service calls closed on first call

• Percentage closed on first call

Tabbed area with 
bar charts

Number of service calls closed on first call at 
weekly, monthly or quarterly intervals (where 
applicable) within the evaluation period.

Table 8-38 Service Calls Closed on First Call Report (Continued)

Report Item Description
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Figure 8-38 Sample Service Calls Closed on First Call Report
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Service Calls Details Report

This report shows the service call records which have been received for 
reporting and processing by the warehouse system. 

The user selects start and end dates for the evaluation period. The user 
can also set filters to reduce the selection and find specific cases. The 
primary table displays a limited set of rows (defaulted to 500 at most) 
and the lower table provides further details for the selected item.

Report Schedules

• On demand

• Scheduled (daily, weekly, or monthly), configurable by the user

Report Fields

Table 8-39 Service Calls Details Report

Report Item Description

Start Date field Drop-down list. The start date of the evaluation 
period.

End Date field Drop-down list. The end date of the evaluation 
period.

Choose Category 
field

Drop-down list. The report is limited to service 
calls in the selected category.

Choose 
Classification 
field

Drop-down list. The report is limited to service 
calls with the selected classification.

Choose 
Workgroup field

Drop-down list. The report is limited to service 
calls for the selected workgroup.

Choose Priority 
field

Drop-down list. The report is limited to service 
calls with the selected priority code.

Choose Closure 
Code field

Drop-down list. The report is limited to service 
calls with the selected closure code.

Choose Impact 
field

Drop-down list. The report is limited to service 
calls with the selected impact.
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Choose 
Organization 
field

Drop-down list. The report is limited to service 
calls for the selected organization.

Change details 
list

Details of the service calls which meet the selected 
parameters. Select an object for further details.

Further details 
list

Further details of the selected object.

Table 8-39 Service Calls Details Report (Continued)

Report Item Description
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Figure 8-39 Sample Service Calls Details Report
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Service Calls by Closure Code Report

This report shows the total number of service calls in the selected 
category with a further breakdown by closure code.

The user selects start and end dates for the evaluation period. The report 
shows service calls that were registered on or after the start date, and 
before the end date.

Report Schedules

• On demand

• Scheduled (daily, weekly, or monthly), configurable by the user

Report Fields

Table 8-40 Service Calls by Closure Code Report

Report Item Description

Start Date field Drop-down list. The start date of the evaluation 
period.

End Date field Drop-down list. The end date of the evaluation 
period.

Drill-down 
category table

Per category:

• Number of service calls

• Number of service calls closed before deadline

• Percentage of service calls closed before 
deadline

• Number of service calls closed after deadline

Click the drill icon to display information for a 
particular category.

Total service 
calls table

• Number of service calls closed before deadline

• Total number of service calls

• Percentage of service calls closed before 
deadline

• Number of service calls closed after deadline
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Closure code 
table

Number of service calls per closure code in the 
selected category.

Tabbed area with 
bar charts

Number of service calls closed before deadline at 
weekly, monthly or quarterly intervals (where 
applicable) within the evaluation period and in the 
selected category.

Table 8-40 Service Calls by Closure Code Report (Continued)

Report Item Description
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Figure 8-40 Sample Service Calls by Closure Code Report
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Incoming Service Calls (History) Report

This report shows the total number of service calls per classification, 
category, priority and organization.

The user selects start and end dates for the evaluation period. The report 
shows service calls that were registered on or after the start date, and 
before the end date. 

Report Schedules

• On demand

• Scheduled (daily, weekly, or monthly), configurable by the user

Report Fields

Table 8-41 Incoming Service Calls (History) Report

Report Item Description

Start Date field Drop-down list. The start date of the evaluation 
period.

End Date field Drop-down list. The end date of the evaluation 
period.

Service Calls 
table

Total number of service calls opened.

Classification 
table

Number of service calls opened per classification.

Category table Number of service calls opened per category.

Priority table Number of service calls opened per priority code.

Organization 
table

Number of service calls opened per organization.

Tabbed area with 
bar charts

Percentage of service calls opened at weekly, 
monthly or quarterly intervals (where applicable) 
within the evaluation period.
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Figure 8-41 Sample Incoming Service Calls (History) Report
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Incoming Service Calls (Recent) Report

This report shows the total number of service calls per classification, 
category, priority and workgroup.

The user selects start and end dates and times for the evaluation period. 
The report shows service calls that were registered on or after the start 
date and time, and before the end date and time. 

Report Schedules

• On demand

• Scheduled (daily, weekly, or monthly), configurable by the user

Report Fields

Table 8-42 Incoming Service Calls (Recent) Report

Report Item Description

Start Date field Drop-down list. The start date of the evaluation 
period.

End Date field Drop-down list. The end date of the evaluation 
period.

Start Hour field Drop-down list. The start time of the evaluation 
period.

End Hour field Drop-down list. The end time of the evaluation 
period.

Service Calls 
table

Total number of service calls opened.

Classification 
table

Number of service calls opened per classification.

Category table Number of service calls opened per category.

Priority table Number of service calls opened per priority code.

Organization 
table

Number of service calls opened per organization.
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Tabbed area with 
bar charts

Number of service calls opened at hourly or daily 
intervals (where applicable) within the evaluation 
period.

Table 8-42 Incoming Service Calls (Recent) Report (Continued)

Report Item Description
Chapter 8 337



OVPI Service Desk Reporting
Help Desk Reports
Figure 8-42 Sample Incoming Service Calls (Recent) Report
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9 Archiving

This chapter explains how to archive Service Desk objects.
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When Service Desk information is archived, it is first copied to a 
predefined archive location, and then deleted from the production 
database. The archived information is stored in XML format.

Archiving is suitable for information that is too useful to discard, but is 
not accessed frequently enough to justify the space it occupies and the 
impact it has on Service Desk performance. For example, a service call 
may be resolved and closed, but deleting it would result in the loss of 
information vital for investigations into the underlying issues and the 
solution that was implemented. This information might be worth 
retaining in case similar issues arise in future, and for auditing 
purposes.

You specify the information to be archived by defining views for each 
object type. Work orders, changes, projects, problems, service calls, and 
incidents can all be archived. Any combination of conditions that can be 
set up in a Service Desk data view can be used to determine what 
information is archived.

CAUTION Archiving should not be used as a backup solution. When information 
has been archived, it cannot be restored. For information about 
performing database backups, refer to your database vendor’s 
documentation set.
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Structure of Archive Files

Service Desk archives are stored in XML format. You can choose between 
two different XML structures when archiving:

• Service Desk-specific

The DTD of the Service Desk-specific XML structure is based on the 
Service Desk object model. The types of XML elements are the 
entities or object types in the Service Desk object model. The 
attributes of the individual XML elements correspond to the values 
of the attributes in the individual Service Desk objects they 
represent. 

• Abstract

The DTD of the abstract XML structure is based on a generalized 
information model, where the XML elements reflect the abstract 
concepts of objects and their attributes. Reference is made to the 
Service Desk object model by identifying the relevant Service Desk 
entities or object types within the properties of the individual XML 
elements.

The advantage of the abstract XML format is that the DTD does not 
depend on the details of a particular Service Desk implementation. 
This makes it very versatile.

The disadvantage of the abstract format is that for a particular 
implementation of Service Desk, programmers who transform XML 
to another format - such as HTML - need to fill in the actual details 
of the Service Desk implementation without any help from the 
structure of the XML.

NOTE Although the data exchange mechanism also exports and imports data in 
XML format, there is no connection between archiving and data 
exchange. Data exchange uses the Common Information Model (CIM) 
XML data definition. In contrast, archiving uses one of two 
user-selectable XML formats: abstract or Service Desk-specific.
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Set Up the Archive Process
The tasks required to set up the archiving process are as follows:

• Create views (or use existing views) that specify the objects to be 
archived.

• Select the specified views in the Archive Settings dialog box.

For instructions, see “Define Archive Settings” on page 343.

• Select the options to archive History Lines, attachments, and service 
event relations, if required.

For instructions, see “Define Archive Settings” on page 343.

• Define settings for archive file names, location and format.

For instructions, see “Define Archive File Names and Location” on 
page 345

• Start archiving immediately from Service Desk, or initiate archiving 
from the command prompt (for scheduling).

For instructions about starting the archive process manually, see 
“Start the Archive Process” on page 347.

For instructions about scheduling archiving, see “Schedule the 
Archive Process” on page 351.
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Define Archive Settings

You define archive settings in the Archive Settings dialog box.

To set up the archive process:

1. Create table views (or use existing table views) that define the 
information you wish to archive. The fields included in each view 
determine the attributes that are archived with each record. The 
filters applied to the view determine which records are archived. 

NOTE You can use only table views for archiving. Other types of view are 
not valid.

2. In the HP OpenView Configuration workspace group, select the 
System Settings workspace.

3. In the right-hand pane, double-click the Archive Settings icon. The 
Archive Settings dialog box opens.

4. In the Views tab page, select the check box for each object type that 
you wish to archive. 
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CAUTION The order in which objects are listed for archiving is the order in 
which they are deleted. This order is significant because of the 
hierarchical links that may exist between objects. For this reason, do 
not select an object lower down in the list without also selecting the 
objects above it. 

For more information about object order, see “Object Order in 
Archives” on page 356.

5. Select a view from the drop-down list next to each object type. The 
selected view determines what information is archived with each 
object. 

6. Select the Abstract Format check box to archive your information in 
abstract XML format. If you do not select this check box, the archived 
information is stored in Service Desk-specific XML format. 

You may prefer to use the abstract format if you intend to transform 
archive files from XML to another format such as HTML. For a 
comparison of the two structures, see “Structure of Archive Files” on 
page 341.

7. Select the Generate DTD check box to generate a document type 
definition for each archive file. You can use the DTD file to simplify 
the transformation process from XML to another format such as 
HTML.

8. Select the Archive Service Event Relations check box to include 
service event relations in the archive.

9. Select the Archive History Lines check box to include history lines in 
the archive.

10. Select the Archive Attachments check box to include attachments in 
the archive.
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Define Archive File Names and Location

In the Location tab page of the Archive Settings dialog box, you can 
define naming conventions and folder structure for archive files.

To define archive file names and location:

1. Click the Location tab in the Archive Settings dialog box.

2. Select the Use Sub Folder for Each Object check box to store the 
archive files for each object type in a separate sub-folder below the 
archive directory. If this check box is not selected, all archive files are 
stored in the displayed archive location.

3. Specify a file name prefix of up to three characters to help identify 
the archive files.

4. Select Include Archive Version Number to append an archive 
version number to each file name. 

Including the archive version number ensures that archive file 
names are unique. The number is incremented each time the archive 
process is performed. Alternatively, you can select Include Date to 
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append the archiving date to the archive file name. You can include 
the archiving time as well as the date. Including the time is useful if 
archiving is performed more than once on the same day.

NOTE By default, information is archived to a location on the Service Desk 
client in the Archive folder below the data folder. This archive location is 
displayed in the read-only Archive Location field. The location of the 
data folder can be viewed and changed in the Client Settings Editor. For 
more information about the Client Settings editor, see Information for 
Administrators→Client Settings in the HP OpenView Service Desk 
online help.

If you initiate archiving from the command line, you can override the 
archive location by specifying a command-line loc option. For more 
information about starting to archive from the command line, see 
“Schedule the Archive Process” on page 351.
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Start the Archive Process

After specifying the archive settings, you can start archiving 
immediately from the console.

To start archiving from the console:

Click the Start Archiving Now button in the Archive Settings dialog box.

Alternatively, you can initiate archiving from the command line, which 
enables you to schedule archiving and to override some archive settings. 

For more information about scheduling the archive process, see 
“Schedule the Archive Process” on page 351.

NOTE Before initiating the archiving process, it is recommended that you 
decide on the time zone to be used for archiving dates and times. For 
more information, see “Time Zones for Archiving” on page 358.
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During the archiving process, all records of the chosen object type (or 
types) are first copied to the archive location. Then the deletion process 
begins, during which the records are removed from the database.

Objects are archived in the order in which they are listed in the Archive 
Settings dialog box. This means that work orders are archived first (if 
selected for archiving), followed by change requests, and so on down to 
incidents. If an error occurs during copying (for example, the disk 
becomes full), the copying process terminates, and no records are deleted. 
By this time, archive files might have been created for some object types. 
You can use the archive log file to identify records that were copied but 
not deleted.

Archive files use object identifiers (OIDs) to refer to objects. An OID 
identifies an object uniquely. OIDs are also used to identify archived 
attachments. The use of OIDs facilitates the development of automated 
search routines.

Viewing Archive Files

Archive files store information in XML format. A separate XML file is 
created for each type of object. New XML files are created each time the 
archive process is performed.

The files are in Service Desk-specific XML format (default) unless you 
select the Abstract Format check box in the Archive Settings dialog box. 
For more information about selecting the XML format for archives, see 
“Set Up the Archive Process” on page 342.)

You can use any external XML browser to view the archive files.

Archive Log Files

After the archive process is completed, Service Desk records the outcome 
in a log file. The log file is created in the archive folder and named 
<date>_<time>.log, where date and time identify the moment the 
archive process started. Use any plain text editor to view the log file.

The log file includes the following information:

• Date and time the archive process started and finished.
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• For each object type:

— Archive filter settings

— Number of objects copied and removed

• For each individual object, the result of copying and the result of 
deletion.

• If the archive process fails, the reason for failure. For example, if 
deletion fails because an object has a relation that cannot be deleted, 
the log identifies the related object that caused the error.

To view an archiving log file:

1. In the Archive Settings dialog box, click the List Log Files button. 
The file browser is displayed.

2. Select the log file to be viewed, then click Open.

NOTE If the log shows that an object was successfully copied to the archive 
location but failed to be deleted, Service Desk will attempt to archive it 
the next time the archiving process runs. This can result in an object 
being archived to more than one archive file. You can use the archiving 
log to identify such objects, and then delete them to prevent them from 
being archived more than once. 
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Archiving Attachments

By default, attachments are not archived when their related objects are 
archived. They are simply deleted from the attachment server. 

However, you can choose to archive attachments by selecting the 
relevant check box in the Archive Settings dialog box. For more 
information about the Archive Attachments check box, see “Set Up the 
Archive Process” on page 342.

Service Desk handles the archiving of attachments as follows:

• Each attachment is copied to an archive subdirectory, using the same 
sub-directory structure as on the attachment server. The structure 
includes the object type and OID.

• The archive file includes a reference to the OID of each attachment 
file.

• The archive file includes a reference to the sub-directory structure 
pointing to the attachment.

For example, consider a service call with an attachment file named 
details.txt. 

If the target folder specified in the attachment settings is /home/attach, 
and the service call has object ID 281478288048260, the attachment 
server stores the attachment with a numeric file name (for example, 
281478288048226) in the following file:

/home/attach/Servicecall/281478288048260/281478288048226.

When the service call is archived, the attachment is copied to the 
following file in the archive folder:

Attachments/Servicecall/281478288048260/details.txt
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Schedule the Archive Process
Depending on the needs of your organization, you can schedule the 
archive process to occur at a specified time and frequency. Use any 
external scheduler to run the archive process at a time that is convenient 
for you. Because the archive process is launched from the command line, 
you can override certain archive settings, such as the location of files, 
and whether to run the archive process on the client or server. 

When you schedule archiving, Service Desk uses the account settings of 
the default user as specified in the user settings on the Service Desk 
server. You can modify these settings in the Client Settings editor. For 
more information about the Client Settings editor, see Information for 
Administrators→Client Settings in the HP OpenView Service Desk 
online help.

To schedule the archive process on the Service Desk client:

When you schedule archiving, Service Desk uses the account settings of 
the default user as specified in the user settings on the Service Desk 
client.

Use the documented procedure supplied with the external scheduler.

When prompted to specify the name of the executable program to run, 
specify the OvSdArchive.bat file located in the bin directory below the 
client installation folder. The default folder is: 

C:\Program Files\HP OpenView\bin

To schedule archiving on the Service Desk server:

Service Desk uses the account settings of the default user as specified in 
the user settings on the Service Desk server.

Use the documented procedure supplied with the external scheduler.

When prompted, specify the name of the executable program to run.

Usage: OvSdArchive [view] [option]

• Windows

<install>\bin\OvSdArchive.bat

• UNIX
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<install>/bin/OvSdArchive

On these platforms, <install> is the installation directory for the 
Service Desk server.

By initiating the archive process from the command line, you can 
override the archive settings. The command-line options available are:

usr=<username>  Account name.

pwd=<password>  Account password.

srv=<server>[:port]  Server name (and optionally, port).

loc=<location>  Archive location.

abs=<yes|no> Use abstract XML format.

dtd=<yes|no> Generate document type definition.

rel=<yes|no> Archive service event relations.

his=<yes|no> Archive history lines.

att=<yes|no> Archive attachments.

del=<yes|no> Delete records (yes) or suppress deletion (no) after they 
have been copied to the archive.

The command-line options are not encrypted. If security is an issue, it is 
not recommended that you specify user account details on the command 
line.

You may need to enclose certain command-line options (both the 
parameter and its argument) in quotation marks, such as when the 
location path contains a directory name with spaces. 

For example, when archiving to the location 

/home/archive files

the following syntax is recommended:

OvSdArchive -usr=admin -pwd=abcdefg -srv=sdserver1 
-loc=/home/archive files

To override the user account on the command line, you need to specify 
the account name, password, and server name (and optionally, the port 
number, if different from the default port).

For example, specify the following: 
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OvSdArchive -usr=admin -pwd=abcdefg -srv=sdserver1:30998 
-loc=/home/archive

If you supply a user account override on the command line, Service Desk 
applies the default time zone for the specified user. Make sure that the 
default time zone for the specified user is set to the required value. 
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Before you specify archiving criteria and initiate archiving, it is 
advisable to plan an archiving strategy that is appropriate for your 
implementation of Service Desk. This section discusses some of the 
factors you might need to consider.

Consistency of Archives

You may need to change archiving settings (for example, when new 
custom fields are introduced). However, to maintain the consistency of 
archived information, it is advisable to avoid, if possible, changing the 
archiving settings.

Performance of Archiving

The performance of archiving can be negatively affected if the archive 
process is started during peak periods. In addition, the archiving process 
can negatively affect the performance of normal Service Desk operations.

When archiving large amounts of data, it is advisable to schedule the 
archiving process to be performed during quiet periods, such as 
overnight. During a 60-hour period over a weekend, it should be possible 
to archive 175,000 records. 

Frequency of Archiving

Consider the rate at which records are created in Service Desk. Allow for 
variations due to cyclical or seasonal factors. In general, the more rapidly 
information is created, the more frequently it needs to be archived. 

If you archive information more frequently, each archive file is smaller, 
but the number of archive files increases more rapidly. This may cause 
difficulty when searching through archived information.

Quantity of Archived Information

Use a test database to experiment with different archiving criteria. In 
this way, you can determine how much disk space is required for your 
archive files.
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The amount of disk space consumed by archive files also depends on how 
many attributes you choose to archive with each object, and on the 
quantity of information that is usually entered in fields. Identify the 
most important attributes, and the ones that consume the most disk 
space. Try to differentiate between attributes that must be archived, and 
attributes that are expendable. 

The -del=no command-line argument is useful when experimenting 
with different archiving criteria. By suppressing the deletion of archived 
records, you do not need to create new records each time. For a list of 
command-line arguments, see “Schedule the Archive Process” on 
page 351.

If storage capacity is limited, consider compressing archives. 
Compression can reduce disk space consumption by 80% or more.

Selecting Data for Archiving

Ensure that information is only archived when it is no longer required by 
other processes. 

The following processes may require information to be retained for long 
periods:

• Service-level management

Service Level Agreements may be active for several years, and each 
evaluation period may span six months or more. Service calls and 
incidents should only be archived if they have remained closed and 
unchanged for a period equal to, or greater than, the evaluation 
period. Consider the timing of evaluation and archiving processes 
(for example, arrange to start archiving after SLA evaluation is 
complete).

• Analyzed data

Analyzed data may be required for problem-solving and process 
optimization. The archiving process removes analyzed data related 
to archived objects, as well as the history lines on which the analyzed 
data is based. If you need to use analyzed data, consolidate that data 
in reports or reporting databases before archiving objects.
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Legal Requirements for Archives

Make sure that your archiving policy complies with your organization’s 
guidelines. Consider official regulations and procedures governing the 
retention and deletion of information. Your organization may have 
policies for keeping objects available for operational use in the database, 
or for indirect use, as well as policies for the deletion of data.

Object Order in Archives

The Archive Settings dialog box lists object types in the order in which 
they are archived. To minimize the possibility that a record cannot be 
deleted because of a dependency, you should not exclude objects higher 
up the list when including objects lower down the list. For example, if 
you archive problems, it is advisable to also include change requests and 
work orders in the archiving process. For more information, see 
“Archiving Related Records” on page 356.

For each type of object, Service Desk archives records according to their 
ID: highest ID first, lowest ID last. This minimizes the possibility that a 
record cannot be deleted because of a dependency (for example, a 
subcontract service call has a higher ID than the originating service 
call).

Archiving Related Records

When you specify archiving criteria for each type of object to be archived, 
avoid setting up a strategy that archives certain records but retains 
related records. Objects hold useful information not only in their text 
fields, but also in their relations to other objects. It is advisable to aim for 
an archiving strategy that archives all interrelated records in the same 
operation. This ensures that all references to related records are 
archived with an object.

Objects Related to Work Orders

Consider the case of a change request related to a work order: 

• Change request only

If you archive the change request but not the work order, the change 
request is copied but not deleted. Service Desk attempts to archive 
the change request the next time the archiving process runs, but the 
Chapter 9356



Archiving
Archiving Strategy
archiving process cannot delete the change request until the related 
work order is deleted or archived. This results in the change request 
object being archived to more than one archive file.

• Work order only

If you archive the work order but not the change request, the work 
order is copied and deleted successfully, and its archive contains a 
reference to the change request. The change request remains in the 
Service Desk database, but its relation to the archived work order is 
lost.

• Change request and word order

If you archive the work order and the change request, both the work 
order and the change request are copied and deleted successfully. 
The work order archive contains a reference to the change request, 
but the change request archive does not contain a reference to the 
work order. This is because by the time the change request is 
archived, the work order has already been copied and deleted.

Service Calls Related to Subcontract Calls

Consider the case of a service call related to a subcontract service call: 

• Originating service only

If you archive the originating service call but not the subcontract 
service call, the originating service call is copied but not deleted. 
Service Desk attempts to archive the originating service call the next 
time the archiving process runs, but the archiving process cannot 
delete the originating service call until the related subcontract 
service call is deleted or archived. This can result in an object being 
archived to more than one archive file. 

• Subcontract service only

If you archive the subcontract service call but not the originating 
service call, the subcontract service call is copied and deleted 
successfully, and contains a reference to the originating service call. 
The originating service call remains in the Service Desk database, 
but its relation to the archived subcontract service call is lost.

• Originating service and subcontract service
Chapter 9 357



Archiving
Archiving Strategy
If you archive the subcontract service call and the originating service 
call, both service calls are copied and deleted successfully. The 
subcontract service call contains a reference to the originating 
service call, but the originating service call does not contain a 
reference to the subcontract service call. This is because by the time 
the originating service call is archived, the subcontract service call 
has already been copied and deleted. 

Objects with Service Event Relations

Consider the case of a change request that has a solved-by service event 
relation to a problem record:

• One record only

If you archive one record without the other, the record selected to be 
archived is copied and deleted successfully, and the archived record 
contains a reference to the service event relation (if you selected this 
option). However, the record that is not archived loses its relation to 
the archived record. 

• Change request and problem

If you archive the change request and the problem, both records are 
copied and deleted successfully. The change request contains a 
reference to the problem (if you selected this option). However, the 
problem does not contain a reference to the change request. This is 
because by the time the problem is archived, the change request has 
already been copied and deleted.

Time Zones for Archiving

It is important that all your archives are produced using the same time 
zone. As part of your archiving strategy, it is recommended that you 
consider how Service Desk chooses a time zone.

Service Desk chooses a time zone based on how you initiate archiving: 

• Console

If archiving is initiated from the Archive Settings dialog box, Service 
Desk uses the time zone currently displayed in the toolbar. This is 
the user’s default time zone. 

• Command line
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If archiving is initiated from the command line, Service Desk uses 
the default time zone of the default user. If a user account is specified 
as a command-line override, Service Desk uses the default time zone 
of the specified user.
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10 Impacted Services

This chapter describes how to define the parameters used to find 
impacted services for incidents and service calls.
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An incident can have an impact on services; not just those directly 
related to the incident but also indirectly-related services. Service Desk 
allows users to view all impacted services and relate them to the 
incident, so that impact analysis can be performed to assess the full 
potential loss of, or damage to organizational processes.

As a starting point for finding all impacted services, Service Desk can 
use the incident’s configuration item or directly-related service or both. 
In the Impacted Services Settings dialog box, you specify which of these 
parameters Service Desk will use when searching for impacted services.

Depending on your choices, Service Desk finds the impacted services 
using the strategies described below. If configuration item and service 
are selected, both strategies are applied.

Configuration Item

If the incident’s configuration item is used as a parameter, the following 
services are considered to be impacted: 

• All services related to the configuration item by a Used By relation

• If the parameter configuration item is part of a hierarchy, all services 
that use each parent CI (linked by a Used By relation)

• For each service found, a further search is performed using the logic 
described below for Service

Service

An incident can be linked to either a Business service or a Management 
Operation service. If the incident’s service is used as a parameter, the 
impacted services are found as follows:

• Business Service

If the parameter service is a Business service, the following services 
are considered to be impacted:

— all services related to the Business Service by a Used By relation

— If any of the Used By services are parent services, their Used By 
(child) services
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• Management Operation Service

If the incident is linked to a Management Operation Service, the 
impacted services include, for each CI managed by the specified 
service, all services found by applying the logic described above for 
configuration items.
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Define Search Parameters for Impacted 
Services
In the System Settings workspace you can define the parameters that 
will be used to search for services impacted by incidents and service calls. 
You can also restrict the search by service status.

To define parameters for the Impacted Services search:

1. In the System Settings workspace, double-click Impacted Services.

The Impacted Services Settings dialog box opens.
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2. Select the check boxes for Configuration item, Business Service and 
Management Operation Service, as required.

3. In the Status Filter for Impacted Services area, select one of the 
following:

• No filter

• Status of Impacted Services equals one of following

If you want restrict the search so that only services with specific 
statuses are included, enter the allowed status codes using the 
New button. You can also edit and delete status codes as 
required.

4. Select the Search and relate Impacted Services when an incident is 
automatically created check box if this functionality is required.

5. Click OK to save the settings.
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11 Additional Tools
This chapter describes the Server Configuration editor and Object Server 
Monitor.
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The HP OpenView Server Monitor program allows you to assess the 
status and performance of management servers over time. You can 
assess database performance, see how many clients are connected, or 
examine the size and state of queues. You can also monitor the 
connections to the database and the status of services.

Open the Server Monitor Program

To open the Server Monitor program, locate and run the following file:

• UNIX and Linux Operating Systems:

 /opt/OV/bin/OvObsServerMonitor

• MS Windows Operating Systems:

 C:\Program Files\HP OpenView\bin\OvObsServerMonitor

Alternatively, click the following option in the Start menu:

Start→Programs→HP OpenView→Server Monitor

Start Using the Server Monitor Program

To start using the Server Monitor program, complete the following 
steps:

1. Select the management server instance you want to monitor from the 
list of host names displayed in the Address drop down menu.

2. Click View→Refresh to display the latest values for all fields on the 
tab you are viewing. The displayed values are updated at regular 
intervals. Use the Refresh button for an immediate update.

3. Click View→Update Speed to modify the interval used to check for 
the latest values for all fields in the tab you are viewing. The Paused 
option stops the refresh process until you reset it to one of the 
following values: High, Normal, or Low.

4. Observe the status bar at the bottom of the Server Monitor program. 
It displays the following information:
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• Uptime is the time that has elapsed since the management 
server was started.

• Connections are the number of active connections to the 
management server. For more information, see “Server Monitor: 
Connections Tab”.

• Threads are the number of active threads in the management 
server. For more information, see “Server Monitor: Threads Tab”.

• Mem Usage is the amount of available memory used by the 
management server process.

5. Click File→Exit to close the Server Monitor program. 

NOTE When you exit, the management server continues to run.

Server Monitor: General Tab

The General tab displays server, operating system, and java runtime 
environment information. Following are definitions for each section:

• Server Information

The Server section displays information about the host where the 
management server is running.

— Name displays the name of the machine where the management 
server is installed and running.

— Version displays the version number of the management server 
software.

— Server IP Address displays the IP address of the host where the 
management server is running.

— Settings file displays the full path and file name of the 
management server settings file.

• Operating System Information

The Operating System section displays information about the 
operating system installed on the host where the management server 
is running.
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— Name displays the operating system on the host where the 
management server is running. The information in parentheses 
is the hardware architecture of the host.

— Version is the version number of the operating system software.

• Java Runtime Information

The Java Runtime section displays details of the Java runtime 
environment installed on the host where the management server is 
running.

— Name displays the name of the Java runtime environment 
installed on the host where the management server is running.

— Version is the version number of the Java runtime environment 
used by the management server.

— Java Vendor is the supplier of the Java runtime environment 
used by the management server.

— Java Home is the full path to the Java runtime root directory.

Server Monitor: Performance Tab

The Performance tab shows performance data for the management 
server. Following are definitions for each section:

• Memory

The sum of the allocated memory and free memory equals the total 
memory made available for the management server by the virtual 
machine.

— Allocated Memory is the amount of memory currently allocated 
in the virtual machine.

— Free Memory is the amount of memory available but not 
currently allocated.

— Click the Free Memory button to force the virtual machine to free 
unused memory. This action also updates displayed values that 
have changed since the last refresh.

• ITP Requests and Thread Load

The numbers in the ITP Requests and Thread Load section help you 
monitor average response and wait times between the management 
server and its clients as well as overall thread load.
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— Average (#/sec) is the average number of ITP requests from 
clients per second. 

— Maximum (#/sec) represents the highest level the average 
number of ITP requests from clients has reached since the 
management server was started.

— Total requests is the total number of ITP requests from clients 
that the management server has processed since it was started.

— Busy ITP Threads is the total number of ITP threads that are 
currently active. Threads indicate open connections.

The information displayed is updated at regular intervals. To 
force an update, click View→Refresh.

— Click the View Transactions button to display detailed 
information about the transactions the management server 
receives and handles from its clients. For more information, see 
“View Transactions”.

View Transactions

The first line of the transaction shows which management server sent 
the transaction and at what time. The next three lines are defined as 
follows: 

• Average thread load is the percentage of time that threads were busy 
processing requests.

• Average response time is the average time it took to process a 
request.

• Average wait time is the average amount of time the request waited 
in a queue before it was picked up by a thread.

The second section of the transaction is defined as follows: 

• You will see a line similar to this: 3*AppSrvDispatch→<command>. 
In this example, the request, AppSrvDispatch, was called three 
times. 

• Max is the maximum response time in milliseconds for the request. 
It also includes a list of query times, if any, that were part of the 
request. The query time is the time the server had to wait for a 
return JDBC call. 
Chapter 11 371



Additional Tools
Server Monitor
• Average response is the average response time in milliseconds for the 
request. 

• Average wait is the average time it took for the request to be picked 
up by a thread after it was put in the queue for the first time. 

• Response time distribution is the time the management server took 
to handle requests. You will see numbers that look like this: 
{10-19,2}. In this example, the management server responded to 
two requests in 10 to 19 milliseconds.

Server Monitor: Database Tab

The Database tab shows information about the database used by the 
management server. Following are definitions for each section:

• Database Information

The Database Information section displays database information.

— Type is the type of database.

— JDBC Driver Name is the Java Database Connectivity (JDBC) 
driver used for communication between the management server 
and the database.

— Version is the current version of JDBC driver.

— Instance is the name of the database server instance. 

If the management server is using an Oracle database, the 
instance field will display the server name, port number and SID 
(Oracle Instance Identifier) in the form servername:port:sid. 

If the management server is using an SQL Server database, the 
instance field will display only the server name.

— Data Store is the name assigned to the database.

• Connection Pool

The Connection Pool section displays information about connections 
to the management server database. 

— Data Store is the account name for the data store user.

— Min Pool Size is the minimum number of connections between 
the management server and database.
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— Max Pool Size is the maximum number of connections allowed 
between the management server and database. 

— Current in Use is the number of connections between the 
management server and the database that are currently open. 

• Query Log

The Query Log section displays information about queries the 
management server makes to the database. 

— Total Queries indicates the total number of queries recorded in 
the query log file. 

If the minus character “-” is present, no information is available.

— Click the Start Logging button to start logging management 
server queries to the database.

— Click the Stop Logging button to stop logging management 
server queries to the database.

— Click the View Log button to view the generated log file.

NOTE You can modify some of the values displayed in the Connection Pool 
section in the Server Configuration program. For more information, 
search for the ObSSetSrv topic in the HP OpenView console online help.

Server Monitor: Threads Tab

The Threads tab shows information about threads, thread groups, and 
the priority assigned to named threads. Threads are allocated to 
applications and services that logon to or use the management server. 
The management server uses the thread pool to handle client requests. 
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You can use thread information to monitor and configure management 
server performance over time. To do this, monitor the CPU load on the 
management server in combination with the response times for client 
requests as indicated in the following table:

Following are definitions for each column:

• Thread Group contains the names of thread groups to which the 
management server threads belong.

• Thread contains the names of threads currently is use by the 
management server. The threads displayed are related to the 
number of applications and services running.

• Priority contains the priority value assigned to the threads.

Server Monitor: Queues Tab

The Queues tab displays management server queues and their current 
size. Following are definitions for each column:

• Queue contains the names of queues used by the management 
server.

• Size is the size of the queue. Size is an indication of how many 
messages are waiting to be processed.

Table 11-1

Server 
CPU 

Activity

Client 
Response 

Time
Suggested Action

<70% Bad Increase the thread pool size.

>70% Bad Consider using more powerful 
management servers or increasing 
the number of servers.

<70% Normal No action is needed.

>70% Normal No action is needed.
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There are two important queues that monitor client requests. If these 
queues grow and remain large for a long period of time, it is and 
indication that the management server you are monitoring is overloaded. 
You can confirm this by looking at the CPU load and client response 
times.

Server Monitor: Services Tab

The Services tab displays the services that use the management server. 
Following are definitions for each column:

• Service Name contains the names of monitored services. 

• Port is the server port number to which the named service is 
connected.

• Status is the service status and can have the following values: 

— UNINITIALIZED indicates that a service has not been started 
and is not ready to accept tasks.

— STARTING indicates that a service has not completed its start 
up procedure.

— STARTED indicates that a service has successfully started, is 
running normally, and can accept tasks.

— STOPPING indicates that a service has not completed its shut 
down procedure.

— STOPPED indicates that the service has successfully completed 
its shut down procedure and is no longer running.

— PAUSING indicates that a service is in the process of being 
paused.

— PAUSED indicates that a service is loaded into memory but is 
not performing any tasks.

— RESUMING indicates that the paused service is being resumed 
but is not ready to accept tasks.

NOTE The services and port numbers can be modified in the Server 
Configuration program. For more information, search for the ObSSetSrv 
topic in the HP OpenView console online help.
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Server Monitor: Connections Tab

The Connections tab displays the clients connected to the management 
server and, in a multi server environment, any other management 
servers that are available to process application requests. Following are 
definitions for each section:

• Clients

The Clients section displays the connections between the 
management server and clients. Following are the definitions for 
each section:

— Name contains fully qualified host names of management 
server’s clients. 

— Port contains the port numbers that are used to connect the 
clients to the management server.

— IP Address contains the IP addresses of the clients. 

• Servers

The Servers section displays the management servers running in the 
monitored environment. The Server Monitor program updates the 
server list regularly to keep track of server instances starting and 
stopping. Following are the definitions for each section:

— Name contains fully qualified host names of the servers. 

— Port contains the port numbers that the servers listen on.

— IP Address contains the IP addresses of the servers. 

NOTE If a user logs in by opening a console on the host where the management 
server is running, the names of the client and server will be the same.
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The Server Configuration program allows you to view and modify the 
configuration of a management server. Use this program to make sure a 
management server is set up to handle requests from clients as 
efficiently as possible. 

The settings displayed in the Server Configuration program are stored in 
the OvObsServer.conf file in the following location: 

• MS Windows Operating Systems

%OvDataDir%\conf\

• UNIX and Linux Operating Systems

<OvDataDir>/conf/

The information you provide in the Server Configuration program is 
used in multiple ways. For example, during installation and migration, 
programs and scripts make assumptions about the type of installation 
that is required based on the information provided in the Server 
Configuration program.

Open the Server Configuration Program

To view or modify server settings, locate and run the following file:

• UNIX and Linux Operating Systems

 /opt/OV/bin/OvObsServerSettingsEditor

• MS Windows Operating Systems

 C:\Program Files\HP OpenView\ 
bin\OvObsServerSettingsEditor

Alternatively, click the following option in the Start menu:

Start→Programs→HP OpenView→Edit Server Settings

Server Configuration: General Tab

The General tab of the Server Configuration program contains 
information about the management server’s configuration file location, 
thresholds, and multiple server instances. There are three sections:
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• Locations

Install Folder. The location of the HP OpenView installation 
directory. The default location is:

— UNIX and Linux Operating Systems

 /opt/OV/

— MS Windows Operating Systems

 C:\Program Files\HP OpenView

Data Folder. The location of the HP OpenView data directory. The 
default location is:

— UNIX and Linux Operating Systems

 /var/opt/OV/

— MS Windows Operating Systems

 C:\Program Files\HP OpenView\data

• Advanced

The Advanced section contains the following information:

— Session Time Out. The maximum length of time that an inactive 
client is allowed to remain connected to the management server. 
The default setting is 120 minutes.

— Socket Time Out. The maximum length of time that the server 
will wait for data to come through from a connected client before 
timing out. The default setting is 1000 milliseconds.

— Thread Pool Size. The maximum number of thread pools 
available to be used by the management server. The default 
setting is 10. This number determines the number of clients the 
management server can handle simultaneously.With a thread 
pool of 10, one management server should be able handle up to 
one hundred (100) concurrent users.

— Join Multiple Servers. Check this box to add the management 
server you are configuring to an environment where there are 
already instances of the management server running. By default, 
the box is not checked.
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— Weight. Weight is the importance of the management server you 
are configuring in relation to the other management server 
instances configured in the environment. You can enter a 
number from 1 to 4294967296, where higher numbers are 
considered to have more weight than lower numbers.

• Other

The Other section contains the following information:

— Accept Console Clients. Check this box to indicate that the 
management server should accept connections and requests 
through the user interface.

Server Configuration: Database Accounts Tab

The Database accounts tab displays a list of the accounts you have 
configured for the management server. It also indicates which account 
the management server is configured to use by default. Use this tab to 
add, modify, and remove accounts or to change the default account. 

Add or Modify an Account

To add or modify a database account, complete the following steps:

1. Click Add or Modify to enter or change detailed information about 
the database account on the database account form. 

2. On the user account form, enter or modify the following: 

Account Name Provide the name you want to assign to the 
configured account. The name you enter is an alias. 
Spaces are allowed.

The name should be self explanatory. For example, 
you could include the user name, the name of the 
HP OpenView management server, and the name 
of the host where the database is running:

 <UserName>_<OvMgtServer>_on <DB_Host>

Database Type Select a database type from the drop down list. The 
choice you make determines the default value in 
the IP port field.

User Name Provide the name of the user who will connect to 
the database.
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Password Provide the password associated with the user 
name.

Host Provide the name of the host on which the database 
is running.

NOTE You cannot enter a value for host if you chose 
Oracle (OCI) in the database type field

IP Port Provide the port number to connect to on the 
database host.

NOTE You cannot enter a value for IP port if you chose 
Oracle (OCI) in the database type field

Instance Provide the name of the database instance to which 
you want to connect.

Advanced Click Advanced to set the size of the connection 
pool. The connection pool is the number of 
connections to the database. The management 
server uses these connections for client requests.

Test Connection After you have entered all the information 
required, click Test Connection to ensure that the 
connection to the database works before you save 
the configuration.

3. Click Apply to save the new settings and keep the dialog box open, or 
click OK to save the new settings and close the dialog box.

Remove an Account

To remove a database account, complete the following steps:

1. Select the account you want to remove.

2. Click the Remove button to remove the selected account from the list 
of available accounts, and confirm your removal request when 
prompted.
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3. Click Apply to save the new settings and keep the dialog box open, or 
click OK to save the new settings and close the dialog box.

Set a Default Account

To set a default account, complete the following steps:

1. Select the account you want to make the default account.

2. Click the Set As Default button to indicate the account that the 
management server should use to connect by default to the database. 

3. Click Apply to save the new settings and keep the dialog box open, or 
click OK to save the new settings and close the dialog box.

Server Configuration: Protocols Tab

The Protocols tab defines the protocols that the management server uses 
to communicate with its clients. ITP is the default protocol and cannot be 
disabled. You can enable additional protocols. See Enable a Protocol for 
more information.

The are two IP address sections on the Protocols tab. The Accept IP 
addresses section contains IP addresses that are allowed to connect to 
the management server. The Deny IP addresses section contains IP 
addresses that are not allowed to connect to the management server. You 
can use wild cards to specify ranges. 

The IP addresses that you either accept or deny should be associated 
with the protocol you select. No check is made to ensure that the IP 
addresses can be resolved.

NOTE Rules that accept connections from IP addresses take precedence over 
rules that deny connections.

Enable a Protocol

To enable a protocol, complete the following steps:

1. Select the protocol that you want to enable from the list in the 
Protocol drop down box.

2. Check the Enable this protocol box.
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3. Accept or modify the default IP Port setting.

4. Click Apply to save the new protocol and keep the dialog box open, or 
click OK to save the new protocol and close the dialog box.

Enable SMTP for Inbound Email

Enable the SMTP protocol if you want to configure OpenView to use the 
inbound email feature. See Enable a Protocol for more information.

Settings for inbound mail are in the HP OpenView Configuration work 
space under System Settings→Email Settings. Enabling SMTP has no 
effect on outbound email. 

If you choose to use the inbound email feature, you can set access filters 
for email addresses. Any filters you set for email addresses are 
superseded by the client IP addresses you deny or accept on the Protocols 
tab.
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This chapter describes the log files used by Service Desk, and explains 
how an administrator can use the logged information to resolve 
problems.
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This section describes how to use and manage Service Desk log files.

Controlling Log Files

All default logging for installed OpenView components is controlled by a 
configuration file, log.cfg. This file sets the system-wide defaults for 
common logging.

Types of Log File

There are two types of log file - binary and text. By default, all processes 
write to binary log files. These are locale-neutral. Take, for example, a 
binary file generated in a Japanese system. Using the ovlogdump tool 
(see ovlogdump(1)), you would see Japanese messages. If you were to 
take the same log file, install it on an English system, then, using the 
ovlogdump tool, you would see English messages.

Text log files are locale-specific. Messages are written to the text files in 
the language set by the local environment variable. Text logging can be 
switched off or on(see Switching Logging Off and On).

Controlling the Size of Log Files

To prevent log files from growing excessively, log file rolling is used to 
create multiple smaller files that can be archived or removed. You can 
specify a maximum number of log files to be created and the maximum 
size of each log file. Whenever a log entry causes a log file to exceed the 
maximum size, the file is closed and a new file is opened, using the next 
sequence number as part of its name. 

For example, say you had a log file called system.txt. When that file is 
full, the file is renamed to system.txt.001 and a new system.txt is 
created. The next time, system.txt.001 is renamed to system.txt.002, 
system.txt is renamed to system.txt.001, and a new system.txt is 
created.

You control these settings by editing the logging configuration file, 
log.cfg.
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The file contains a keyword and value pair per line. There can be no 
blanks, blank lines, or comments. The keywords are case-sensitive.

The keywords are:

BinSizeLimit=n

Sets the maximum size of binary log files to n bytes 
before it rolls to the next file. Default is 10000.

BinFileLimit=n

Sets the maximum number of binary log files to 
generate before throwing away log entries.  Default is 
10.

TextSizeLimit=n 

Sets the maximum size of text log files to n bytes before 
it rolls to the next file.  Default is 10000.

TextFileLimit=n

Sets the maximum number of text log files to generate 
before throwing away log entries. Default is 10.

The configuration and log files for MS Windows systems are stored in the 
following locations indicated in Table 12-1.

The configuration and log files for UNIX systems are stored in the 
following locations indicated in Table 12-2.

Table 12-1 MS Windows Configuration and Log Files

Configuration file:

C:\Program Files\HP OpenView\Data\conf\xpl\log\log.cfg

Binary log files:

C:\Program Files\HP OpenView\Data\log

Text log files:

C:\Program Files\HP OpenView\Data\log

Table 12-2 UNIX Configuration and Log Files

Configuration file:
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The log files will be stored in the <Data dir>/log/public directory if 
permissions are inadequate for the default locations.

/var/opt/OV/conf/xpl/log/log.cfg

Binary log files:

/var/opt/OV/log

Text log files:

/var/opt/OV/log

Table 12-2 UNIX Configuration and Log Files (Continued)
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Switching Logging Off and On
You can switch logging off and on by changing the settings in the logging 
configuration file, log.cfg.

The file contains a keyword and value pair per line. There can be no 
blanks, blank lines, or comments. The keywords are case sensitive..

The keywords are:

TextLog=off|on

Switches locale-specific text logging off and on. 
Switching this on causes the logging libraries to write a 
locale-specific log in human-readable format. Default is 
off.

OVLog=off|on

Switches binary logging off and on. Default is on.

WARNING Switching off this option will prevent any binary 
logging for any component.

SysLog=off|on

Switches logging by syslog off and on. 

NTLog=off|on

Switches logging by the Windows event log off and on. 
It has no effect on UNIX systems. Default is off.

OVEvents=off|on

Switches message forwarding to the OpenView 
Operations event system off or on. Default is on.

See Table 12-1 and Table 12-2 for more information about the location of 
the configuration and log files on UNIX and MS Windows systems.
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Viewing the Contents of a Log File
Use the ovlogdump command to dump a binary log file as text in the 
current locale to the console. You can thereby view the contents of the 
text file and use the information to help you troubleshoot problems.
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ovlogdump(1)

NAME
ovlogdump – dumps a specified binary log file as text in the current locale to the 
console

SYNOPSIS
ovlogdump -h|-help 

ovlogdump -version 

ovlogdump [<binary_logfile_name>] 

ovlogdump -merge -tofile <binary_logfile_name> 
-fromfiles <binary_logfile1_name> 
<binary_logfile2_name>... 

DESCRIPTION
The ovlogdump command dumps a binary log file as text in the current 
locale to the console. To view the contents of a log file, specify its location 
and name; else, the system.bin file is dumped to the console by default.

By default, all the log files are stored in the following location:

On Windows:

C:\Program Files\HP OpenView\Data\log

On UNIX:

/var/opt/OV/log

If permissions are inadequate for the default locations, the log files are 
stored in the <OvDataDir>/log/public directory.

During application logging, if multiple log files are created, you can use 
the -merge option to merge these files into a single binary log file.

Parameters
ovlogdump recognizes the following options:

[<binary_logfile_name>]
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The name and location of the binary log file to be 
dumped. If the log file name is not specified, 
system.bin file in the <OVDataDir>/log/ directory is 
displayed on the console by default. 

-merge -tofile <binary_logfile_name> -fromfiles 
<binary_logfile1_name> <binary_logfile2_name>....

Merges application log files specified by 
<binary_logfile1_name>.... into a single binary log 
file specified by <binary_logfile_name>. This 
option is not supported for merging system log files.

-h|-help

Displays all available options for the ovlogdump 
command.

-version

Displays the version of the ovlogdump command.

AUTHOR
ovlogdump was developed by Hewlett-Packard Company.
Chapter 12390



13 Support Tool

This chapter explains how to use the support tool supplied with Service 
Desk.
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The Service Desk 5.0 Support Tool can be used in the event of a problem 
arising with Service Desk that results in a call to the Service Desk 
support line. 

The tool collects information about the operating system and Service 
Desk and puts it into a Support Log file. This log file is intended to be 
used by support engineers to reproduce problems and to prevent 
miscommunication between the support team and the customer.

The support tool gathers information about:

• The operating system

• The Service Desk installation

• The installed JRE and its settings

• The machine on which Service Desk is installed

The tool wraps all log files (including the Support Log file) and cache files 
together in a zip file that can be used by a support engineer or sent to 
Service Desk support as an attachment to an e-mail or as a service call 
for analysis.
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Support Log File
Support Log File
The tool reads settings from both the operating system and the Service 
Desk (client or server) installation and writes them to the Support Log 
file, SupportInfo.log.

Table 13-1 shows the settings that are included in the log file:

Table 13-1

Variable Description

os.name Operating system

os.arch Processor type

Java.vendor Java vendor

Java.version Java version

User.region Region of Service Desk machine

User.language User language

http.agent Web browser

Java.class.path Java classpath

User.timezone User time zone

AppSystem.getVersionInfo Service Desk version

AppSystem.getApplicationVersion Service Desk build version

AppSystem.getUserFolder Service Desk user folder

AppSystem.getCacheFolder Service Desk cache folder

AppSystem.getTempFolder Service Desk temporary folder

AppSystem.getRootFolder Service Desk root folder

AppSystem.getBinaryFolder Service Desk bin folder

AppSystem.getClassesFolder Service Desk class folder

AppSystem.getImagesFolder Service Desk images folder
Chapter 13 393



Support Tool
Support Log File
AppSystem.getRepositoryFolder Service Desk repository folder

AppSystem.getSoundsFolder Service Desk sounds folder

file.encoding File encoding

Java.vm.info VM mode information

Java.home Java home directory

Java.io.tempdir Java temp directory

User.country Country where user is located

User.home User’s home directory

Dir.path(DirKey.Install) Service Desk install folder

Dir.path(DirKey.DataTmp) Service Desk temporary data 
folder

Dir.path(DirKey.Packages) Service Desk packages folder

Dir.path(DirKey.DataWww) Service Desk internet folder

Dir.path(DirKey.NonOV) Non-Openview folder

Dir.path(DirKey.Resources) Service Desk resources folder

Table 13-1  (Continued)

Variable Description
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Support Zip File
Support Zip File
The files which are retrieved from Service Desk are stored in a zip file in 
the support folder. The support folder is located in the installation 
directory.

The support zip file is:

<client/server>_support_information_yyyyMMdd_HHmmss.zip 

The support zip file contains the support log file, and also the contents of 
the following directories:

The contents of these directories are copied to the subdirectories in the 
support folder. After the zip file has been successfully created, the files 
are removed from the support folder, leaving only the zip file.

Table 13-2

Log folder (client and server) <Support folder>/log

Configuration folder (client and 
server)

<Support folder>/config

User data folder <Support folder>/userdata

Cache folder (client and server) <Support folder>/cache
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Run the Support Tool
Run the Support Tool
The Support Tool is packaged as a jar file, OvSdSupporttool.jar and 
delivered with Service Desk.

• Windows

bin\OvSdSupportTool.bat

• UNIX

bin/OvSdSupportTool.sh
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